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Introduction

Learning Objectives

L earning Objectives
¢ LearntousetheeZdsp™ LF2407 Starter Kit

¢ Understand the basic architecture and
peripherals of the LF2407 and family devices

¢ Understand DSP in control applications

¢ Learn how totakethe next development step
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Workshop Introduction

Workshop Introduction

Workshop Lab Overview
Usethe eZdsp™ L F2407 to:

1) Generatea PWM signal 2) Captureasignal

e

Let’sIntroduce Ourselves...

¢ Your Name

¢ Company

¢ Application area of interest
¢ DSP or Micro experience
*

Areyou:
+« Hardware

« Software
+ Assembly or C or BOTH

DSP24 1-Day Workshop - Introduction



Workshop Introduction

TMS320C24xx Device Family

TMS320™ DSP Platforms Achieve
Unequivocal L eader ship

TMS320C2000™ TMS320C5000™ TMS320C6000™

Most Control- L owest Power/ Highest-
Optimized MIPS Performance
DSPsin the DSPsin the DSPsin the

World World World

Optimized, not Compromised

TM S320C2000™ DSP Platform Milestones
TheWorld's M ost Control Optimized DSPs

20X higher
performance

25% more
code efficient

D In Production ~tes %
[& In Development = g =

. Roadmap

Control Performance

1996 1999 2000 2001
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Workshop Introduction

Tl Enables OEMsto Develop M ore Compact,
Intelligent and Robust Digital Control

T I
elligent sens

132 PoFP
132 PoFP

64 PQFP 68
pLce

64 PQFP 68
PLCC

144 TQFP

** 64 TQFP for new LC2402A DSP is 100 mm?”*
C28x Broad Sampling Mid 2001
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eZdsp™ LF2407 Starter Kit

Learning Objectives

L earning Objectives

¢ Review eZdsp™ LF2407 Starter Kit platform

¢ Become familiar with the Code Composer
development environment

¢ Run aReal-Time Monitor Demo (using watch
windows & graph functions)

DSP24 1-Day Workshop - eZdsp™ LF2407 Starter Kit



eZdsp™ LF2407
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eZdsp™ LF2407

EZdsp™ LF2407

JTAG Interface (P10)

Parallel Port/
JTAG
Controller
Interface (P9)

Power
Connector (P3)
+5V

EXPANSION
Data & Address (P6)

TM S320L F2407 - DSP
1/0 Interface (P2/P8)

eZdsp™ L F2407 Hardware

SRAM 64K x 16
Program/Data

ANALOG
Interface (P1/P7)

Data RAM Boot ROM Program FLASH
2.5K words 256 words 32K words
D(15-0) ‘
bmd ¥

Program / Data / I/O Buses
=

A(15-0) L

C2xx DSP Core

16-Bit T Register

16-Bit Barrel 16 x 16 Multiply
Shifter (L) 32-Bit P Register 5
Shift L (0,1,4,-6) =
32-Bit ALU s
32-Bit Accumulator =
Shift L (0-7) &

8 Auxiliary Registers

8 Level Hardware Stack
Repeat Count

2 Status Registers

Event Manager B

Event Manager A

2 Timers
5 Compares
8 PWM Outputs
Dead Band Logic

AID Converter
10-Bits
16 Channels

TM S320L F2407 Block Diagram

25nsinstruction cycle
time (40 MIPS)

32K Words of on-chip
FLASH/ROM memory

2.5K Words of on-chip
RAM memory

256 Words of Boot Rom

Motor control optimized
Event ManagersA & B

& A/D converter with

*

*

500ns conversion time
UART (SCI) @ 2.5Mbl/s
SPI @ 10.0Mb/s

On-chip CAN module
(meets spec 2.0B)

16-bit external memory
interface

40 GPIO Pins
144-TQFP
3.3V Core& 1/0
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Code Composer

Disassembly
Window

Tt Graph
Project View o Windows
Window

¥ o= R EE

Debugger
Editor
Window

ur_o

It Fimdscan

EEEEIRE]

e ncluge files containing THS120F240 registers
e

ftincluge “regsoue.n
e

[/« o
e these must

Memory
Window

frinc1uge “stavecs i

w00 11 - 00z
5IC0 IR - 0880
E7D0 GREG - 0098
7iar

- o
ang - 6259

=
[OSPHATED  REALIINE For il s 1

CPU Status
Registers Window

Assembler, Mnemonics, Directives, Sections

& Assembler

+ Instructions & directives cannot bein first column, and comments
defined by a“;” or “*" (asterisk located in column one only)

& Mnemonics

« Linesof TMS320 code (“ processor code’) become components of
program memory

& Directives/ Sections

« Begin with aperiod (.) and are lower case - and can create sections,
constants and variables; and may occupy no memory space when used
to control assembly and link process

.bss 2,2
Assembler| Definition .data
Directive « P
text Code to follow ¥ .int 7
data Constants to follow siEEdE
. tart LACC
bss Allocate space for variables e *
o Yy
.int Creates 16-bit integer constant SACL z
.set Define assembly-time constant eren 2l
B start
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eZdsp™ LF2407

Softwar e Development Tool Flow

Code Composer Probe
In
LNK . CMD
*_ eZdsp™
Edit -2SM Build .OUT Debug —|
S (Cmp/Asm/Lnk) Third
v

.LST/.MAP/.OBJ Party
510PP+

Probe t

Graph Oout EVM /
Target

# Code Generation Tools/ Debug Tools

Connecting the eZdsp™ to your PC

25 pin male
D-sub connector

(Plugsinto parallel
port on PC)

25 Conductor Cable
—

eZdsp™ L F2407

25 pin male
D-sub connector

o Power
Supply
25 pin female Towall outlet

D-sub connector

Code Composer —eZdsp™ L F2407 Configuration
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eZdsp™ LF2407

Module 2 Lab: Getting Started with the eZdsp™
LF2407 Starter Kit

Module 2 Lab:
Getting Started with the eZdsp™ L F2407

Objective:
1) Build, load & run a project on eZdsp™

2) Learning to use Code Composer with Real-Time Mode
» Build project

» Load program

» EnableReal-Time Mode

¢ Run program

e Set-up Watch, Memory and Graph Windows

» Control waveforms by changing operational variables

Introduction

The objective of thislab isto become familiar with the basic operation of the Code Composer
debugger, which is provided with the eZdsp™ LF2407. The REALTIME.MAK project used in
this lab has a sine waveform generation routine that creates two sine waves of controllable and
variable frequency and phase difference. These waveforms are buffered in memory so that it can
be viewed with Code Composer graph windows without aliasing.

In thislab you will:

Open the REAL24XX.MAK project
Build the project and download the example program to the eZdsp™ board
Set-up Code Composer in Real time mode and run the program

View the operation of the program through watch windows, graphs and memory windowsin
real-time

Use the watch windows to make real -time changes to variables and waveforms

No externa signals or connections are used in this lab.

DSP24 1-Day Workshop - eZdsp™ LF2407 Starter Kit



eZdsp™ LF2407

> Procedure
Part #1: Loading the Project and Running the Program
1. Connect the eZdsp™ to the PC parallel port using cable provided.
2. Connect the power supply to the eZdsp™. Verify the red power lights are on.
3. From the desktop, launch Code Composer. Y ou should see the debugger window open.
4. Open project Real24xx.mak : From the pull-down menu bar, go to Project - Open

5. Browseto the project file directory: C:\DSP24 1DAY\LABSLab2\Real 24xx.mak
and click Open.

6. Under the “Files” window, expand the project tree. Y ou should see:

:" /sdgo2xs { Spectrum Digital )/CPU_L - C2XX Code Composer- Realz4xx.mak
File Edit View Project Debug Profiler ©ption GEL Tools Window Help

EE I B L IELS
| @ e
| |20 GEL files 0022 S5AA MPYU =+ BR2 -
[ & init.gel 0023 55A2 MPYU *+

=] Project 0024 7123 LTP 2ah

) Realzonmak 0025 4542 BIT ®t,5

— =[] Include 0026 52AA SQRA *+,AR2 i
L] c200mnrt.i 0027 552A MPYU 2ah

¥ rhvecs.h 00258 SDAA

- x24x_spp.h 0029 SS5EA MPYU =0+ ,AR2

i (] Libraries 0024 SD9A

| Real24xx.cmd ﬂ]?ﬂ S1AR MPVE *+ BRI

e urce: hl

- c200mnrt. asm

@ --[3) data_log.asm

& --[2) EWMZ407 .asm
— --[3) pwmodry.asm

~ -2 rmp_cntl.asm

-[B) sincasph.asm

v ~[B) SINTE360.a5m

{¥ B sys_init.asm

- -[B) whz_praf.asm

7. Edit the x24x_app.h header file to select the appropriate DSP. Double-click on the x24x.h file
and view the text editor window. Since thislab is working with the LF2407 DSP, the section

of text should read:

X240 .set 0 ; CIF240
x241 .set 0 i F241
X242 .set 0 : C242
X243 .set 0 ; CIF243
x2402 .set 0 ; CIF2402
x2404 .set 0 : C2404
Xx2406 .set 0 ; C/IF2406
x2407 .Set 1 : F2407

8. Buildthe project by going to the pull-down menu: Project > Rebuild All. The output
window status should read: “Build complete, O Errors, 0 Warnings” when complete.

9. Download tutorial example to eZdsp™ board. From the pull-down menu go to File > Load
Program. Select Real 24xx.out from the dialog box in directory C:\DSP24 _1DAY\LABS\Lab2\
and click on Open. Note: If you receive a loading error, verify you have the eZdsp™ target
jumpers set for disabled watchdog (JP3 = 2-3) and microprocessor mode (JP4 = 1-2).
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eZdsp™ LF2407

10. Reset the DSP by going to pull-down menu item Debug = Reset DSP. Thisresetsthe

11.

Program Counter (PC) to 0. Verify this by checking the Disassembly Window. The yellow
bar shows the current memory location of the PC. Y ou can also view the PC along with other
CPU registers by going to pull-down menu View - CPU Registers > CPU Register.

_{ol x| 25 C2XX Registers < Type 03 =10 %]
ooon RESET: 7 BC = 0000 ARO = 0OC01
joooo 7980 B e ahelif BCC = 00000000 AR1 = 03C0
oooz INT1: FREG = FEOBO&41 ARZ? = 2137
el VL e TREG = EOES AR3 = EBA4

: 5TO = 0kOO0 AR4 = 0219
gggg HHE0 113NT3: Tl_PERIOD_IJ 5T1 = OFFC AR5 = (0301
0006 7980 E PHAENTOM , * REPTC = 0000 &4R6 = EB25
oong INT4: TOZ = 034F AR7 = 24F6
Qgoog ¥9g80 B PHARTOM , = IME = 00400
000z INTS: IFE = 0O00n
Qoo0a 7980 B PHANTOM ,= =

: GREG = 0000

[ | _'d

Initialize real-time mode. Go to Tools - Command Window. The Command Window will
appear. Type go MON_GO in the Command line and execute. The program will begin
executing until encountering the label “MON_GO.” (View the Disassembly Window and
check the location of the PC for reference.) Y ou may see the file C200mnrt window appear ...
close thiswindow asit will not be reviewed in thislab. Finally, go to Debug - Rea Time
Mode.

~* /sdgoZux { Spectrum Digital )}/CPUL_1 - C2XX Code Composer- RY
File Edt View Projsct Debug Profiler  Option  GEL  Tools  wWindow

HEE| 5= :rezkp:mt:.
Command Window Flug-in, Version 1.21 ( B g F_‘_“as Sy e
Copyright (c) 1986-1999 Texas Instrument: E Coonper i:enpom igﬂ 7
THS320C2400 Enulator (Supports: RealTi: % o mgel ShiftFs
Enter 'HELP' for information — & g-g::alzw Animats F12
Board Version 00.00.81 o S e Runfree 7
Target Silicon Version 00.00.205 f Bl e Sl
Device Driver Version 02.15.00 & Lo (R R Fit
go MON_GO *% & L ;::;:5"
® &
i| | s o
Comnand:  |EETXALE MR o

12. After selecting Real Time mode, run the software. Go to menu bar Debug = Run. The DSP

should be running in Real Time Mode. The bottom left of the screen should be as seen below:

[DSF RUMMING [REALTIME For Help. |

Part #2: Adding Watch Windows.

1

2.

Add watch windows by going to the pull down menu, go to View - Watch Window.

Declare variables or peripheral registersto watch. Place cursor on watch window and right —
click, select “Insert New Expression” and then type in the watch Add Expression box:
*sine al  and then enter. Repeat for these other variables:

*sine a2

*gpeed _setpt

*phase_in

DSP24 1-Day Workshop - eZdsp™ LF2407 Starter Kit



eZdsp™ LF2407

*dlog_iptrl,x
*dlog_iptr2,x

[ watch Window

Inserk Mew

Remove Current Expression
Refresh Watch Window
Continuaus Refresty

Expand fs Array.
Help

v fllov Bocking
Hide

Watch Add Expression x|

Expression: I"sine_a‘l

o]

Cancel | Help

[T AT»IpI]s waten 1 + Float In Main Window

At this point you will notice that even though the program is running, the variables in the

watch window are not changing. Enable the continuous refresh of watch variables by placing

the cursor on the watch window and

right-mouse clicking on Continuous Refresh (see next

graphic.) If the variables are not changing, halt the program (Debug = Run) and carefully

repeat Steps 10-12 in Part 1 above.

I v o Fxgrsion..

Remove Current Expression

=7
1

*sine_al
*sine_az
*speed_setpt
*phase in
*dlog_iptrl.x
*dlog_iptr2,x

HTATR M watch 1 £viaten 2 A 4] |

n0ge
5078

Refresh Watch Window

 Conkinuou;

= 1200

a0 Expand &5 Array.
= 0x0301 Help
= 0z0302

v Allow Docking
Hide:
Float In Main Window

s

o

Part #3: Adding Graph View

1

In order to add a graph, go to the pull-down menu and select View - Graph >

Time/Frequency in order to open a Graph Property Dialog box.

Flle Edit | Yiew Project Debug ProFlIer Cption GEL  Tools  Wind

?i%

4w Project

= | v Standard Toolbar
GEL Toolbar

g‘ v Debug Toalbar
. Edit Toolbar
v Status Bar

Toolbar

Dis-Assembly
Mermory...

CPL Registers

(3

Time/Freguency...

Tasks

Constellation...
Evwe Diagrarm. ..

]

elE = AR E‘«’Iﬁi@;

wakch Wlndow

Irmage...

2. Maodify the following in Graph Property Dialog box (shown below) and click OK.

Graph Title

Start Address
Acquisition Buffer Size
Display Data Size

Sine Al
0x8000
400

400
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eZdsp™ LF2407

e DSPDataType

| = Graph Property Dialog 5 il
Singls Time =

A Graph Title

| Start Address

APage

; Acquizition Buffer Size
Index [ncrement

Display Data Size

DSP Data Tupe

0-value

.| 5ampling Fate (Hz]

Plot Data From
Left-chifted D ata Dizplay
Avtogcale

DC Value

) Awes Dizplay

Time Dizplay Urit
Statuz Bar Display
Magnitude Display Scale
[rata Plat Style

lrid Style

Cursor Mode

oK I Cancell

Sine &1
0xB3000
Data

400

1

400

16-bit zsigned integer
i]

1

Left ta Right
ez

On

1]

On

3

On

Linear

Line

Zera Line
[Crata Cursor

Help |

16-hit signed integer

e Right Click on Graph Window and click on > Continuous refresh
e  Graph Window should be displaying a Sine Wave at this time — as shown below.

TEIS
Zoom |h »
FEIS. Zoorm Dut 4
23644 v fues
D W §t§tus Bar 0 2am
Grid »
M LCurzor Mode 3 [Aulip Sl
Log Scale 1ol x|
F Fixed Scale
Refrezh
v Continuous Refresh
Clear Display
Help
Froperties... k_,_
- b 388
@aem) ¢ ’é:';s"; Rasting futa Scal
v Float In Main Window !H

=10fx]|

-TE35

-1 .5e+44

-23e+4]

0

BBI.? 1 3‘3 20‘0 25“? 33‘3 399

(278, -6702)

iTime Lin |auko Scale |

3. Add asecond Graph Window similar to the first window. This second Graph Window will
mimic the previous one. The only change is modifying the Graph Titleto Sine A2 and the
Starting Address to 0x8400.
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eZdsp™ LF2407

zl
Single Time =l ~
Graph Title Sine &2
Start Address 08400
Page Data
Acquizition Buffer Size 400
Index Increment 1
« | Dizplay Data Size 400
E DSF Data Type 16-bit signed integer
| Qvalue il
Sampling Rate (Hz) 1
Plot D ata From Left to Right
Left-zhifted Data Display ves
Autoscale On
DC Walue 0 i
Awes Display On
Time Display Urit 3
Statuz Bar Display On ;]
Ok I Cancel | Help |

4. Click OK on Graph Property Dialog box for Second Graph Window. Right-click on this
Second Graph Window and click on >Continuous Refresh, as before. This Second Graph
Window should now be displaying a Cosine wave as shown below.

o =] 3
Zae+d
1 de+d43
45177 ri
4E17]
-1 4e+44
-2'38+4_| T T T f T
i BE.7 133 200 267 333 399
{199, -17845) [Time [iin [autoSeals |

5. Thefregquency of these waveforms can be changed by putting a different value for the
variable speed_setpt in the Watch Window. Variables in the Watch Window can be changed
by double-clicking on the variable. Double-click on speed setpt in the Watch Window and
edit the variable in the following dialog box:

Edit ¥ariable x|

Wanable: i*speed_setpt

Walue: 1200

(4 I Cancel | Help |

6. Change speed_setpt to 2000 and watch the graph windows change accordingly. The phase
angle between these waveforms can be changed by modifying the variable phase ininthe
Watch Window. The following graph shows waveforms at speed _setpt = 2000 and phase in
= 180. The corresponding watch window is also shown. Experiment with other valuesin
speed_setpt and phase_in.
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S T=TT |
o *sine_al = 17479
1 Beva] \/ *sine_aZ = 21919
= 38+4_E'I 1 EIIEI ZDID SEIIEI 399 *SPEEd_SEtPt > 1 ZD D
0B, ZE=18] [Time [Cin [Auta Scale [ *phase_in = 130

*Jlaog_iptrl.x = O0x0301
*dlaog_iptrZ.x 0x0302

= 33+4_\ -

o 1da >0 EnT Saa LA T wateh 1 A wisteh 2 fowd| 4] |

Mas. 276521 [Tirne Lin [Auto Scale |

Part #4: Adding Memory View Windows

1

In order to view the memory contents, go to the pull-down menu and select View ->
Memory. A dialog box of the Memory Window Options will appear. In order to view a
specific memory location, the absolute hex address (e.g. 0x0301h) or avariable name (e.g.
sine_al) can be entered in the Addressline. (Don't forget the Continuous Refresh.) FYI Only
- The Realtime refresh interval is default set at 100msecs, which is the shortest inveterval, but
can be changed by going to pull-down menu View = Realtime Refresh Options.

Tile:  [Memony Bl Memory {Data: Hest | =10l x|
pee 0x0301: sine_al -
Qalue: |0 0x0301: 0OxZC72
Format; IHe:-c-CSter _:I 0=x0302 - sine_aE
I Use IEEE Float 0xz0302: 0O=zCFC1

Page:  |Data =l 0z0303: gain_cs r
[ Enable Reference Buffer 0z0303: Ox5a2D0
Start Address: IUHU[]DU O0xz0304: freq
Endéddress: [0 0xz0304: 0x31D7
[T lpdate Refererice Buffer &utomatically O0=0305:- phﬂSE

ok ] carcel | e | 0x0305: Ox7FF8 ~

In order to change the addresses viewed, either scroll the window up or down, or right-click
on thetable, select “Properties” and the Memory Window Options dialog box will be opened.
Data memory space is currently being viewed. FYI Only - The Program and 10 memory
spaces can also be viewed by changing the “ Page:” selection.

Halt the Program and deactivate Realtime mode — First, go to pull-down menu Debug >
Halt. Next, go to Debug - Real Time Mode and uncheck the Real Time Mode selection.

Part #5: Using Workspaces

1

Save your workspace by going to pull-down menu File > Workspace - Save Workspace
and using a new file name (like Lab2.wks)

Thislab tutorial also provides a workspace example. Open the example workspace by going
to the Menu bar and select File > Workspace > Load Workspace and browseto / open
C:\DSP24_1DAY\LABSLab2\real24xx.wks Next, reactivate Debug > Real Time Mode.
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3. Theresulting workspace is shown below. The placement, sizing and properties of each view
window are preserved in the workspace file and can be restored in subsequent sessions. Y ou
can also switch between different working environments in the same debugging session. One
property that is not saved though is continuous refresh, which must be re-enabled after setting
up Real-Time mode as described in Part 1.

4. The project file is contained within the workspace as well. From a fresh start of Code
Composer, loading the workspace also |oads the project. Project files (.mak files) do not
contain workspace information so loading a project will not load a workspace.

I =8l

_| .‘ /sdgo2ux { Spectrum Digital }/CPU_L - C2XX Code Composer- Real24xx.mak
File Edit View Project Debug Profiler Option GEL Tools Window Help

0x0305: 0x005A

— ] 567 133 200 267 333 39
& 0z0306: sgb6 freg max —-=
LG R g i =l [(193, -17845) [Time [tin [Auto Scale [

SR R el ﬁwém a;s»:gmaws\gﬁu%ﬁM
© BEE BER[wsnen BEE]
8 Files DO5C AE1F SPLE #1h, 10k ||
- GEL files O0SE AEG4 SPLE #67h, G4h 15044
=] Project 0060 AES3 SPLK #0h . 63h
% g2 Realzdicsmak 0062 MOM_GO: 76959
SR -7 Include 0062 AER3 SPLE #1h,63h
<y P c200mnrt.i 0064 BEB7 Bl o
# rtvecs.h 0063 MOM_RESET:
= w24 _app.h 0065 8BO0 MOP =750
5 o[ Libraries 006& EFO0 RET A Zoaa]
[24:0.cmd ooe? MON_TRAP_EWTRY :
W B 0067 906F SACL  6fh 23ev4] ‘ : : : ‘
= 006G 9670 SACH 70h - 0 6.7 133 200 267 333 399
@] : data_log.asm 4 M 7 |lfz7a, -6702) [Time ltin [auto Scale |
e [2] EWM2407. 350 — — =
) (B pumodky.aam =101 =lolx|
™ rmp_crtl.sm 0z0301: sins_al A 2Ee
o sincosph.asm 0x0301: 0=xz5778 1 de+d]
o i [B) SINTB360.asm 0x0302: sine_a?
i sys_init.asmm 0x0302: O0xzEALA 4E17
e : vhz_prof asm 0x0303: gain_cs
o 0x0303: O0xz3FFF I Iiaks!
Z 0x0304: freq
7 0x0304: D0Ox3FFF -1 de+d
- 0x0305: phase 2304
£ T
M 5
=)
=
&

NofRnE.  fenTAn
s coex JRTEIES] o vorcn v JRISIES||  command win il
il PC = 0062 ARO = 0C01a|| *sine_al = ~ll|Conmand Windew Plug-in, Versior
dsplnk Real24xx.mak ACC = DOODOFCOD &R1 = 03CC *sine a2 = -5610 Copyright (cj 1986-1999 Texas ]
TMS3200 12022/ (Zxx/C5% | |[PREG = FSOBOR41 ARZ = 2133 || *speed_setpt = 1200 o e
Copyright (o) 1967-1999 REG = EQOES BR3 = EBA< *phase_in = 90 Board Version 00.00
STO = 2600 BR4 = 021° *dlog_iptrl,z = Dx0301 Targst Silicon ¥ersion 0000
Build Complete, ST1 = 0O3FC AR5 = 0301 *dlog iptr2,z = 0x0302 Device Driver Version 02.15
0 Errors, 0 Warnings. [RPTC = 0000 ARE = E@zc | E(g ggg,gg
TOZ = 034F BR7 = 24F¢ =l = .
—l| ™R = oooo v - |
A[A[E o] Build / IE o[ |l | [ 7 A[ATP M, watena Cwaj[« ]| »[ | Command Evecute_|
"[bsP HALTED [REALTIVME For Help, press FL [noooo, coloon [ wom [

-_ il start “ HEDSE > H Humﬂur—M\trnsn.‘.l [ Labz LF2407, doc | @ /sdgozux { spe... [BRworkspace.jpg l... I%gqﬁp ORESHFEFRFD ssim

Part 6 — Using General Extension Language (GEL) capabilities

Y ou can use GO DSP Extension Language (GEL) files to add custom features to the GEL menu
on the Code Composer menu bar. Code Composer will automatically load the GEL file “init.gel”
at the start of each session. This GEL file can be customized with speciaty features, and other
GEL files can be created and added to the project.

1. IntheProject View window of your workspace, right-click on the “init.gel” file under the
folder “GEL Folders’ and select the properties. Thiswill show the source path of thefile.
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[ /sdgo2xx { Spectrum Digital }/CPU_1 - C2%X Co:

File Edit Wiew Project Debug  Profiler Ophion  GE

I e
s Project view .

Lt

@ Files
=1+ GEL files
HD Praject Sl

2 Reload i -
&l % ga - H Source File Properties i x|

Propetties ...

File: M arne: IE:\ticEHH\cc\gel'\init.gel

| Bllay Docking
D Hide
v Float In Main Window
[=-[_1] Saurce

----- c200mnrt. asm

File Size: 15356 bytes
Lazt Modified: Tuesday, February 08, 2001

Code Composer references theinit.gel file at the C:\tic2xx\cc\gel directory at the start of each
session. Modifying or replacing that file can add special or custom GEL functions, which will
be available at the start of each Code Composer session.

Go to the Menu bar and note the available options under the GEL pull-down. These were
defined by the current init.gel file.

Open up Microsoft File Explorer. Browseto C:\DSP24 1DAY\LABSLab2 and find the copy
of init.gel located in that directory. Copy the file. Browse to C:\tic2xx\cc\gel directory and
replace theinit.gel file there with the one located in the Lab2 directory.

Shutdown Code Composer and restart it. Now go to the Menu bar and note the new additional
functions under the GEL pull-down. These will now be available at the start of each session
of Code Composer, and for each previously created workspace that uses theinit.gel file.

First init.gel

1 - C2XX Code Composer- RealZd4xx.mak

Option | GEL  Tools  ‘Window Help

After Step 4 update of init.gel

U _1 - C2XX Code Composer- RealZz4xx.mak

iler ©Option | GEL Tools  Window  Help

Memoary Maps  # W | Ii Mernary Maps * l | '
=== Specialty _Funcktions »
= by =|C  EventManager k !
oooo REZET: =  aDcC FISET:
ooon ¥9s80 B . SerialCann r . [
g g g g —_— ]gNT 1: Cther Reqisters T
Ann A THTT . Flonn? 79an R 1

L oading and Removing GEL files can also be done by right clicking on the GEL files
themselves in the CC Window “Project View.” This can only be done, however, if Code
Composer is not in Real-time mode. Other GEL files with different file names can be loaded
into the project aswell.

The new init.gel provided Specialty Functions, like go MON_GO. Using this GEL command
replaces the repetitive steps of resetting the DSP and executing the go MON_GO in the
Command Window. Y ou will still need to complete the final step of going to the pull-down
menu item Debug = Real Time Mode.

The periphera registers can be added to the Watch Window. Currently your watch window
may be displaying the memory locations / variables listed in Part 2. Those variables were
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displayed in the tab labeled “Watch 1.” Click on the tab “Watch 2" for a different Watch
window. Go to pull-down menu GEL - EventManager > Watch T1 Regsand the Timer 1
Registers will be displayed in the active Watch Window (in tab Watch2).

1 - C2XX Code Composer- Real24xx.mak

Cption | GEL Tools  Window Help

Memory Maps ’”ﬁ ﬁl}at|i§i‘k?

Specialty_Functions *

;HE EventManager 4
ADC 3
SerialCom »

Other Registers 3
i

| iEIEIEZ

Watch_T1_Regs

Watch_T2_Regs
Watch_T3_Regs
Watch_T4_Regs
Watch_CMPA_ACTR_DETCOM

2. Watch Window g

GPTCOHA =
TICHT =
TI1CMPR =
T1PR =
T1CON =

=101 x|
0x6000 I
0x02CF

0x0000

0x07D0

0x9040

-

AT AT I wvstch 1 p wateh 2 A] <]

=

9. Let'srestart the program. If power to the eZdsp™ was lost, then the program Real 24xx.out
will have to be reloaded to the eZdsp™ target processor. (Repeat the action in Part 1, Step 9).
Real-time monitor mode will have to be activated, repeat the action of Part 6, Step 7, (two
steps prior.) RUN the program and observe the registersin Watch 2. If they are not updating,
right-click on the Watch Window and make sure Continuous Refresh is checked on. (Note
that this only affects the active Watch Window. Enabling Continuous Refresh on Watch 1
does not enable it for the other Watch Windows.) T1CNT, T2CNT, and T3CNT arethe
read/write counter registersin each of the three GP timers. The program isusing timer 1 so
this Watch operation shows the changing value of the Timer 1 counter register.
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TMS320C240x Architecture

Learning Objectives

L earning Objectives

¢ TMS320C240x Core Architecture
¢ Addressing Modes

¢ Instruction Set

¢ Interrupts
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TMS320C240x Core Architecture

TMS320C240x Core Architecture

TM S320C240x Block Diagram

Program Bus
)
:E v
§ Program Memory,
A(15-0) Memory Mapped
Registers|
D(15-0) C Y e
«— |
| DataBus r 3
_________________ U : v %5‘;
' [ Peripherals | Multiplier
'_:’ (Event Mgr) F:» Data P
: ! T
: Peripherals |l ! | Memary
“T (Non-Event Mgr) [ AL U/Shifters
’ ;

Multiplier and ALU / Shifters

Program Bus

Data Bus 31-6
4 16 6¢ 16
16 T (16) MUX
16 MULTIPLIER |<——
P (32) 16
SHIFTER (0-16) 4 3

SHIFTER (-6, 0, 1, 4)

ALU (32
32
ACCH (16)| ACCL (16)

32

SFL (0-7)
Data Bus 18
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Program Memory

Program Bus
16
\Mux/
16 16
1 "
{12_15 L {1(5‘—/;»
Address STACK
Program (8x16)
ROM /
A0 | FLASH
2 16 Instruction
16
D(15-0) Y 16
<—>{ ) 16
h 16—
l Data Bus {

vy v
To Data Memory

TM S320L F2407 Program Memory Map

Hex Program
0000 Interrupts

0040 |Code Security PSWD
0044

On-chip 32K Flash

(External if MP/MC = 1)

8000 SARAM (2K)
(PON=1) or
External (PON = 0)

8800 External
FEOO| Reserved (CNF = 1)
External (CNF = 0)

FF00| On-chip DARAM BO
(CNF =1) or
External (CNF = 0)

FFFF
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Data Memory

Data Bus
216
From Program Memory ARO(lG)
3 AR1(16) 718
- 3 AR2(16) From IR
ARP(3) AR3(16)
161 16 ARA4(16)
3 AR5(16)
ARG6(16)
ARB(3) AR7(16) "
A A T ‘ 3
4#3 \MuUx/ ARAU(16) MUX
16
16
Data/ Program
Data RAM
RAM 16
% 16 167 J16

TM S320L F2407 Data Memory M ap

Hex Data
0000[ M emory-Mapped
Registers
0060 On-chip DARAM B2
0080 Reserved
0200[ On-chip DARAM B0
(CNF=0) or
Reserved (CNF = 1)
03001 on-chip DARAM B1
0400 Reser ved
0800~ SARAM (2K)
(DON = 1) or
Reserved (DON = 0)
1000 Reser ved
7000 Non-EV Peripherals
400 EV Peripherals
;(5)£ Reser ved
FEFF External
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Peripherals

Event M anager p——
GPTimers
Compar e Unit

PWM Outputs

Dead-Band L ogic

Capture Unit
Quadrature

ncoder
Pulse (QEP)

v

Non-EV Manager
Watchdog Timer

Data Bus

A/D Converter
| /O Pins
CAN

IIHQ
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Addressing Modes

Addressing Modes

Data Addressing Modes

Mode

Purpose

Immediate
(Constant)

Initialize registers, oper ate with
constants

Direct
(Paged)

Access data on a given pagein
any order

Indirect
(Painter)

Access data from arrays anywherein
data memory in an orderly fashion

Immediate Addressing

Immediate Addressing Syntax

ADD #8000h,1

1) 1
2) ADD
3)

Shift operand left 1-bit
Optional, 0 default
Operate on shifted operand

Result is stored in Accumul ator
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Direct Addressing

Direct Addressing

7 Page 511
/| Page 510

512 Pages /

1
128-Word
Page
Y
Using direct addressing to generate a 16-bit address

15 76 0
HENRERRRNARRRERN
} DP dma

Direct Addressing Block Diagram

Instruction Register

1514131211109 8 7 6 5 4 3 2 1 0

’ Opcode | 0 | dma I
7 LSBsfrom
] Data Bus (16) l Instruction
Register (IR)
DP (9)
9 7

Ya

16-bit Data Address
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Addressing Modes

Direct Addressing Syntax

ADD X, 1

1) X
2 1
3) ADD
4)

DP register concatenated with

X address operand

Shift operand left 1-bit

optional, O default
Operate on shifted

operand

Result isstored in accumulator

Instruction

LDP #2
ADD 56h

Program i
Memory |
|

Opcode

ADD | 56

C240x Direct Addressing Example

DP i Data Memory i Data
0 0000 0010 | | Bus
Address
9-bit Operand 0100
Address

| 0000 0001 0] 101 0110 |~

0156 | FO22 f—> F022

l<— 9 bits—>t=<—7 bits—

* DP register pointsto “Data Page”
« Direct address (in instruction) selects
1 of 128 |locations on the “ Data Page’
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Indirect Addressing

Indirect Addressing Syntax

ADD *+,1,AR0

1) * ARP selects AR to address
operand
2) 1 Shift operand left 1-bit

optional, 0 default
3) ADD Operateon shifted operand
4 + Modify AR value - optional
5 ARO New ARP value - optional

Indexing the Auxiliary Registers

ARP=101b AR (ARP)=AR5 AR5 = 0200h ARO = 0004h

Successive indexing oper ationsyield the following in ARS:

FFT
* *+/*- | *O+}*0-_|*BRO+*BRO- Resequencing
0200 0200 0200 0200 X(0) | 200h
0200 0201 0204 0204 X(@)
0200 0202 0208 0202 =
ARS | 0200 0203 020C 0206 X(2)
0200 0204 0220 0201 X(6)
0200 0205 0224 0205 )
0200 0206 0228 0203
0200 0207 022C 0207 X(5)
0200 0208 0230 0200 Q)
X(7) | 207h
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Addressing Modes

C240x Indirect Addressing Example

«opcode* [ +, -, 0+, 0-, BRO+, BRO- ] [, new ARP]

Instruction i Program ARP i Data i Data
! Memory (selects“current” | Memory | Bus
! AR register) ! !
lofo]1]
Opcode ARO
1234
|sus *||suB[1]... AR1| 1234 Fo23)—> Fo23
* means
A AR7
“Indirect” “Indirect Bit”

Addressing Summary

DP

IMMEDIATE INSTRUCTION
OPERAND IOPCODE| operand I
DIRECT INSTRUCTION
ADDRESSING |OPCODE[ dma
\
INDIRECT INSTRUCTION
ADDRESSING OPCODE| ARP |

Methods of Instruction Operand Addressing

I —
! 16 operand

L [AR ARP% ] operand |
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Instruction Set

TM S320C240x | nstruction Set

Accumulator Auxiliary Register and Multiply, T, P
Memory Reference Data Page Pointer APAC MPYA
ABS NEG SUB ADRK MAR LPH MPYS
ADD NORM  SUBB CMPR SAR LT MPYU
ADDC OR SUBC LAR SBRK ﬂg S’Sﬁc
ADDS  ROL SUBS LDP ) o
AND  SACH XOR. LTS SPL
i MAC  SPM
CMPL SACL  ZALR C;TTWH”S"P“C‘;SO”S MACD SQRA
LACC  SFL MPY  SQRS

BITT POPD

t’:g# SFR CLRC  PSHD

IDLE PUSH
RPT SETC Branch
1/0 and Data LST SST B cc
Memory Operations NOP BACC INTR
BLDD  OUT BANZ — NMI
BCND RET

BLPD  SPLK
CALA RETC
DMOV  TBLR CALL TRAP
IN TBLW

Central Arithmetic Logic Unit

Program Bus T

16

Data Bus
16 LTy 16 16y 16
16 T (16) MUX &
16 Len MULTIPLIER .
—{ _ P@2 16
[ SHIFTER (0-16) i V32 S
LACC SHIFTER (-6,0, 1, 4) H
ADD ' PAC
s — 7 _— | [T ! APAC
| SPAC
32
ACCH (16) AccL (16) |
Ve T — 32
SACL SFL (0-7)
Data Bus i
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Program Control

BRANCH CALL RET
B next CALL sub RET
BACC CALA —
BCND next,cnd,cnd,... | CC sub,cnd,... RETC cnd,cnd,...
Conditional Codes
EQ ACC=0 |[NEQ ACC=#0
LT ACC<0 |GT ACC >0 BANZ
LEQ ACC<0 |GEQ ACC=20 Branch on AR #0
C Cc=1 NC Cc=0
oV ov=1 NOV 0OV =0
TC TC=1 NTC TC=0
BIO BIO=0 [UNC uncond.
Using SPLK
SPLK means Store Parallel Long Immediate
Problem: Store a 16-bit immediate value to memory
Solution Code Words/ Cycles
UsingLACC LACC  #1234h 212
SACL meml 1/1
R3]
Using SPLK SPLK  #1234h,meml 2/2

Benefits: o SPLK doesnot usethe ACC

o If immediate valueis 9-16 bits, you save 1w/1c

e Themnemonicissimpler toread

Note: If immediate value is< 8 bits, you could use LACL

instead of LACC and save theextra cycle
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Instruction Set

Basic Sum-of-Products

LT
MPY
APAC

Data Data Bus

Data Memory

Sum-of-Products

y = Axl + Bx2 + Cx3 + Dx4

LT X1
MPY A
PAC

LT X2
MPY B
APAC

LT X3
MPY C
APAC

LT X4
MPY D
APAC
SACL y

;T = x1

;P = Ax1

;ACC = Ax1l

;T = x2

: = Bx2

;ACC = Axl + Bx2
;T = x3

iP = Cx3

;ACC = Ax1l + Bx2
;T = x4

;P = Dx4

;ACC = y

;Store result

+ Cx3
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Instruction Set

Enhanced Sum-of-Products

Y:

LT
PAC }\\\MPY
LT X2 S
MPY
APAC
LT X3 i
MPY
APAC LTA
LT X4 MPY
APAC
SACL

X1
A
X2
B
X3
C
X4
D

Y

Ax]l + Bx2 + Cx3 + Dx4

x(h)

FIR Filter Implementation

»y(h)

EISUEL S ERS S E
a0 <X> al J() a2 J() a3 <X> a4 <X>
> > >

y(h) =[a0x x(h)] +[al xx(h-1)] + [a2x x(h-2)]
+[a3x x(h=3)] + [a4 x x(h—4)]

¢ A delay chain isrequired!
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Delay Chains: Ripple Buffers

y(K) = bgx(K) + byx(k-1) + bx(k-2)

Lower — >

memory
address

Higher
memory
address

X(0)

) DMOV x,
X ) DMOV x,

X(2)

Filters= Sum of Products + Delay Chain

LT APAC

MPY LT T LTA

APAC DMOV DMOVJ) "LTD

DMOV MPY MPY MPY
4 cycles 4 cycles 3cycles 2 cycles
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Instruction Set

2nd-order FIR on C240x

y(K) =box(k) + byx(k-1) + byx(k-2)

FIR: N X0, ADC 9 cydle core bo
LACL #0 // by
LT x2 b,
MPY B2 .
LTD X1 .
MPY Bl °
LTD X0 s Xo
MPY  BO = 8 )
APAC g8 Xy
SACH YO0 gﬂf X, )

OUT  YO,DAC

Data memory

PID algorithm on C240x

u(k) = u(k-1) + coe(k) + cre(k-1) + coe(k-2)

PID: IN EO, ADC
LACC U116 L9 cycle core
LT e &
MPY  C2
LTD  E1
MPY C1
LTD  EO
MPY  CO
APAC J R
SACH U1 e(k) PID u(k)
OUT  Ul,DAC
B PID
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Instruction Set

MAC Instruction

MAC <pma>, <dma>

Equivalent to:
APAC, LT <dma>, MPY <pma>

Filters= Sum of Products + Delay Chain

LT APAC

MPY LT [~ LTA

APAC DMOV DMOV LTD}
DMOV ~ MPY  MPY  MPY M@:D

4 cycles 4 cycles 3cycles 2cycles lcycle
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Instruction Set

RPT - Repeat Next Instruction

RPT #<n> ;repeat next instruction (n+1) times
Example:
RPT  #199 ;repeat next instruction 200 times

MACD coeff, *+ ;add from * and increment current AR

MAC and MACD Instructions

< < Program
Data memor = =
y 3 5 memory
O o
: :
«©
% &
o S
ot
16 &Y
G
{ 32 l
ALU 32
1
’ ACC
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Nth-order FIR on C240x

y(K) = box(K) + byx(k-1) + bx(k-2) + ... + b x(k-n)

LAR AR, #X0 Al Y
LAR  ARO, #n .
MAR  * ARL Xo ) coeff: | By
X]_ Bn-l
FIR: IN *+0, ADC )
L-N+8 . .
Lac #0 .~ cycle . .
MPY  #0 core = B
RPT #n-1 n-1 2
MACD coeff, *- X ) B
APAC n =
SACH * extra) By | ¥
OUT  *+ DAC Data Program
B FIR memory memory
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Interrupts

Interrupts
Interrupt Structure of C240x
Core
Compare1,2,3 | Compare4,5,6
INT1 Timer 1 Timer 3

INT2 } Timer 2 Timer 4 IEV
INT3 Capture1,2,3 | Capture4,5,6 I

| PDPINTA | PDPINTB |
INT4

INT5 XINT1,2 (high priority)
SPI, SCI, CAN (high priority)
INT6 ADC (high priority) Non
I —

SPI, SCI, CAN (low priority) EV

ADC (low priority)
XINT1,2 (low priority)

Peripheral Interrupt Management -
Individual Flag and Mask Bits

ToCore
— Interrupt
XINT1 ﬁ m
’ Fllag‘ ‘ POIamy‘ ‘Enablel Arbitrator
XINT2 ! \—D—\_‘
’ Flag‘ ‘Polarity‘ ‘Enable’
* =D
ADCINT
’Flag‘ ‘Enable’

| . D
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Interrupts

Corelnterrupt Management

Core (IFR) (IMR) (INTM)
Interrupt | “Latch” “Switch” “Global Switch”
INT1 ——»/-—» >
— C240x
INT2 —+——{ 0 - .
[j Core
INTs ——{ L} > >

A valid signal on a specific interrupt line causesthe latch
todisplay a" 1" in the appropriatebit. If theindividual and
global switchesareturned on, the interrupt reachesthe core.

Determining I nterrupt Source

¢ Each peripheral interrupt loads a unique offset
valueinto the Peripheral Interrupt Vector Registers

« location of PIVR @ 701Eh (in data space)

INT1 (core) INT2 (core) INT3 (core) INT4 (core)

PDPINTA  0020h CMPI1INT  0021h T2PINT 002Bh CAP1INT 0033h
PDPINTB 0019h CMP2INT  0022h T2CINT 002Ch CAP2INT 0034h
ADCINT 0004h CMP3INT  0023h T2UFINT  002Dh CAP3INT 0035h
XINTL 0001h TI1PINT 0027h T20FINT  002Eh CAP4INT 0036h
XINT2 0011h T1CINT 0028h T4PINT 0039h CAPSINT 0037h
SPIINT 0005h TIUFINT 0029h T4CINT 003Ah CAPGINT 0038h
RXINT 0006h T1OFINT  002Ah TAUFINT  003Bh

TXINT 0007h CMP4INT  0024h T4OFINT ~ 003Ch INT5 (core)
CANMBINT 0040h CMPSINT  0025h SPIINT 0005h
CANERINT 0041h CMP6INT  0026h INTS (core) RXINT 0006h
h
TNT Oozh | ADCINT  0004h | TXINT 0007h
Phantom Interrupt T3UEINT 0031h XINTL 0001h CANMBINT  0040h
Vector 0000h XINT2 0011h CANERINT  0041h

T3OFINT 0032h
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Interrupts

Basic Approach - (XINT1 example)

GISR
i SIS PIVR .set 701Eh
B e text
B gisr ——| (i S LDP #PIVR>>7
B gisr LACC PIVR,1
B gisr ADD #sivt
BACC
text
sivt B phantom
B xintl <
B phantom SISR
B phantom text
B phantom bl Xi N1 specific interrupt code
B spiint .
B rxint .
g Gl CLRC INTM
phantom
B phantom RET
B phantom

Over
Current
Sensor

Power Drive Protection - PDPINTA & PDPINTB

¢ Interrupt latency may not protect hardware when
responding to over current through I SR software

+ PDPINTX hasafast, clock independent logic path to
high-impedance the PWM output pins (~ 45-55 ns)

C240x
DSP || PDPINT
CORE flag

T

PDPINTx Enable

NERERRREERE
nwHdcuv-Hco Z=vU
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Module 3 Lab: Enhanced Sum of Products

Module 3 Lab: Enhanced Sum of Products

Module 3 L ab:
Enhanced Sum of Products

¢ Use Code Composer to build
MOD3LAB.ASM

¢ Observethe operation of the L F2407
ar chitecture:

+« Memory

« Multiplier

« ALU

« Auxiliary Registers

Introduction

The objective of thislab isto familiarize the student with the programming and operation of the
TMS320L F2407 core: the ALU, multiplier, addressing features, accumulator, and the memory.
The processor will beinitialized with two arrays of four elements each from atable. Pointers will
be setup, and the routine will perform the sum-of-products. The result will be stored in data
memory.

Recall that there are severa ways to execute a sum-of-products

1) A succession of LT, MPY, and APAC instructions

2) A succession of LTA, MPY instructions

3) A RPT instruction followed by a MAC instruction

Note that the order of operations could be extremely important since some instructions make use
of previous values. Pointers must be initialized to the correct location. When using the
RPT/MAC combination, the product register and accumulator must beinitially cleared, since the

first operation will be an accumulation and amultiply. The product register can be easily cleared
using a MPY #0.

Thislab will use method #2. A flow chart of the codeis shown in figure 3.1.
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Module 3 Lab: Enhanced Sum of Products

Start

!

CPU Initialization

watchdog disable
SCSR1 & 2 register
wait-state generator
shared pins

Memory Initialization

e |nitidlize data values
e |nitidize coeff values
e [nitidlizeresult location

L oop | nitialization
<

e  Setup Pointers (aux-
iliary registers)

v

Sum of Product

e Begin the sum of products

e Storetheresult

e  Start at the beginning of
the loop

Figure 3.1: Code Flow
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> Procedure

Create a New Project

1

Double-click on the Code Composer icon on the desktop. Maximize Code Composer to fill
your screen. The menu bar (at the top) lists File ... Help. Note the horizontal tool bar bel ow
the menu bar and the vertical tool bar on the left-hand side. The window on the left isthe
project window and the large right hand window is your workspace.

A project isall the filesyou’ll need to develop an executable output file (. OUT) which can be
run on the target hardware. Let’s create anew project for thislab. On the menu bar click:

Project > New

and make surethe “SAVE IN” locationis: C: \DSP24 1DAY\LABS and type MOD3LAB in
the file name window. Thiswill create a make file which will invoke all the necessary tools
(assembler, linker, compiler) to build your project.

Add the assembly file to the new project. Click:
Project = Add Files to Project

and make sureyou'relooking in C: \DSP24 1DAY\LABS. Change the“files of type” to
view assembly files (. AsM) and select MOD3LAB . ASM and click OPEN. Thiswill add the
fileMOD3LAB . ASM to your newly created project.

Add MOD3LAB. CMD to the project using the same procedure.

In the project window on the left click the plus sign (+) to the left of Project . Now, click
on the plus sign next to MOD3LAB . MAK. Notice that theMOD31.AB. CMD fileislisted. Click
on the plus sign next to Source to see the current sourcefilelist (i.e. MOD3LAB . ASM).

Setup the Linker

6.

Setup the linker options by clicking:
Project > Options

on the menu bar. Select the Linker tab. In the middle of the screen select “No
Autoinitialization”. (If needed, amap file can be created by using the Map
Filename [-m] field). Next, select the Assembler tab. Inthe middle of the screen check
“Enable Source Level Debugging”. (Thisfeature alowsyou to debug using both
source and assembly, known as “mixed mode”). Then select OK to save the Build Options.

Build and Load

7.

Thetop four buttons on the vertical toolbar control code generation. Hover your mouse over
each button as you read the following descriptions:

Button Name Description
1 CompileFile Compile, assemble the current open file
2 Incremental Build Compile, assemble only changed files, then link
3 Rebuild All Compile, assemble al files, then link
4 Stop Build Stop code generation
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8. Clickthe“Rebuild A11” button and watch the tools runin the build window. To open
more space, right-click on the build window and Hide the build window.

9. Load the output file onto the target. Click:
File = Load Program.

Make sureyou arelookingin C:\DSP24 1DAY\Labs. Select MOD3LAB.OUT and click
OPEN.

Note: Code Composer can automatically load the output file after a successful build. On the
menu bar click: Option > Program Load.. and sdect: “Load program after
build”, thenclick OK.

10. If code generation is successful, the Dis-Assembly window will display the source file
(MoD3LAB.ASM) and ayellow highlight on “B start” should appear. Thisindicates that you
are now ready to run.

Running MOD3LAB

11. Inspect MOD3LAB . ASM in the source window. Note how the topics covered in the module
are used in the program code.

12. Open amemory window. On the menu bar click:
View - Memory

or click the View Memory button on the vertical toolbar. Type “table” into the address to
display the contents of the memory starting at label table. (Note: Code Composer is case
sensitive). Y ou can display as many independent windows as you require. Do you see the
initial valuesin the memory window displaying “table’? Open another memory window
starting at label data. During initialization, the values from memory starting at label “table’
will be copied to the memory locations starting at label “data’.

13. To seethe CPU registers. On the menu bar click:
View = CPU Registers > CPU Registers

Right click inthe CPU Registers window and deselect “Allow Docking”. Youcan
now move and resize the window as you like.

14. Next, single-step the routine by using the <F8 > key or click the single-step button on the
vertical toolbar repeatedly past the initialization and to the beginning of the “ Sum-of -
Products Routine”. While in the sum-of-products routine, single-step through the program
and watch the memory windows and CPU registers. Did you get the expected answer (28h)?

Optional

15. Y ou might want to experiment with this code by changing some of the values. By double-
clicking on amemory location in the memory window you can edit the contents of that
memory location. Also, contents of any CPU register can be edited by double-clicking on it.
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MODS3LAB.ASM

; MOD3LAB.ASM

.bss temp, 1 ;general purpose variable
.bss data, 4 ;jallocate space for data
.bss coeff, 4 ;allocate space for coeff
.bss result,1 ;jallocate space for result
data
table: .int 1,2,3,4 ;table values for data
int 8,6,4,2 ;table values for coeff
.int 0 ;table value for result
length set S-table ;calculate size of table

.sect "vectors"

B start ;00h reset
intl: B intl ;02h INT1
int2: B int2 ;04h INT2
int3: B int3 ;06h INT3
int4: B int4 ;08h INT4
inths: B int5 ;0Ah INTS
inté: B inté ;0Ch INT6
int7: B int?7 ;0OEh reserved
int8: B int8 ;10h INT8 wuser-defined
int9: B int9 ;12h INT9 user-defined
intl10: B int10 ;14h INT10 user defined
intll: B intll ;16h INT11l user defined
intl2: B intl2 ;18h INT12 user defined
intl3: B int13 ;1Ah INT13 user defined
intl4: B intl4 ;1Ch INT14 user defined
intls: B intl5 ;1Eh INT15 user defined
intlé6: B intlé ;20h INT16 user defined
intl7: B intl7 ;22h TRAP
intl18: B intl8 ;24h NMI
intl9: B int19 ;26h reserved
int20: B int20 ;28h INT20 user defined
int21: B int21 ;2Ah INT21 user defined
int22: B int22 ;2Ch INT22 user defined
int23: B int23 ;2Eh INT23 user defined
int24: B int24 ;30h INT24 user defined
int25: B int25 ;32h INT25 user defined
int26: B int26 ;34h INT26 user defined
int27: B int27 ;36h INT27 user defined
int28: B int28 ;38h INT28 user defined
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int29 ;3Ah INT29 user defined
int30 ;3Ch INT30 user defined
int31 ;3Eh INT31 user defined

bit
bit
bit
bit

* ¥ X *

LDP #DP_PF1 ;set data page
SPLK #11101000b, WDCR

1l: clear WD flag

1: disable the dog
3 101: must be written as 101
0 000: WDCLK divider = 1

~.

bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit

L . T R R R S . T

bit
bit
bit
bit
bit
bit

* % ok X X % ~.

15
14
13
11

[eo)

O R N WH Uy J

LDP #DP_PF1 ;set data page
SPLK #0000000011111101b, SCSR1
NARRRRRARRRERNR
FEDCBAS9876543210
0: reserved
0: CLKOUT = CPUCLK
-12 00: IDLEl selected for low-power mode
-9 000: PLL x4 mode
0: reserved
1: 1 = enable ADC module clock
1: 1 = enable SCI module clock
1: 1 = enable SPI module clock
1: 1 = enable CAN module clock
1: 1 = enable EVB module clock
1: 1 = enable EVA module clock
0: reserved
1: clear the ILLADR bit
SPLK #0000000000001111b, SCSR2
NERNRRRRRRRRRNY
FEDCBAS9876543210
-6 0's: reserved
0: DO NOT clear the WD OVERRIDE bit
0: XMIF HI-Z, O=normal mode, 1=Hi-Z'd
1: 1 = disable the BOOT ROM
1: MP/MC*, 1 = Flash addresses mapped external
0 11: 11 = SARAM mapped to prog and data

;Set wait states for external memory interface on eZdsp (TM) LF2407

;set data page
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SPLK #0000000001000000b, temp

; NERRRRRRRRRRRRN

; FEDCBA9876543210

* bit 15-11 0's: reserved

* bit 10-9 00: bus visibility off

* bit 8-6 001: 1 wait-state for I/0 space

* bit 5-3 000: 0 wait-state for data space

* bit 2-0 000: 0 wait-state for program space
ouT temp, WSGR

LDP #DP_PF2 ;set data page
SPLK #0000000000000000b, MCRA
* NERNRRRRRRRRRNY
* FEDCBAS9876543210
* bit 15 0: 0=I0PB7, 1=TCLKINA
* bit 14 0: 0=I0PB6, 1=TDIRA
* bit 13 0: 0=I0PB5, 1=T2PWM/T2CMP
* bit 12 0: 0=I0PB4, 1=T1PWM/T1CMP
* bit 11 0: 0=I0PB3, 1=PWM6
* bit 10 0: 0=I0PB2, 1=PWM5
* bit 9 0: 0=I0PB1, 1=PWM4
* bit 8 0: 0=I0PBO, 1=PWM3
* bit 7 0: 0=I0PA7, 1=PWM2
* bit 6 0: 0=I0PAG, 1=PWM1
* bit 5 0: 0=I0PAS5, 1=CAP3
* bit 4 0: 0=I0PA4, 1=CAP2/QEP2
* bit 3 0: 0=I0PA3, 1=CAP1/QEP1
* bit 2 0: 0=I0PA2, 1=XINT1
* bit 1 0: 0=I0PA1, 1=SCIRXD
* bit 0 0: 0=I0PAO, 1=SCITXD
SPLK #1111111000000000b,MCRB
* NERNRRRRRRRRRNY
* FEDCBAS9876543210
* bit 15 1: O=reserved, 1=TMS2 (always write as 1)
* bit 14 1: O=reserved, 1=TMS (always write as 1)
* bit 13 1: O=reserved, 1=TD0 (always write as 1)
* bit 12 1: O=reserved, 1=TDI (always write as 1)
* bit 11 1: O=reserved, 1=TCK (always write as 1)
* bit 10 1: O=reserved, 1=EMUl (always write as 1)
* bit 9 1: O=reserved, 1=EMUO (always write as 1)
* bit 8 0: 0=I0PDO, 1=XINT2/ADCSOC
* bit 7 0: 0=I0PC7, 1=CANRX
* bit 6 0: 0=I0PCe6, 1=CANTX
* bit 5 0: 0=I0PC5, 1=SPISTE
* bit 4 0: 0=I0PC4, 1=SPICLK
* bit 3 0: 0=I0PC3, 1=SPISOMI
* bit 2 0: 0=I0PC2, 1=SPISIMO
* bit 1 0: 0=I0PC1, 1=BIO*
* bit 0 0: 0=I0PCO, 1=W/R¥*
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bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit

LR . . R S TR R R N R

Y el el
OR N WKL

O N WK U1 Oy J

SPLK

#0000000000000000b, MCRC

876543210

FEDCBAS

O OO OO0 0O0OO0OO0OO0OO0OoOOoOOoo

reserved
0=I0PFe6,
0=I0PF5,
0=I0PF4,
0=I0PF3,
0=I0PF2,
0=I0PF1,
0=I0PFO,
0=I0PE7,
0=I0PE6,
0=I0PES5,
0=I0PE4,
0=I0PE3,
0=I0PE2,
0=I0PE1l,
0=I0PEO,

1=I0PF6
1=TCLKINB
1=TDIRB
1=T4PWM/T4CMP
1=T3PWM/T3CMP
1=CAP6
1=CAP5/QEP4
1=CAP4/QEP3
1=PWM12
1=PWM11
1=PWM10
1=PWM9

1=PWM8

1=PWM7
1=CLKOUT

loop:

sop:

LACC
SACL
BANZ

LAR
LAR
MAR
LT
MPY
LTP
MPY
LTA
MPY
LTA
MPY
APAC
LDP
SACL

*,AR1

*+,0,AR2
*+,0,AR3

loop, *-,AR1

AR1, #data
AR2, #icoeff

* , AR1
*+,AR2
*+,AR1
*+ ,AR2
*+ ,AR1
*+ ,AR2
*+,AR1
*+,AR2
*+ ,AR1

#result
result
top

AR1, #table
AR2, #data
AR3, #length-1

;AR1 is the source pointer

;AR2 1s the destination pointer
jcount value for BANZ loop

;ARP set to AR1

;load/store BANZ loop
;from .data to .bss
;branch on AR not equal 0

;AR1 is data pointer

;AR2 1s coeff pointer

;ARP set to AR1

;begin sum-of-products routine

;data page ptr set to result
;jstore result
jbranch to top
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This pageisintentionaly blank.
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Analog-to-Digital Converter (ADC)

Learning Objectives

L earning Objectives

¢ Understand the operation of ADC
¢ Configuration of the ADC registers
¢ LAB: Usethe ADC to sampledata
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Analog-to-Digital Converter (ADC) Overview

Successive Approximation Method

analog

Sy
comparator o
n-bit
\V2 Control N
n Sample L Logic SlLifpLE
p register
&Hod [
WS pit DAC

Fot

VREFHI  VREFLO
Conversion alwaystakes n stepsfor an n-bit ADC:

1. Start with all output bits0

2. Initial guessismade by settingMSB =1

3. If guess >V, then reset bit, else keep bit set

4. Remaining n-1 bits are sequentially tested, MSB — LSB

ADC Module Block Diagram (cascaded Mode)

Analog MUX Result MUX
ADCINO -
ADCIN1 10-bit, 500-ns
ADCIN2 » S/H +A/D
. converter
MUX . CT i EOC
ADCIN15 Select
Autosequencer
Ch Sel (state 0)
Ch Sl (state 1)
Ch Sdl (state 2)
Software Ch Sel (state 3)
EVA C
EVB .
Ext Pin (ADCSOC) Ch Sel (State 15)
Start Sequence
Trigger
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ADC Module Block Diagram (pual-sequencer Mode)

Analog MUX Result MUX
ADCINO— 0T »[RESULTO
ADCIN1—>| it, 500-ns —»[RESULT1
ADCIN2—» » S/H+A/D

: converter Zdwejcltt .
MUX Be! | Seguencer | 22 —>{RESULT7]
ADCIN15—»{ Select arbiter t
F»[RESULTS
—»[RESULTY]
SEQ1  SEQ2 Result .
Autosequencer Autosequencer Select | »[RESULTI5
[ MAX_convi ] — [ MAX_CONV2 |
Ch Sel (state 0) Ch Sel (state 8)
Ch Sl (state 1) Ch Sl (tate 9)
Ch Sdl (tate?) | —

Software

EVA :
Ext Pin Ch Sel (State7)
(ADCSOC) Start Sequence

Ch Sd (state 10)

Ch Sel (State 15)

Trigger

Start Sequen
Trigger

Software
EVB

* 6 o o

ADC Module

« Two independent 8-state sequencers
« “Dual-sequencer mode’
« “Cascaded mode’

L K 4

¢ Flexibleinterrupt control

10-bit ADC corewith built-in Sample & Hold (S/H)
Sixteen multiplexed analog inputs (8 on C2402)

Fast conversion time (S/H + conversion) of <500ns
Autosequencing capability - up to 16 autoconversions

Sixteen individually addressableresult registers
Multipletrigger sourcesfor start-of-conversion
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Control Registers

ADC Control Register 1 - upper Byte

ADCTRL1 @ 70A0h
ADC Module Reset Acquisition Time Prescale (S/H)
0= no effect Value = (binary+1) x 2
1=reset (set back to0 * Time dependent on the “ Conver sion
by ADC logic) Clock Prescale” bit (Bit 7“CPS")
15 14 13 12 11 10 9

| reserved | RESET | SOFT | FREE |ACQ_PS§|ACQ_PSZ|ACQ_P51|ACQ_PSO‘

%/—/

Emulation Halt Behavior

00 = stop immediately

10 = stop after current conversion
x1 = freerun (do not stop)

ADC Control Register 1 - Lower Byte

ADCTRL1 @ 70A0h

Continuous Run Sequencer Mode
0 = stops after reaching 0 =dual mode

end of sequence 1 = cascaded mode
1= continuous (startsall over

again from “initial state”

7 6 5 4 3 2 1 0
| CPS |CONT_RUN| INT_PRI |SEQ_CASC|CAL_ENA| BRG_ENA| HI/LO SEEEI— ‘
Con‘version Prescale Calibration and Self-Test Functions

OfCLK/l Interrupt Priority

1=CLK /2 0= high

1=low
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ADC Control Register 2 - upper Byte

ADCTRL2 @ 70A1h
EVB SOC Interrupt Flag (SEQ1) EVA SOC
(cascaded mode only) 0=nointerrupt SEQ1 Mask Bit
Oinoactlon 1=interrupt occurred 0= cannot be started
1= gart by EVB . by EVA trigger
dgnal Start Conversion (SEQ1) 1= can be started
0= clear pending SOC trigger by EVA trigger
1= softwaretrigger-start SEQ1
15 14 13 12 11 10 9 8

INT_ENA_|INT_ENA_|

INT_FLAG|EVA_SOC
EVB_SOCRST_SEQl| g grn1lseor BSY| SEQL | SEQL - _SOC_

_SEQ |STRT_CAL (MODE 1) | (MODE 0) _SEQ1 SEQ1
Reset SEQ1/ SEQ1 Busy Interrupt Mode Enable (SEQ1)
Start Calibration O=idle 00 = interrupt disabled
0=noaction 1=inprogress 0l=onINT_FLAG_SEQ1 set
1=immediate reset or 10 = interrupt every other EOS

start calibration if 11 =reserved

bit 3 of ADCTRL1=1

ADC Control Register 2 - Lower Byte

ADCTRL2 @ 70A1h
External SOC (SEQ1) Interrupt Flag (SEQ2) EVB SOC
0=noaction 0=nointerrupt SEQ2 Mask bit
1=gartbysignal 1=interrupt occurred 0= cannot be started
from ADCSOC pin by EVB trigger
Start Conversion (SEQ2) 1= can be started
(dual-sequencer mode only) by EVB trigger

0= clear pending SOC trigger
1= sx)ftv‘varetrigga'-start SEQ2

7 6 5 4 3 2 1 0

INT_ENA_|INT_ENA |
EXT_SOC| psr se02|soc._seodseqz Bsy| SE02 oz |'NT_FLAGIEVB_ SOC_

_SEQ1L (MODE 1) | (MoDEQ) | —EQ2 SEQ2
Reset SEQ2 S|EQ2 Busy Intie(rupt M ode Enable (SEQ2)
0= no action O=idle 00 = interrupt disabled

_. X 1=inprogress 01=onINT_FLAG_SEQ2 st
1=immediatereset 10=int t ther EOS
SEQ2 to “initial state” = Interrupt every other
11 =reserved

4-6 DSP24 1-Day Workshop - Analog-to-Digital Converter (ADC)



Control Registers

Maximum Conversion Channels Register
MAX_CONV @ 70A2h

+ Bit fields define the maximum number of autoconversions (binary+1)

Cascaded Mode
AL
reserved | MAX_ MAX_ MAX_ MAX_ MAX_ MAX_ MAX_
CONV 2 2 [CONV 2 1 |CONV 2_0 |CONV 1 3|{CONV 1_2|CONV 1.1 [CONV 1.0
J J
Y

SEQ2 —— pual Mode—— SEQ?

# Autoconversion session always startswith the “initial state”
and continues sequentially until the “end state”, if allowed

SEQ1 SEQ2 | Cascaded
Initial state | CONV0OO  CONV08 | CONV00
End state | CONVO7 | CONV15 | CONV15

ADC Input Channel Select Sequencing
Control Register

Bits 15-12 Bits 11-8 Bits 7-4 Bits 3-0
70A3n | CONVO3 | CONV02 | CONVO1 | CONVOO fCHSELSEQ1
70A4h | CONVO7 | CONVO06 | CONVO5 | CONVO04 ICHSELSEQ2
70Ash | CONV11 | CONV10 | CONV09 | CONVO08 CHSELSEQ3
70A6h | CONV15 | CONV14 | CONV13 | CONV12 ICHSELSEQ4

DSP24 1-Day Workshop - Analog-to-Digital Converter (ADC)



Sequencer Example

Sequencer Example

Example - Sequencer “ Start/Stop” Operation

N \\Em,l

EVA
PWM

Iulaly Vi, Vo Vg Iy lp s ViV, Vg

System Requirements:
*Threeautoconversions (I, I, | ) off trigger 1 (Timer underflow)
*Three autoconversions (V,, V,, V) off trigger 2 (Timer period)

Event Manager A (EVA) and SEQ1 are used for thisexample

Example - Sequencer “ Start/Stop” Operation
Continued
*MAX_CONV1isset to 2 and Channel Select Sequencing Control Registersare set to:

Bits— 1512 11-8 7-4 30
70A30 [V, [ 1, [ 1, [ 1,] CHSELSEQ1
70A4h [X | X | V5| V,| CHSELSEQ2

« Oncereset and initialized, SEQ1 waits for a trigger
« First trigger three conversions performed: CONVQO (1), CONVO1 (1,), CONV02 (I )

* MAX_CONV1valueisreset to 2 (unless changed by software)

« SEQ1 waits for second trigger

« Second trigger three conversions performed: CONVO3 (V,), CONV04 (V,), CONVO05 (V)
*End of second autoconversion session, ADC Resultsregisters have the following values:
RESULTO |, RESULT3 V,

RESULT1 |1, RESULT4 V,
RESULT2 |, RESULTS V,

* SEQ1 keeps “waiting” at current state for another trigger
— User can reset SEQ1 by softwar e to state CONV00 and repeat same trigger 1, 2 session
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ADC Conversion Result
ADC Conversion Result Buffer Register

RESULTO @ 70A8h through RESULT15 @ 70B7h
(Total of 16 Registers)

’J:B|14|13‘12|11|10‘ 9| 8| 7|L§B| 5| 4|3| 2| 1| O|

With Vgegy, =33V, and Ve o =0V, we have:

analog volts converted value RESULTx
33 3FFh 1111]1111|1100|0000
1.65 1FFh 0111]11111100|0000
0.00322 1h 0000]0000]0100|0000
0 oh 0000|0000|0000|0000

Integer Format:
How Do We Handle the Shift?

XIXIXIXIXIXIXIXIXIXI o[ 0l 0[ 0[O 0] RESUL Tx

15 bit shiftright — ¢
[o]oJolololololofololololololoTO IXIXIXIXIXIXIXIXIXIXT T T T T 1T 1 Acc

XIXIXIXIXIXIXIXIXIX] Data Mem

RESULTO  .set 70A8h
.bss value, 1

ot 6 words, 13 cycles

tex

LDP #RESULTO0>>7

LACL RESULTO

RPT #5
SFR

LDP #value
SACL value
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Integer Format:
A Better Solution for Handling the Shift

Shift left 10 RIXXXIXIXIXIXIXIX[0[0[0[0[0[0] RESUL Tx

25 15 9 Q
[ofoTofo o o IXIXIXTXIXTXIXXIXTXT o[ of of of o[ o[ 0] o[ 0] 0] 0[O O[ O[ O] O] ACC

oJoJoJo[OTOIXIXIXIXIXIXIXIXIXIX] Data Mem

RESULTO .set 70A8h
.bss value, 1

et 5words, 7 cycles

CLRC SXM

LDP #RESULTO0>>7

LACC RESULTO, 10

LDP #value

SACH value

What About Signed Input Voltages?
Example: -1.65V <V, <+1.65V
Add 1.65 voltsto analog input, then subtract “ 1.65" from

digital result
R
R
C240x
RESULTO .:;tta 70A8h V., R P . $
; Input Ch.
offset it 1FFh 38V Y ! nput L. x
.bss value, 1
VCCA
text
Y
CLRC SXM REFHI
LDP #RESULTO0>>7 Vv
LACC RESULTO, 10 REFLO
LDP #offset GND
suB offset,16
LDP #value
SACH value
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Module 4 Lab: ADC Sampling

Module 4 Lab: ADC Sampling

Ground 3.3Volts |IOPA2

i ®* ADC data
CPU copiesresult memory
connector :
wire RESULTO to buffer during
===

he)
£
3
ADCO o]
T : £
i GP Timer 2triggers ) s
| ADC SOC every —
20 ps (50kHz) View ADC
: @ buffer samples
@ Code Composer
GPTimer 2

Introduction

The objective of thislab isto familiarize the student with the programming and operation of the
on-chip ADC on the TMS320LF2407 DSP. The DSP will be setup to sample asingle ADC input
channel at a prescribed sampling rate and store the conversion result in a buffer in the DSP
memory. This buffer will operate in acircular fashion, such that new conversion data
continuously overwrites older resultsin the buffer. Recall that there are three basic ways to
initiate an ADC start of conversion (SOC):

1. Using software
a ADCIMSTART bitin ADCTRL1 causes an immediate SOC
b. ADCSOC bitin ADCTRL1 causes an SOC upon completion of the current conversion (if the
ADC iscurrently idle, an SOC occursimmediately)
2. Automatically triggered on user selectable event manager conditions
a. GPTimer 1 or 2 underflow (e.g. timer count = Q)
b. GP Timer 1 or 2 period match
c. GPTimer 1 or 2 compare match
3. Externally triggered using apin
a. ADCSOC pin
b. CAP3 pin (capture unit #3 edge detection)

One or more of these methods may be applicable to your particular application. In thislab, we
will be using the ADC for data acquisition. Therefore, one of the GP timers (GP Timer 2) will be
configured to automatically trigger an SOC at the desired sampling rate (SOC method 2b above).
The ADC end-of-conversion interrupt will be used to prompt the CPU to copy the results of the
ADC conversion into aresults buffer in memory. This buffer pointer will be managed in a
circular fashion, such that new conversion results will continuously overwrite older conversion
resultsin the buffer. In order to generate an interesting input signal, the code also alternately
toggles a GPIO pin (IOPA2) high and low in the ADC interrupt service routine. This pin will be
connected to the ADC input pin, and sampled. After taking some data, Code Composer will be
used to plot the results. A flow chart of the codeis shownin Figure 4.1.
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Start

v

CPU Initialization

watchdog disable
SCSR1 & 2 register
wait-state generator
software stack

core interrupts
shared pins

GPIO setup

.

ADC Initialization

e convert channel O on
Timer2 period match

e Send interrupt on
every conversion

e  Setup aresults buffer
in memory

'

Timer 2 Initialization

e clear counter

e  set period register

e settotrigger ADCon
period match

e set the clock prescaler

e enablethetimer

ADC interrupt ADC ISR
> e context save
o readthe ADC result
Main L oo e writeto results buffer
e adjust the buffer
. pointer
loop: B loop 44— toggle the GPIO pin

context restore
re-enable interrupts
return

return

Figure4.1: Code Flow
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> Procedure

Create a New Project

1

Double-click on the Code Composer icon on the desktop. Maximize Code Composer to fill
your screen.

Create anew project for thislab. On the menu bar click:
Project > New

and make surethe “SAVE IN” locationis: C: \DSP24 1DAY\LABS and type MOD4LAB in
the file name window. Thiswill create a make file which will invoke all the necessary tools
to build your project.

Add the assembly file to the new project. Click:
Project = Add Files to Project

and make sure you'relooking in C: \DSP24 1DAY\LABS. Change the“files of type” to
view assembly files (. AsM) and select MOD4LAB . ASM and click OPEN. Thiswill add the
fileMOD4LAB . ASM to your newly created project.

Add MOD4LAB . CMD to the project using the same procedure.

In the project window on the left click the plus sign (+) to the left of Project . Now, click
on the plus sign next to MOD4L.AB . MAK. Notice that theMoD41.2B. CMD fileislisted. Click
on the plus sign next to Source to see the current sourcefilelist (i.e. MOD4LAB . ASM).

Setup the Linker

6.

Setup the linker options by clicking:
Project —> Options

on the menu bar. Select the Linker tab. In the middle of the screen select “No
Autoinitialization”. (If needed, amap file can be created by using the Map
Filename [-m] field). Next, select the Assembler tab. Inthe middle of the screen check
“Enable Source Level Debugging”. (Allows debugging using “mixed mode”).
Then select OK to save the Build Options.

Build and Load

7.

8.

Click the "Rebuild A11” button and watch the tools run in the build window. To open
up more space, close any open files or windows that you do not need.

If the “Load program after build” option was not selected in Code Composer
(*option” menu, click on “Program Load..”) load the output file into the target.
Click: File = Load Program.

Make sureyou arelookingin C:\DSP24 1DAY\Labs. Select MOD4LAB.OUT and click
OPEN.

Then reset the DSP by clicking on: Debug = Reset DSP
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0.

If code generation is successful, the Dis-Assembly window will display the sourcefile
(MOD4LAB . ASM) and ayellow highlight on “B start” should appear. This indicates that you
are now ready to run.

Running MOD4LAB

10.

11.

12.

13.

14.

15.

16.

17.

18.

Inspect MOD4LAB . ASM in the source window. Note how the topics covered in the module
are used in the program code.

Single-step your code afew timesinto the MOD4LAB.2ASM file. Then scroll down through
the code and placethe cursor at the “loop: B loop” line. Set abreakpoint by right
clicking the mouse key and select Toggle breakpoint. Noticethat lineis highlighted
indicating that the breakpoint has been set. Next, locate the code segment that initializes the
ADC results buffer with the value 0x2407. Notice the effective use of the RPT instruction
coupled with the SACL for this purpose.

Open amemory window to view some of the contents of the ADC results buffer. The
address label for the ADC results buffer isadc_buf .

Run the code by using the <F5> key, or using the Run button on the vertical toolbar, or using
Debug = Run onthemenu bar. It should halt when it hits the breakpoint set at the main
loop. Verify that the ADC results buffer has been initialized with the expected value (e.g.
0x2407).

Removethe breakpointat “loop: B loop” by right clicking the mouse key and
select Toggle breakpoint.

Using the connector wire provided, connect the ADCINO (pin # P1-2) to “GND”

(pin # P6-49) on the eZdsp™. Exercise care when doing this as the power to the eZdsp™is
on, and we do not want to damage the eZdsp™ Then run the code again, and halt it after a
few seconds. Verify that the ADC results buffer contains the expected value of 0x0000.

Adjust the connector wire to connect the ADCINO (pin # P1-2) to “+3.3V" (pin # P6-45) on
the eZdsp™. Exercise care when doing this as the power to the eZdsp™is on, and we do not
want to damage the eZdsp™ Then run the code again, and halt it after a few seconds.
Verify that the ADC results buffer contains the expected val ue of OxO3FF.

Adjust the connector wire to connect the ADCINO (pin # P1-2) to IOPA2 (pin # P2-5) on the
eZdsp™. Exercise care when doing this as the power to the eZdsp™is on, and we do hot
want to damage the eZdsp™ Then run the code again, and halt it after a few seconds.
Examine the contents of the ADC results buffer (the contents should be aternating 0x0000
and OxO3FF values). Are the contents what you expected?

Open and setup a graph to plot a 50-point window of the ADC results buffer.
Click: view = Graph = Time/Frequency.. and set the following
values:
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Start Address adc _buf
Acquisition Buffer Size 50
Display Data Size 50

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000
Time Display Unit us

Select OK to save the graph options.

19. Recall that the code toggled the IOPA2 pin alternately high and low. If you had an

oscilloscope available to display IOPA2, you would expect to see a square-wave. Why does
Code Composer plot resemble a saw-tooth wave? What is the signal processing term for

what is happening here?

20. Recall that the program toggled the IOPA2 pin at a 50kHz rate. Therefore, a complete cycle
(toggle high, then toggle low) occurs at half this rate, or 25kHz. We therefore expect the
period of the waveform to be 40us. Confirm this by measuring the period of the saw-tooth
wave using the graph (you may want to enlarge the graph window using the mouse). The
measurement is best done with the mouse. The lower left-hand corner of the graph window

will display the X and Y axisvalues. Subtract the X-axis valuestaken over a complete

waveform period.
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Things to Think About (optional)

1. How could start-of-conversion method 1b (see introduction section) be utilized in thislab instead of
SOC method 2b? What advantage does method 2b offer?

2. The ADC uses a successive approximation method that is clocked from a pre-scaled version of the
CPU clock. The ADC is capable of running from the CPUCLK with a pre-scale factor of 1 (i.e. maxi-
mum speed). Can you think of areason why you would want to use alarger pre-scale value than 1?

Answer to 1: To implement method 1b, the CPU would respond to the timer period interrupt and initiate an
ADC SOC using software (e.g. using ADCTRL 1 control register bits). After the ADC conversion was
complete, the CPU would respond to the ADC end-of-conversion interrupt and transfer the results to the
results buffer. This approach requires the CPU to respond to two different interrupts, and incurs the
interrupt overhead associated with each of them. Using method 2b, the CPU needs to respond to only 1
interrupt.

Answer to 2: There are at |east two possible reasons.

1) A larger prescale value will cause the sample acquisition time to become larger, thereby giving the
ADC hold capacitor additional time to charge. Thisis sometimes necessary when the output imped-
ance of the signal feeding the ADC input pinislarge.

2) The ADC can be runin continuous conversion mode, where conversions continuously occur one after
another without the need for any triggering event. The rate at which these conversions take place can
be controlled by slowing down the conversion time (e.g. with a prescale greater than 1). This can be
useful for periodically sampling an input when a GP Timer is not available to trigger the conversions at
the desired rate.
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MOD4LAB.ASM

; MOD4LAB.ASM

adc_rate
adc_buf len
stk_len

;50kHz sampling rate

;ADC results buffer length
;stack length

adc_buf ptr
adc_buf
stk

.usect
.usect
.usect

"buffer",1
"buffer",adc_buf len
"stack",stk len

;general purpose variable

;ptr to next free buff addr
;reserve space for buffer
;reserve space for stack

intl:
int2:
int3:
int4:
inths:
inté:
int7:
int8:
int9:
intl0:
intll:
intl2:
intl3:
intl4:
intl5:
intlé6:
intl7:
intl18:
intl19:
int20:
int21:
int22:
int23:
int24:
int25:
int26:
int27:

0 Wowwoowwowowwowwoowwowowwwowwwowww:

"vectors"

start ;00h
adc_isr ;02h
int2 ;04h
int3 ;06h
int4 ;08h
int5 ; 0Ah
inté ;0Ch
int?7 ; OEh
int8 ;10h
int9 ;12h
int10 ;14h
intl1l ;16h
intl2 ;18h
int13 ;1Ah
intl4 ;1Ch
intl5 ;1Eh
intlé ;20h
int1l7 ;22h
int18 ;24h
int19 ;26h
int20 ;28h
int21 ; 2Ah
int22 ;2Ch
int23 ; 2Eh
int24 ;30h
int25 ;32h
int26 ;34h
int27 ;36h

reset
INT1
INT2
INT3
INT4
INTS5
INT6
reserved

INT8 user-
INT9 user-

INT10 user
INT11l user
INT12 user
INT13 user
INT14 user
INT15 user
INT16 user
TRAP

NMI
reserved
INT20 user
INT21 user
INT22 user
INT23 user
INT24 user
INT25 user
INT26 user
INT27 user

defined
defined
defined
defined
defined
defined
defined
defined
defined

defined
defined
defined
defined
defined
defined
defined
defined
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int28: B int28 ;38h INT28 user defined
int29: B int29 ;3Ah INT29 user defined
int30: B int30 ;3Ch INT30 user defined
int31: B int31 ;3Eh INT31 user defined
; MAIN ROUTTINE

text
start

LDP #DP_PF1 ;set data page
SPLK #11101000b, WDCR
* bit 7 1: clear WD flag
* bit 6 1: disable the dog
* bit 5-3 101: must be written as 101
* bit 2-0 000: WDCLK divider =1

LDP #DP_PF1 ;set data page
SPLK #0000000011111101b, SCSR1
; NERNRRRRRRRRRNY
; FEDCBA9876543210
* bit 15 0: reserved
* bit 14 0: CLKOUT = CPUCLK
* bit 13-12 00: IDLEl selected for low-power mode
* bit 11-9 000: PLL x4 mode
* bit 8 0: reserved
* bit 7 1: 1 = enable ADC module clock
* bit 6 1: 1 = enable SCI module clock
* bit 5 1: 1 = enable SPI module clock
* bit 4 1: 1 = enable CAN module clock
* bit 3 1: 1 = enable EVB module clock
* bit 2 1: 1 = enable EVA module clock
* bit 1 0: reserved
* bit 0 1: clear the ILLADR bit
SPLK #0000000000001111b, SCSR2
; NERNRRRRRRRRRNY
; FEDCBA9876543210
* bit 15-6 0's: reserved
* bit 5 0: DO NOT clear the WD OVERRIDE bit
* bit 4 0: XMIF HI-Z, O=normal mode, 1=Hi-Z'd
* bit 3 1: 1 = disable the BOOT ROM
* bit 2 1: MP/MC*, 1 = Flash addresses mapped external
* bit 1-0 11: 11 = SARAM mapped to prog and data

;Set wait states for external memory interface on eZdsp (TM) LF2407
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LDP #temp ;set data page
SPLK #0000000001000000b, temp

; FEDCBA9876543210

* bit 15-11 0's: reserved

* bit 10-9 00: bus visibility off

* bit 8-6 001: 1 wait-state for I/0 space

* bit 5-3 000: 0 wait-state for data space

* bit 2-0 000: 0 wait-state for program space
ouT temp, WSGR

LAR AR1, #stk ;AR1 is stack pointer
MAR *, AR1 ;ARP = AR1

LDP #0h ;set data page
SPLK #111111b, IFR ;clear any pending interrupts
SPLK #000001b, IMR ;enable desired interrupts

LDP #DP_PF2 ;set data page
SPLK #0000000000000000b, MCRA
* NARRRRRARRRERNR
* FEDCBAS9876543210
* bit 15 0: 0=I0PB7, 1=TCLKINA
* bit 14 0: 0=I0PB6, 1=TDIRA
* bit 13 0: 0=I0PB5, 1=T2PWM/T2CMP
* bit 12 0: 0=I0PB4, 1=T1PWM/T1CMP
* bit 11 0: 0=I0PB3, 1=PWM6
* bit 10 0: 0=I0PB2, 1=PWM5
* bit 9 0: 0=I0PB1, 1=PWM4
* bit 8 0: 0=I0PBO, 1=PWM3
* bit 7 0: 0=I0PA7, 1=PWM2
* bit 6 0: 0=I0PAG, 1=PWM1
* bit 5 0: 0=I0PAS5, 1=CAP3
* bit 4 0: 0=I0PA4, 1=CAP2/QEP2
* bit 3 0: 0=I0PA3, 1=CAP1/QEP1
* bit 2 0: 0=I0PA2, 1=XINT1
* bit 1 0: 0=I0PA1, 1=SCIRXD
* bit 0 0: 0=I0PAO, 1=SCITXD
SPLK #1111111000000000b,MCRB
* NARRRRRARRRERNR
* FEDCBAS9876543210
* bit 15 1: O=reserved, 1=TMS2 (always write as 1)
* bit 14 1: O=reserved, 1=TMS (always write as 1)
* bit 13 1: O=reserved, 1=TD0 (always write as 1)
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* bit 12 1: O=reserved, 1=TDI (always write as 1)
* bit 11 1: O=reserved, 1=TCK (always write as 1)
* bit 10 1: O=reserved, 1=EMUl (always write as 1)
* bit 9 1: O=reserved, 1=EMUO (always write as 1)
* pbit 8 0: 0=I0PDO, 1=XINT2/ADCSOC
* bit 7 0: 0=I0PC7, 1=CANRX
* bit 6 0: 0=I0PCe6, 1=CANTX
* bit 5 0: 0=I0PCS5, 1=SPISTE
* bit 4 0: 0=I0PC4, 1=SPICLK
* pbit 3 0: 0=I0PC3, 1=SPISOMI
* bit 2 0: 0=I0PC2, 1=SPISIMO
* bit 1 0: 0=I0PC1, 1=BIO*
* bit 0 0: 0=I0OPCO, 1=W/R*
SPLK #0000000000000000b, MCRC
* RRRRRRRRRARRERR
* FEDCBAS876543210
* bit 15 0: reserved
* bit 14 0: 0=IO0OPF6, 1=I0PF6
* pbit 13 0: 0=I0OPF5, 1=TCLKINB
* pbit 12 0: 0=I0PF4, 1=TDIRB
* bit 11 0: 0=I0OPF3, 1=T4PWM/T4CMP
* bit 10 0: 0=I0PF2, 1=T3PWM/T3CMP
* pbit 9 0: 0=IO0PF1, 1=CAP6
* pbit 8 0: 0=IO0PFO, 1=CAP5/QEP4
* bit 7 0: 0=I0PE7, 1=CAP4/QEP3
* bit 6 0: 0=I0OPE6, 1=PWM12
* bit 5 0: 0=I0OPES5, 1=PWM11
* bit 4 0: 0=I0PE4, 1=PWM10
* pbit 3 0: 0=I0PE3, 1=PWMO
* pbit 2 0: 0=I0PE2, 1=PWM8
* bit 1 0: 0=I0OPE1, 1=PWM7
* bit 0 0: 0=I0OPEO, 1=CLKOUT
;Setup IOPA2 pin for use as output
LDP #DP_PF2 ;set data page
LACC PADATDIR ;ACC = PADATDIR
OR #0400h ; IOPA2 is output
SACL PADATDIR ;write back to GPIO port register

LDP #DP_PF2 ;set data page
SPLK #0100000000000000b, ADCTRL1
NERNRRRRRRRRRN
FEDCBA9876543210
* bit 14 1: 1 = reset ADC module
SPLK #0000000000000000b, MAX CONV
* NERNRRRRRRRRRN
* FEDCBA9876543210
* bit 15-7 0's: reserved
* bit 6-4 000: MAX CONV2 value
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* bit

bit
bit
bit
bit

I S

bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
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bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
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15
11
7-
3-

15
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13
11
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15
14
13
12
11

o)

O Wk U1 0y I

SPLK

-12
-8
4

0

SPLK

-12
-8

SPLK

-10

0000: MAX CONV1 value (0 means 1 conversion)

#0000000000000000b, CHSELSEQ1

FEDCBA9876543210

0000: CONVO03 channel

0000: CONVO02 channel

0000: CONVO01l channel

0000: CONV0OO channel (only active conversion)

#0010000000010000b, ADCTRL1

FEDCBA9876543210

0: reserved

0: RESET, O=no action, l=reset ADC

10: SOFT and FREE, 10=stop after current conversion
0000: ACQ Prescaler, 0000 = 1 x Tclk

0: CPS, 0: Fclk=CPUCLK/1l, 1: Fclk=CPUCLK/2

0: CONT_RUN, O=start/stop mode, l=continuous run
0: 0=hi priority int, 1l=low priority int

1l: 0=dual sequencer, l=cascaded sequencer

0: O=calibration mode disabled

0: BRG _ENA, used in calibration mode only

0: HI/LO, no effect in normal operation mode

0: O=self-test mode disabled

#0100011100000010b, ADCTRL2

NARRRRRARRRERNR

FEDCBA9876543210

: EVB_SOC_SEQ, 0O=no action
RST SEQ1/STRT CAL, O=no action
SOC_SEQ1, O=clear any pending SOCs
SEQ1 BSY, read-only
INT ENA SEQ1l, 0l=int on every SEQl conv
INT FLAG SEQl, write 1 to clear
EVA SOC_SEQ1l, 1=SEQl start from EVA
EXT SOC SEQ1, 1=SEQ1l start from ADCSOC pin
RST SEQ2, 0O=no action
SOC_SEQ2, no effect in cascaded mode
SEQ2 BSY, read-only
0: INT ENA SEQ2, 00=int disabled
INT FLAG _SEQ2, write 1 to clear
EVB SOC_SEQ2, 1=SEQ2 started by EVB

O e ee e

OPr o000 oOkrHrHOOORO

#adc buf ptr ;set data page

ARO, #adc_buf ;pointer to results buffer
ARO, adc_buf ptr ;initialize adc_ buf ptr

*, ARO ;ARP = ARO

#2407h ;ACC=0x2407

#temp

#adc_buf len-1, temp

temp jrepeat #adc_buf len-1 times
* 4 ;initialize the buffer
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LDP #DP_EVA ;set data page
SPLK #0000h, T2CNT ;clear timer2 counter
SPLK #adc_rate, T2PR ;jset timer2 period
SPLK #0000010000000000b, GPTCONA ;init GPTCON register
* RERRRRRERARNENE
* FEDCBA9876543210
* bit 15 0: reserved
* bit 14 0: T2STAT - read only
* bit 13 0: T1STAT - read only
* bit 12-11 00: reserved
* bit 10-9 10: T2TOADC, 10 = ADCSOC on period match
* bit 8-7 00: T1TOADC, 00 = no ADCSOC
* bit 6 0: 1 = enable all timer compare outputs
* bit 5-4 00: reserved
* bit 3-2 00: 00 = T2PIN forced low
* bit 1-0 00: 00 = T1PIN forced low
SPLK #0001000001000000b, T2CON ;init T2CON register
* RRRRRRRRRARNENE
* FEDCBA9876543210
* bit 15-14 00: stop immediately on emulator suspend
* bit 13 0: reserved
* pbit 12-11 10: 10 = continous-up count mode
* bit 10-8 000: 000 = x/1 prescaler
* bit 7 0: 0 = use own TENABLE bit
* bit 6 1: 1 = enable timer
* bit 5-4 00: 00 = CPUCLK is clock source
* bit 3-2 00: 00 = reload compare reg on underflow
* bit 1 0: 0 = disable timer compare
* bit 0 0: 0 = use own period register

LDP #DP_EVA ;set data page

SPLK #0FFFFh, EVAIFRA ;clear all EVA group A interrupts
SPLK #0FFFFh, EVAIFRB ;clear all EVA group B interrupts
SPLK #0FFFFh, EVAIFRC ;clear all EVA group C interrupts
SPLK #00000h, EVAIMRA ;enabled desired EVA group A intrpts
SPLK #00000h, EVAIMRB ;enabled desired EVA group B intrpts
SPLK #00000h, EVAIMRC ;enabled desired EVA group C intrpts
LDP #DP_EVB ;set data page

SPLK #0FFFFh, EVBIFRA ;clear all EVB group A interrupts
SPLK #0FFFFh, EVBIFRB ;clear all EVB group B interrupts
SPLK #0FFFFh, EVBIFRC ;clear all EVB group C interrupts
SPLK #00000h, EVBIMRA ;enabled desired EVB group A intrpts
SPLK #00000h, EVBIMRB ;enabled desired EVB group B intrpts
SPLK #00000h, EVBIMRC ;enabled desired EVB group C intrpts
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B loop ;branch to loop

Rk kS kb b Ok R R R Ik R i R kb O R I R Rk R Rk ik

* GENERAL INTERRUPT SERVICE ROUTINES *

Rk b Sk bk b O kR R R Ik R R S S R kb S R R kR R R R S S

;context save

MAR * ,AR1 ;ARP=stack pointer

MAR * 4 ;skip one stack location
SST #1, *+ ;save ST1

SST #0, *+ ;save STO

SACH * 4 ;save ACCH

SACL * 4 ;save ACCL

SAR AR2, *+ ;save AR2

;jclear the INT FLAG SEQl and read the ADC result

CLRC SXM

LDP #DP_PF2 ;set data page

LACC ADCTRL2 ;read and write ADCTRL2
SACL ADCTRL2 ;to clear the INT FLAG SEQ1
LACC RESULTO, 10 ;jread ADC RESULTO

;store the data value to the buffer

LDP #adc_buf ptr ;set data page

LAR AR2, adc_buf ptr ;AR2 points to the buffer
MAR *, AR2 ;set ARP

SACH *+ ;jstore result

SAR AR2, adc_buf ptr ;store updated pointer

;brute-force the circular buffer

LAR ARO, #(adc buf+adc_buf len-1) ;ARO points to last
;buffer entry

CMPR 2 ;TC set if AR(ARP) > ARO

BCND adc_isrl, NTC ;branch if TC not set

SPLK #adc _buf, adc_buf ptr ;jre-init the pointer

adc_isrl:

;reset ADC SEQ1 to CONVOO state
LDP #DP_PF2 ;set data page
LACC ADCTRL2 ;read ADCTRL2
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;toggle

OR #4000h
SACL ADCTRL2

the IOPA2 pin

LDP #DP_PF2
LACC PADATDIR
XOR #0004h
SACL PADATDIR

;context restore

MAR *, ARl
MAR * -

LAR AR2, *-
LACL * -

ADD *-,16
LST #0, *-
LST #1, *-
CLRC INTM
RET

;set bit 14 (RST SEQ1/STRT CAL bit)
;write back to reset SEQ1

;set data page

;ACC = PADATDIR

;toggle IOPA2 bit

;write back to GPIO port register

;ARP = AR1

;SP points to last entry

;restore AR2

;restore ACCL

;restore ACCH

;restore STO

;restore ST1l, de-allocate skipped
;stack location

;re-enable global interrupts
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Learning Objectives

L earning Objectives

Pulse Width M odulation (PWM) Review
Understand the GP Timers

Understand PWM with GP Compares
Understand PWM with Full Compare Units
Under stand Capture and QEP Functions
Lab: PWM Generation

L ZBR R JEE JNR JR 2

Note: Two identical Event Manager (EVA and EVB) modules
are available on some devices. For simplicity, only EVA
will be explained.
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Pulse Width Modulation (PWM)
PWM Signal Representation

t
Original Signal

/7 sameareas(energy)7
ORI L Ese

e e e e e s I e A A e e e e B
T T
PWM representation PAM representation

What Does a DSP Need to Generatea PWM ?

¢ Clocked counter

Comp

Timer Counter Value

¢ Compare Function

COUNTER
PERIOD
COMPARE

GP Timer
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Event Manager

Event Manager Block Diagram (EvA)

Reset TINTZ, 3,4
2
4—»{ EV Control Registers/ Logic[ > L%LCKIS’;‘Q{ TDIRA

GP Timer 1 Compare—*|Output L ogic| T1CMP/T1IPWM

GP Timer 1

—

Compare Unit 1 PWM Circuits| Output Logic [ PWM2
Compare Unit 2 PWM Circuits| Output Logic [ bivna
Compare Unit 3 PWM Circuits| Output Logic > BWMB

" GP Timer 2 Compare—#*Output Logic T2CMP/T2PWM
) GP Timer 2

CLK QEP

DIR Circuit

i CAP1/QEP1
CAP2/QEP2
CAP3

h 4

v

Data Bus

h 4

Capture Units

A
h 4

General-Purpose Timer

General-Purpose Timer Block Diagram (EVA)

Internal TXCMPR .15-0
External
TCLKS1-0 Shadowed
TXCON .5-4 Compare
Register
TXCNT .15-0 l GPTCONA
Clock 16 - Bit Timer Compare Output TXCMP /
Prescaler | *| Counter | | Logic f§ | Logic [ " TxPwm
TPS2-0 ]’
TXCON.10-8 -
x Period
Register
Shadowed
Note: x=1o0r 2 TXPR .15-0
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Timer Counting Modes

amwv/

VAVAN

’Stop/HoId ’Up Counting

’Up/Down Counting

|

CPU Changes
Period Reg. Buffer

anytimehere

Generated Outputsand Interrupts

PWM period #2

New Period is
Auto-loaded on
Under flow here

A LN

Timer Counter
Value

| PWM period 1 | //
! '
! !
1 1
! !
!
!

TXCMP/TXPWM
(active high)

TXCMPITXPWM : :
(active low) H | —

Comparelnts

Period Ints

Underflow Ints t
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GP Timer Control Register A (EVA)

GPTCONA @ 7400h

15 14 13 12-11 10-9 87
reserved | T2STAT | TISTAT | s | T2TOADC | TITOADC ‘
%\/—/
GP Timer Status (read-only) ADC start by event of GP Timer x
0 = counting down 00: no event starts ADC

1= counting up 01: setting of underflow interrupt flag
10: setting of period interrupt flag

11: setting of compare interrupt

6 5-4 3-2 1-0
T T

‘TCOMPOE | reserved T2PIN | T1PIN
! L

TxPWM/TxCMP Output Pin Conditioning

Compare Output Enable 00: forced low
0= all disabled (hi-impedanced) 9 adive Ir:gh
1=all engbled 11: forced high

Timer 1/2 Control Register (EVA)

T1CON @ 7404h /| T2CON @ 7408h

Upper Byte:
15 14 13 12 11 10 9 8
‘ FREE | SOFT | reserved ‘TMODE1|TMODEO| TPS2 | TPS1 | TPSO ‘

\ﬁ/—/
Emulation Halt Behavior Timer Clock Prescale

000: +1 100: + 16
001: +2 101: + 32
Count M ode Select 010: + 4 110: + 64
00= stop/hold 011: +8 111: + 128
01 = continuous-up/down
10 = continuous-up
11 = directional-up/down
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Timer 1/2 Control Register (EVA)

T1CON @ 7404h / T2CON @ 7408h

L ower Byte: Timer Compare Operation Enable
0 = disabled

Timer Clock Source 1= enabled

) ) 00 =internal (CPUCLK)
O=timer disabled (01 = external TMRCLK pin
1=timer enabled 10 = internal (CPUCLK) (bit reserved in TICON)

11 = QEP (Timer 2 only) ‘
/—/%

7 6 5 4 3 2 1 0
’ TSWT1 |TENABLE| TCLKSL | TCLKS)| TCLD1 | TCLDO |TECMPR|SELT1PR‘

Period Register Select

Timer Enable
0=useown per.reg.
1=useTimer 1per.reg

‘ ~

Start with Timer 1 Compare Register Reload Condition
0=useown TENABLE 00 = when counter equals zero (under flow)
1=useTimer 1 TENABLE 01 = when counter equalszero or period reg
(bit reserved in TICON) 10 = immediately
11 = reserved

Compare Unit

Compare Units Block Diagram (EvA)

ACTRA .11-0

Shadowed

TICNT.15-0

Compare
GP Timer 1 Action Control
Counter Register
i DBTCONA .11-2 l
Compare .| Dead Band Output
Logic Units | °] Logic [ ~PWMy.y+1
T COMCONA .9
FCOMPOE
Compare
Register
Shadowed
Note: x=1,2,3,y=1,35
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Compare Control Register (EVA)
COMCONA @ 7411h

Compare Enable

Space Vector PWM

Full Compare Output

0=disable 0 =SV disabled 0 =disable (hi-Z'd)
1=enable 1=SV enabled 1=enable
15 14 13 12 11 10 9 8-0

‘CENABLE| CLD1 | CLDO |SVENABLE|ACTRLD1|ACTRLDO|FCOMPOE| reserved

—

CMPRXx reload condition

00 =when TICNT =0
01=when TICNT =0or TIPR
10 = immediately

11 =reserved

e

ACTRA reload condition

00=when TICNT =0

01 =when TICNT =0or TIPR
10 = immediately

11 =reserved

Compare Action Control Register (EvA)
ACTRA @ 7413h

Basic Space Vector Bits
can writeas0when SC not in use

15 14 13 12 11 10 9 8
‘ SVRDIR D2 | D1 | DO CMPBACT1| CMP6ACTO| CM P5Acn| CMP5ACTO
7 6 5 4 3 2 1 0
CMP4ACT1|CMP4ACTO| CM P3ACT1.| CMP3ACTO| CMP2ACT1| CMP2ACTO!

CcM F'J.ACT[.| CMPI1ACTO

Pin Action on Compare: CMPyACT1-0

SV Rotation Direction
can writeas 0 when SV not in use

00 forcelow
01 active low
10 active high
11 forced high
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Dead-Band

M otivation for Dead-Band

supply rail

Gate Signalsare H L
Complimentary PWM to motor phase

S
T

¢ Transistor gatesturn on faster than they shut off
+ Short circuit if both gatesare on at sametimel!

Dead-Band Functionality (EVA)

Clok _— | — | — CPUCLK#

PHx

— PH, | edge
— TENA L 4hit

DT — Counter
L

P et
oren, | |
L o1

DTPH, ;
_ : ; 4-bit period
I

dead time DTPH,
Asymmetric PWM Example TP,

l
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Dead-Band Timer Control Register (EVA)

DBTCONA @ 7415h

dead time= DB period * DB prescaler * CPUCLK period

DB Timer Period

15 14 13 12 11 10 9 8
reserved | reserved | reserved| reserved | DBT3 ‘ DBT2 ‘ DBT1 ‘ DBTO ‘
7 6 5 4 3 2 1 0
’ EDBT3 ‘ EDBT2 ‘ EDBTl‘ DBTPSZ‘ DBTPSI‘ DBTPS0| reserved | reserved

DB Timer Enable DB Timer Prescaler
0= disable 000=1 100=16
1= enable 01=2 101=32

010=4 110=32
011=8 111-32

Capture Unit

Some Usesfor the Capture Units

+ Synchronized ADC start with capture event
+ Measurethetimewidth of a pulse
+ Low speed velocity estimation from incr. encoder:

Problem: At low speeds, calculation of X~ %,
speed based on a measur ed position Vi zT"l
changeat fixed time intervals produces

large estimate errors
Alternative: Estimate the speed using a measured time
interval at fixed position intervals

Signal from one ‘
Vy = __ A quadrature

b~ by encoder channel }‘7 Ax %
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Capture Units Block Diagram (EvA)

(TacNT . 15-0)  (T2cNT.15-0)

. . Can latch on:
GP Timer 1 GP Timer 2 . .
Counter Counter * rising edge
’_1 « falling edge
| « both
CAPCONA . 10- 9 MUX CAP3TOADC
Enable  (cApcONA.8
ADC Start
Edge [ (CAP3)
Detect
l_iﬁ —-— cAP123 -—|-—|
2-Level Deep RS Edge Select L
FIFO CAPCONA .7-2 TTL Signal
CAPXFIFO Status CAPRESET min. valid width:
(capcona . 15] 2 CPUCLK lo
2 CPUCLK hi

Capture Unit FIFO Operation

& CPU can read both upper and lower FIFO registers
separately; Standard approach isto read upper, but lower

can beread
value #2
value #1 read by
LOST! CPU
+ 4
unknown value#1 value#1 / vallje#Z / vallje#3
unknown unknownl value #2 value #3 unknownl
Capture 1st 2nd 3rd CPU
Unit Capture  Capture Capture read
Reset
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Capture Control Register (EVA)

CAPCONA @ 7420h
Capture Reset (not latched)

0=clear all result FIFO’'sand Uit 3 Control ADC Start
. 0=disabled 0=noaction
CAPFIFO register
1=noaction 1:el‘1abled 1=CAP3I‘NT flag
\
15 14-13 12 11 10 9 8
T
‘ CAPRES | CAPQEPN | CAP3EN | reserved | CAP3TSEL |CAP12TSEL|CAP3TOADC‘
.
~—
Unit 1 & 2 Control )
00 = disabled Timer Select
01 = enable for capture 0=GP Timer 2
10 = reserved 1=GPTimer 1
11 = enablefor QEP
7-6 54 3-2 1-0
1 1 T T

CAPIEDGE CAP2EDGE CAPSEDGE reserved
1 1 1

Edge Detection Control

00 = no detection 10 = falling edge
01 =rising edge 11 = both edges

Capture FIFO Status Register (EvA)

CAPFIFOA @ 7422h

15-14 13;12 11;10 9;8 7-0
reserved| CAP3FIFO | CAP2FIFO CAPIFIFO |rmved‘
1 1 1

FIFOx Status:

CAPXFIFO bitsare
automatically adjusted on a
captureor FIFO read

00 = empty

01 =oneentry

10 = two entries

11 =three entries attempted,
1st entry lost
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Quadrature Encoder Pulse (QEP)

What isan Incremental Quadrature
Encoder?

A digital (angular) position sensor

photo sensors spaced 6/4 deg. apart
T slots spaced 0 deg. apart 0/4

I light source (LED)

6

cha [ L[ LI
ch.B i

U=

shaft rotation

Incremental Optical Encoder Quadrature Output from Photo Sensors

Incremental Encoder Connections (EVA)

Ch.A
QEP CAP1/QEP1 Ch.B

decoder CAP2/QEP2
logic
CLK DIR
¢ GP Timer 2 selected as
pulse counter
¢ Timer Prescaler bypassed
l l (i.e. Prescale always 1)
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Module 5 Lab: Event Manager and PWM

Event Manager and PWM

Event Manager

Module 5 L ab:

Compare 1l

\ GPTimerl
i used to

| Generate
! PWM

! output

GPTimer 1

PWM Circuits connlector ADC resitto  Memary
Output Logic WIS RESULTO buffer during
[y

CPU copies data

ADC ISR

ADCO

? GP Timer 2triggers
1 ADC SOC every

i 20ps(50kH2) —

@ @ View ADC
buffer PWM
Samples

GP Timer 2 Code Composer I

pointer rewind

A —

Introduction

The objective of thislab isto familiarize the student with the programming and operation of the
Event Manager on the TM S320L F2407 DSP. General-Purpose Timer 1 and Compare 1 will be
setup to generate a 2kHz, 25% duty cycle symmetric PWM waveform. The waveform will then
be sampled with the on-chip analog-to-digital converter and displayed using the graphing feature

of Code Composer.

Recall that there are two timebases associated with Event Manager “EVA”. The timer and its
associated control registerswill be configured to produce a PWM waveform on the eZdsp™

LF2407:

General Purpose Timer #1 — PWM Generation

e Used astimebase for Comparel generation of PWM waveform

Genera Purpose Timer #2 — ADC Conversion Trigger & PWM Generation

e Used astimebase for triggering ADC samples (same as previous lab)

The software for this lab configures the Event Manager and the ADC. It isentirely interrupt
driven. A flow chart of the codeis shownin Figure5.1.
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Start

v

CPU Initialization

watchdog disable
SCSR1 & 2 register
wait-state generator
software stack

core interrupts
shared pins

GPIO setup

v

ADC Initialization
e convert channel 0 on

Timer 1 Initialization

Timer 2 Initialization

clear counter
set period register

e clear counter
Timer2 period match e et period register set to trigger ADC on
e send interrupt on e setup Full Compares period match
every conversion e settheclock prescaler set the clock prescaler
e  setup aresults buffer e enablethetimer enable the timer
in memory
Main L oop ADC ISR
: e  context save
loop: ADC interrupt | | read the ADC result
e writeto results buffer
« e adjust the buffer pointer
return e togglethe GPIO pin
B loop e  context restore
e re-enableinterrupts
e return

Figure5.1: Code Flow
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> Procedure

Create a New Project

1

Double-click on the Code Composer icon on the desktop. Maximize Code Composer to fill
your screen.

Create anew project for thislab. On the menu bar click:
Project > New

and make surethe “SAVE IN” locationis: C: \DSP24 1DAY\LABS and type MOD5SLAB in
the file name window. Thiswill create a make file which will invoke all the necessary tools
to build your project.

Add the assembly file to the new project. Click:
Project = Add Files to Project

and make sure you'relooking in C: \DSP24 1DAY\LABS. Change the“files of type” to
view assembly files (. AsM) and select MODSLAB . ASM and click OPEN. Thiswill add the
fileMODSLAB . ASM to your newly created project.

Add MODSLAB . CMD to the project using the same procedure.

In the project window on the left click the plus sign (+) to the left of Project . Now, click
on the plus sign next to MOD5LAB . MAK. Notice that the MOD51.AB . CMD fileislisted. Click
on the plus sign next to Source to see the current sourcefilelist (i.e. MODSLAB . ASM).

Setup the Linker

6.

Setup the linker options by clicking:
Project —> Options

on the menu bar. Select the Linker tab. In the middle of the screen select “No
Autoinitialization”. (If needed, amap file can be created by using the Map
Filename [-m] field). Next, select the Assembler tab. Inthe middle of the screen check
“Enable Source Level Debugging”. (Allows debugging using “mixed mode”).
Then select OK to save the Build Options.

Build and Load

7.

8.

Click the "Rebuild A11” button and watch the tools run in the build window. To open
up more space, close any open files or windows that you do not need.

If the “Load program after build” option was not selected in Code Composer
(*option” menu, click on “Program Load..”) load the output file into the target.
Click: File = Load Program.

Make sureyou arelookingin C:\DSP24 1DAY\Labs. Select MOD5SLAB.OUT and click
OPEN.

Then reset the DSP by clicking on: Debug = Reset DSP
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9. If code generation is successful, the Dis-Assembly window will display the sourcefile
(MOD5LAB . ASM) and ayellow highlight on “B start” should appear. This indicates that you
are now ready to run.

Running MOD5LAB

10. Inspect MOD5SLAB . ASM in the source window. Note how the topics covered in the module
are used in the program code.

11. Single-step your code afew timesinto the MOD5SLAB.ASM file.

12. Open amemory window to view some of the contents of the ADC results buffer. The
address label for the ADC results buffer isadc_buf.

13. Using the connector wire provided, connect the PWM1 (pin # P2-9) to ADCINO (pin # P1-2)
on theezdsp™. Exercise care when doing this asthe power to the eZdsp™is on, and we do
not want to damage the eZdsp™ Then run the code, and halt it after afew seconds. Verify
that the ADC results buffer contains updated values.

14. Open and setup a graph to plot a 50-point window of the ADC results buffer.
Click: view = Graph = Time/Frequency.. and setthefollowing values:

Start Address adc_buf

Acquisition Buffer Size 50

Display Data Size 50

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Time Display Unit us

Select OK to save the graph options.

15. Thegraphical display should show the generated 2kHz, 25% duty cycle symmetric PWM
waveform. The period of a 2kHz signal is500us. Y ou can confirm this by measuring the
period of the waveform using the graph (you may want to enlarge the graph window using
the mouse). The measurement is best done with the mouse. The lower left-hand corner of
the graph window will display the X and Y-axis values. Subtract the X-axis values taken
over a complete waveform period (you can use the PC calculator program found in Microsoft
Windows to do this).

Frequency Domain Graphing Feature of Code Composer

16. Code Composer aso has the ability to make frequency domain plots. It doesthis by using
the PC to perform a Fast Fourier Transform (FFT) of the DSP data. Let's make a frequency
domain plot of the contents in the ADC results buffer (i.e. the PWM waveform).

DSP24 1-Day Workshop - PWM Generation & Event Manager 5-17



Module 5 Lab: Event Manager and PWM

Click: Vview = Graph = Time/Frequency.. and set the following values:

Display Type FFT Magnitude

Start Address adc_buf

Acquisition Buffer Size 256

FFT Framesize 256
DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Select OK to save the graph options.

17. Onthe plot window, left-click the mouse to move the vertical marker line and observe the
frequencies of the different magnitude peaks. Do the peaks occur at the expected
frequencies?

Optional

18. You might want to experiment with this code by changing some of the values or modifying
the code. Try generating another waveform of a different frequency and duty cycle. Also,
try to generate complementary pair PWM outputs. Next, try to generate additional
simultaneous waveforms by using Compare 1, Compare 2 and Compare 3. (Hint: don’t
forget to setup the proper shared 1/0 pins, etc.).
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MODS5LAB.ASM

; MODS5LAB.ASM

adc_rate

adc_buf len
stk_len

pwm_half per
ric PWM
pwm_duty

;50kHz sampling rate

;ADC results buffer length
;stack length

;period/2 for 2kHz symmet-

;25% duty cycle

adc_buf ptr
adc_buf
stk

.usect
.usect
.usect

"buffer",1
"buffer",adc_buf len
"stack",stk len

;general purpose variable

;ptr to next free buff addr
;reserve space for buffer
;reserve space for stack

intl:
int2:
int3:
int4:
inths:
inté:
int7:
int8:
int9:
intl0:
intll:
intl2:
intl13:
intl4:
intls5:
intlé6:
intl7:
intl18:
intl19:
int20:
int21:
int22:

W Wowwowowwwowwowowwowowwwowwwow:

"vectors"

start ;00h
adc_isr ;02h
int2 ;04h
int3 ;06h
int4 ;08h
int5 ; 0Ah
inté ;0Ch
int7 ; OEh
int8 ;10h
int9 ;12h
int10 ;14h
intl1l ;16h
intl2 ;18h
int13 ;1Ah
intl4 ;1Ch
intl5 ;1Eh
intlé ;20h
int17 ;22h
int18 ;24h
int19 ;26h
int20 ;28h
int21 ; 2Ah
int22 ;2Ch

reset

INT1

INT2

INT3

INT4

INTS5

INT6

reserved

INT8 user-defined
INT9 user-defined
INT10 user defined
INT11l user defined
INT12 user defined
INT13 user defined
INT14 user defined
INT15 user defined
INT16 user defined
TRAP

NMI

reserved

INT20 user defined
INT21 user defined
INT22 user defined
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int23: B int23 ;2Eh INT23 user defined
int24: B int24 ;30h INT24 user defined
int25: B int25 ;32h INT25 user defined
int26: B int26 ;34h INT26 user defined
int27: B int27 ;36h INT27 user defined
int28: B int28 ;38h INT28 user defined
int29: B int29 ;3Ah INT29 user defined
int30: B int30 ;3Ch INT30 user defined
int31: B int31 ;3Eh INT31 user defined
; MAIN ROUTTINE
text
start

LDP #DP_PF1 ;set data page
SPLK #11101000b, WDCR
* bit 7 1: clear WD flag
* bit 6 1: disable the dog
* bit 5-3 101: must be written as 101
* bit 2-0 000: WDCLK divider = 1

LDP #DP_PF1 ;set data page
SPLK #0000000011111101b, SCSR1
; NERNRRRRRRRRRNY
; FEDCBA9876543210
* bit 15 0: reserved
* bit 14 0: CLKOUT = CPUCLK
* bit 13-12 00: IDLEl selected for low-power mode
* bit 11-9 000: PLL x4 mode
* bit 8 0: reserved
* bit 7 1: 1 = enable ADC module clock
* bit 6 1: 1 = enable SCI module clock
* bit 5 1: 1 = enable SPI module clock
* bit 4 1: 1 = enable CAN module clock
* bit 3 1: 1 = enable EVB module clock
* bit 2 1: 1 = enable EVA module clock
* bit 1 0: reserved
* bit 0 1: clear the ILLADR bit
SPLK #0000000000001111b, SCSR2
; NERNRRRRRRRRRNY
; FEDCBA9876543210
* bit 15-6 0's: reserved
* bit 5 0: DO NOT clear the WD OVERRIDE bit
* bit 4 0: XMIF HI-Z, O=normal mode, 1=Hi-Z'd
* bit 3 1: 1 = disable the BOOT ROM
* bit 2 1: MP/MC*, 1 = Flash addresses mapped external
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;Set wait states for external memory interface on eZdsp (TM) LF2407

bit
bit
bit
bit
bit

* Kk ok K ok~

#temp ;set data page

#0000000001000000b, temp

FEDCBA9876543210

0's: reserved

00: bus visibility off

001: 1 wait-state for I/0 space
000: 0 wait-state for data space
000: 0 wait-state for program space
temp, WSGR

AR1, #stk ;AR1 is stack pointer

*, AR1 ;ARP = AR1

LDP
SPLK
SPLK

#0h ;set data page
#111111b, IFR ;clear any pending interrupts
#000001b, IMR ;enable desired interrupts

bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit

LR S R I R D R R I R R N

O R RRPRER
O N WKL

O R N WK UTO J

#DP_PF2 ;set data page

#0000000001000000b, MCRA

FEDCBAS9876543210

0: 0=I0PB7, 1=TCLKINA

0: 0=I0PB6, 1=TDIRA

0: 0=I0OPB5, 1=T2PWM/T2CMP
0: 0=I0OPB4, 1=T1PWM/T1CMP
0: 0=I0PB3, 1=PWM6

0: 0=I0PB2, 1=PWM5

0: 0=I0PB1, 1=PWM4

0: 0=IOPBO, 1=PWM3

0: 0=I0OPA7, 1=PWM2

1: 0=I0PAG6, 1=PWM1

0: 0=I0PA5, 1=CAP3

0: 0=I0PA4, 1=CAP2/QEP2
0: 0=TIOPA3, 1=CAP1/QEP1
0: 0=I0OPAZ2, 1=XINT1

0: 0=I0PAL, 1=SCIRXD

0: 0=I0PAO, 1=SCITXD
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SPLK #1111111000000000b, MCRB
* NARRRRRARRRERNR
* FEDCBA9876543210
* bit 15 1: O=reserved, 1=TMS2 (always write as 1)
* bit 14 1: O=reserved, 1=TMS (always write as 1)
* bit 13 1: O=reserved, 1=TD0 (always write as 1)
* bit 12 1: O=reserved, 1=TDI (always write as 1)
* bit 11 1: O=reserved, 1=TCK (always write as 1)
* bit 10 1: O=reserved, 1=EMUl (always write as 1)
* bit 9 1: O=reserved, 1=EMUO (always write as 1)
* bit 8 0: 0=I0PDO, 1=XINT2/ADCSOC
* bit 7 0: 0=I0PC7, 1=CANRX
* bit 6 0: 0=I0PC6, 1=CANTX
* bit 5 0: 0=I0PC5, 1=SPISTE
* bit 4 0: 0=I0PC4, 1=SPICLK
* bit 3 0: 0=I0PC3, 1=SPISOMI
* bit 2 0: 0=I0PC2, 1=SPISIMO
* bit 1 0: 0=I0PC1, 1=BIO*
* bit O 0: 0=I0PCO, 1=W/R*
SPLK #0000000000000000b, MCRC
* NARRRRRARRRERNR
* FEDCBA9876543210
* bit 15 0: reserved
* bit 14 0: 0=I0PFe6, 1=I0PFe6
* bit 13 0: 0=I0PF5, 1=TCLKINB
* bit 12 0: 0=I0PF4, 1=TDIRB
* bit 11 0: 0=I0PF3, 1=T4PWM/T4CMP
* bit 10 0: 0=I0PF2, 1=T3PWM/T3CMP
* bit 9 0: 0=I0PF1, 1=CAP6
* bit 8 0: 0=I0PFO, 1=CAP5/QEP4
* bit 7 0: 0=I0PE7, 1=CAP4/QEP3
* bit 6 0: 0=I0PE6, 1=PWM12
* bit 5 0: 0=I0PES5, 1=PWM11l
* bit 4 0: 0=I0PE4, 1=PWM10
* bit 3 0: 0=I0PE3, 1=PWM9
* bit 2 0: 0=I0PE2, 1=PWM8
* bit 1 0: 0=I0PE1l, 1=PWM7
* bit O 0: 0=I0OPEO, 1=CLKOUT
;Setup IOPA2 pin for use as output
LDP #DP_PF2 ;set data page
LACC PADATDIR ;ACC = PADATDIR
OR #0400h ; IOPA2 is output
SACL PADATDIR ;write back to GPIO port register

LDP #DP_PF2 ;set data page
SPLK #0100000000000000b, ADCTRL1

* ERRRRRRRRARRENR

* FEDCBAS9876543210

* bit 14 1l: 1 = reset ADC module
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bit
bit
bit

* %* X X X

bit
bit
bit
bit

L I S

bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit

L S . I R S S I N

bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit
bit

L R R T T R R I

15
11
’7_
3-

15
14
13
11

O RN WP UTO

15
14
13
12
11

o)

O Wk U100y J

SPLK

-12
-8
4

0

SPLK

-12
-8

SPLK

-10

#0000000000000000b, MAX CONV

FEDCBAS876543210

O0's: reserved

000: MAX CONV2 value

0000: MAX CONV1 value (0 means 1 conversion)

#0000000000000000b, CHSELSEQ1

FEDCBA9876543210

0000: CONVO03 channel

0000: CONVO02 channel

0000: CONVO01l channel

0000: CONV0OO channel (only active conversion)

#0010000000010000b, ADCTRL1

FEDCBAS9876543210

0: reserved

0: RESET, O=no action, l=reset ADC

10: SOFT and FREE, 10=stop after current conversion
0000: ACQ Prescaler, 0000 = 1 x Tclk

0: CPS, 0: Fclk=CPUCLK/1, 1: Fclk=CPUCLK/2

0: CONT_RUN, O=start/stop mode, l=continuous run
0: 0=hi priority int, 1l=low priority int

1l: 0=dual sequencer, l=cascaded sequencer

0: O=calibration mode disabled

0: BRG_ENA, used in calibration mode only

0: HI/LO, no effect in normal operation mode

0: O=self-test mode disabled

#0100011100000010b, ADCTRL2

NERNRRRRRRRRRNY

FEDCBA9876543210

: EVB_SOC_SEQ, 0O=no action
RST_SEQl/STRT_CAL, 0=no action
SOC_SEQ1l, O=clear any pending SOCs
SEQ1 BSY, read-only
INT ENA SEQ1l, 0l=int on every SEQl conv
INT FLAG SEQl, write 1 to clear
EVA SOC _SEQ1, 1=SEQ1l start from EVA
EXT SOC SEQ1, 1=SEQ1l start from ADCSOC pin
RST SEQ2, 0=no action
SOC_SEQ2, no effect in cascaded mode
SEQ2 BSY, read-only
0: INT ENA SEQ2, 00=int disabled
INT FLAG SEQ2, write 1 to clear
EVB_SOC_SEQ2, 1=SEQ2 started by EVB

o .

OPrPr o000 O0OHFHHKFEHOOOHRrO

#adc_buf ptr ;set data page

ARO, #adc_buf ;pointer to results buffer
ARO, adc_buf ptr ;initialize adc buf ptr

*, ARO ;ARP = ARO
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LACC
LDP
SPLK
RPT
SACL

#2407h
#temp

;ACC=0x2407

#adc buf len-1, temp

temp

*+

jrepeat f#adc_buf len-1 times
;initialize the buffer

SPLK
SPLK

SPLK

bit 15
bit 14
bit 13
bit 12-11
bit 10-9
bit 8-7
bit 6
bit 5-
bit 3
bit 1

* %k % Ok X F F 3k X X X X

bit 15-14
bit 13
bit 12-11
bit 10-8
bit 7
bit 6
bit 5-4
bit 3-2
bit 1
bit 0

L I R T I T D I

#DP_EVA ;set data page
#0000h, T2CNT ;clear timer2 counter
#adc_rate, T2PR ;set timer2 period

#0000010000000000b, GPTCONA ;init GPTCON register

FEDCBA9876543210

0:
0:

reserved
T2STAT - read only

0: T1STAT - read only
00: reserved
10: T2TOADC, 10 = ADCSOC on period match
00: T1TOADC, 00 = no ADCSOC
0: 1 = enable all timer compare outputs
00: reserved
00: 00 = T2PIN forced low
00: 00 = T1PIN forced low
#0001000001000000b, T2CON ;init T2CON register
RRRRRARERARNENE
FEDCBA9876543210
00: stop immediately on emulator suspend
0: reserved
10: 10 = continous-up count mode
000: 000 = x/1 prescaler
0: 0 = use own TENABLE bit
1: 1 = enable timer
00: 00 = CPUCLK is clock source
00: 00 = reload compare reg on underflow
0: 0 = disable timer compare
0: 0 = use own period register

*
*

* bit 15

#DP_EVA ;set data page
#0000h, T1CON ;disable timer 1
#0000h, T1CNT ;clear timer 1 counter

#pwm _half per, T1PR ;setup timer 1 period

#0000h, DBTCONA ;deadband units off
#pwm_duty, CMPR1 ;set PWM1 duty cycle

#0000000000000010b, ACTRA ;PWM1l set for active high

FEDCBAS9876543210

0:

space vector dir is CCW (don't care)
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bit
bit
bit
bit
bit
bit
bit

* % X X X F F

bit
bit
bit
bit
bit
bit

* Ok X X X X X F

bit
bit
bit
bit
bit
bit
bit
bit
bit
bit

L R T I I S

15
14-13
12
11-10
8-0

SPLK

15-14

000: basic space vector is 000 (dont' care)
00: PWM6/IOPB3 pin forced low
00: PWM5/IOPB2 pin forced low
00: PWM4 /IOPB1l pin forced low
00: PWM3/IOPB0 pin forced low
00: PWM2/IOPA7 pin forced low
10: PWM1/IOPA6 pin active high

#1000001000000000b, COMCONA ;configure COMCON

FEDCBA9876543210
1l: 1 = enable full compare operation
00: 00 = reload CMPRx regs on timer 1 underflow
0: 0 = space vector disabled
00: 00 = reload ACTR on timer 1 underflow
1: 1 = enable PWM pins
0's: reserved
#0000100001000000b, T1CON ;init T1CON register
RERRRRRNRARNENE

FEDCBA9876543210
00: stop immediately on emulator suspend
0: reserved
01: 01 = continous-up/down count mode
000: 000 = x/1 prescaler
0: 0 = use own TENABLE bit
1: 1 = enable timer
00: 00 = CPUCLK is clock source
00: 00 = reload compare reg on underflow
0 0 = disable timer compare
0: 0 = use own period register

#DP_EVA ;set data page

#0FFFFh, EVAIFRA ;clear all EVA group A interrupts
#0FFFFh, EVAIFRB ;clear all EVA group B interrupts
#0FFFFh, EVAIFRC ;clear all EVA group C interrupts
#00000h, EVAIMRA ;enabled desired EVA group A intrpts
#00000h, EVAIMRB ;enabled desired EVA group B intrpts
#00000h, EVAIMRC ;enabled desired EVA group C intrpts

#DP_EVB ;set data page

#0FFFFh, EVBIFRA ;clear all EVB group A interrupts
#0FFFFh, EVBIFRB ;clear all EVB group B interrupts
#0FFFFh, EVBIFRC ;clear all EVB group C interrupts
#00000h, EVBIMRA ;enabled desired EVB group A intrpts
#00000h, EVBIMRB ;enabled desired EVB group B intrpts
#00000h, EVBIMRC ;enabled desired EVB group C intrpts

CLRC

INTM ;enable global interrupts
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B loop ;branch to loop

Rk b Sk bk b O kR R R S R S R R kR I Rk Ik Rk Ik Rk ki kb O

* GENERAL INTERRUPT SERVICE ROUTINES *

Rk b Sk bk b Ok R R R Rk Rk S Rk kb b R R R R Ik R I R i S S S ko

;context save

MAR *,AR1 ;ARP=stack pointer

MAR * 4 ;skip one stack location
SST #1, *+ ;save ST1

SST #0, *+ ;save STO

SACH * 4 ;save ACCH

SACL * 4 ;save ACCL

SAR AR2, *+ ;save AR2

jclear the INT FLAG SEQl and read the ADC result

CLRC SXM

LDP #DP_PF2 ;set data page

LACC ADCTRL2 ;read and write ADCTRL2
SACL ADCTRL2 ;to clear the INT FLAG SEQ1
LACC RESULTO, 10 ;read ADC RESULTO

;store the data value to the buffer

LDP #adc_buf ptr ;set data page

LAR AR2, adc_buf ptr ;AR2 points to the buffer
MAR *, AR2 ;set ARP

SACH *+ ;jstore result

SAR AR2, adc_buf ptr ;store updated pointer

;brute-force the circular buffer

LAR ARO, #(adc buf+adc _buf len-1) ;ARO points to last
buffer entry

CMPR 2 ;TC set if AR(ARP) > ARO

BCND adc_isrl, NTC ;branch if TC not set

SPLK #adc_buf, adc_buf ptr ;jre-init the pointer

adc_isrl:

;reset ADC SEQ1 to CONVOO state

LDP #DP_PF2 ;set data page

LACC ADCTRL2 ;read ADCTRL2

OR #4000h ;set bit 14 (RST_SEQl/STRT_CAL bit)
SACL ADCTRL2 ;write back to reset SEQ1

;toggle the IOPA2 pin
LDP #DP_PF2 ;set data page
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LACC

XOR

SACL

;context restore

MAR
MAR
LAR
LACL
ADD
LST
LST

CLRC
RET

PADATDIR
#0004h
PADATDIR

*, ARl

* -

AR2, *-
* -
*-,16
#0, *-
#l, * -

INTM

;ACC = PADATDIR
;toggle IOPA2 bit
;write back to GPIO port register

;ARP = AR1

;SP points to last entry

;restore AR2

;restore ACCL

;restore ACCH

;restore STO

;restore ST1l, de-allocate skipped
;stack location

;re-enable global interrupts
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This pageisintentionaly blank.

DSP24 1-Day Workshop - PWM Generation & Event Manager



Filtering Techniques

Learning Objectives

L earning Objectives

4

Review the basic concepts of filters

What aredigital filtersand how arethey
designed?

How to implement filterson a C240x DSP

TI'sDigital Filter Software Library
package

¢ FilteringLab - Using TI'sDigital Filter
Software Library Package

4

L R 2
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Module Topics
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Filtering

Filtering

Filtering & DSP

¢ What isFiltering

+ The selective attenuation of certain
frequency components of a signal

+ |solate desired portionsof a signal

« Removeinterfering signals
¢ Why usedigital filtering?
Programmability - adaptivefilters
Stability
Repeatability

Realization of systems not possible or
feasible with analog techniques

*

*

*

*

Analog Filter Examples

J % e H.—}. :
ighpass Filter

R Ax Vot

o—e—>o

Typical Filter 1 Y e vana e

Performance ** *

Dwgn ) stop band ripple
Parameters :‘/
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Digital Filters

¢ Themathematical theory of digital filtersisbased on
the Z-transform

¢ Inpractice, digital filtersarerealized by multiplying
the incoming data by a set of coefficient valuesand
summing theresultsto produce thefiltered output
signal (Basically, a Sum-of-Products...)

& Thenumber of coefficientsisdirectly related to the
filter performance ( Each coefficient-data multiplier
junctionisreferredtoasa“TAP"); more“TAPS’
generally means better performance

¢ Filter coefficients are normally generated
mathematically with special filter design software
(ie: Matlab, or other Filter Generation Package...)

Coefficients Deter mine the Filter Response

Digital Filtersare designed by using Softwar e Packages (ie:
Matlab, or other Filter Generation Packages...) to
mathematically gener ate coefficient tablesto match the
desired filter type (LowPass, Bandpass...) and performance
specifications (Rolloff, Ripple, Passband...) .

Basic Filter Types:

il L owpass - passes ever ything below a designated frequency
f

i Highpass - passes everything above a designated frequency
f

Bandpass - passes everything between two designated
/ N\ . frequencies

t i Bandstop - rgj ects ever ything between two designated
; frequencies.
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Digital Filter Types
¢ Finite Impulse Response (FIR)

+ Theimpulseresponse of an FIR filter decaystozeroin a
finite amount of time

« FIR filtersexhibit linear phase response
+ Highly desirablein signal processing
+ Difficult to achieve with analog techniques

+ FIR filtersarefeedforward filters

¢ Infinite Impulse Response (11 R)

« Theimpulseresponse of an I IR filter theoretically never
decaysto zero

« |IR filtersdo naot exhibit linear phaseresponse
+ IR filtersarefeedback filters
« lIR filtershave steeper roll-off/tap than FIR Filters

FIR Filter Implementation

¢ Aswe have seen, DSPs have specialized
instructionsfor the implementation of FIR
filters

+« MAC - Multiply and accumulate
+« MACD - Multiply and accumulate and move data

+ DSPshave multiple memory buses to access
data and coefficient values in the same clock
cycle

¢ DSPsexecuteFIR filtersat a 1-tap per clock

cyclerate by using a“ Repeat” instruction in
combination with a“MACD” instruction
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Nth-order FIR on C240x
Aswe have seen, the MACD instruction can be used
very efficiently toimplement FIR filters....
y(k) = box(k) + b;x(k-1) + box(k-2) + ... + b,x(k-n)

LAR AR, #X0 Al Y
LAR  ARO, #n .
MAR  * ARL Xo ) coeff: | By,
X1 B
FIR: IN *+0, ADC N+8 )

|- cycle . .
LACL #0 ] Gre . .
MPY  #0 " B
RPT #n-1 n-1 2
MACD coeff, *- X ) B
APAC n =
SACH * extra) By | ¥
OUT  *+ DAC Data Program
B FIR memory memory

Tl Modular Software Library

TI'sModular Software Library Concept

¢ TI Provides Modular Software Building blocks
for many DSP functions/systems

¢ Plug-and Play Modules are Available
Individually or as System Solutions

Motor Control Digital Filter Other
Library Library Libraries
SN || PID ] pum || FIR ]
GEN || control ||SVPWM |- FIRIO || pac || ceEN [* DDE%
c VIHZ IR
R o | | PROF. | FIR20 |[FIR10C|| 16 | Dﬁ% E
c | || MANY [ | | R J
e[| ReMP more..” FIRGEN | FIR20C | 32 |~ ‘ J
] ] L]
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Tl Digital Filter Software Package

TI’sDigital Filter Softwar e Package

Tl Provides a Digital Filter Software Package that can be
used to implement various forms of Digital Filters
¢ TheDigital Filter Softwareisprovided in:

+ Assembly Language (ASM)
+ C-Callable Assembly (CcASM)

Filterstypesprovided areFIR & IIR

¢ Coefficient tables are provided for several L owpass,
Highpass, Bandpass Filters

¢ Digital Filtersareimplemented on T1's*C2000
DSP’'susing different techniques:
+ Linear Buffer Delay Line Approach
+ Circular Buffer Approach (Uses Bit-Rever sed Addressing)

¢ Filter design scriptsare provided for MATLAB
Signal Processing Toolbox

L 4

Types of Filtersin
TI'sDigital Filter Softwar e Package

¢ All Software provided follows T1's M odular
Software Library Methodology

¢ TheFollowing Typesof Filtersare Provided:
+ FIRGEN - Generic FIR Filter w/ Linear Buffer (var. Order)
+ FIR10 - Fixed 10 Order FIR Filter using Linear Buffer
+ FIR20 — Fixed 20t Order FIR Filter using Linear Buffer
+ FIRCGEN- Generic FIR w/ Circular Buffer (var. Order)
+ FIR10C — Fixed 10t Order FIR Filter using Circular Buffer
+ FIR20C — Fixed 20t Order FIR Filter using Circular Buffer
« |IR16 - 16-bit IIR Filter
+ 1IR32 - 32-bit IIR Filter
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TI'sComplete Digital Filter Demo Systems

To Better Understand and Use the Digital Filter Software
Package, Tl provides complete Demo Systemsfor each filter type

¢ Diqital Filter Demo'sInclude:
« All necessary software (.asm, .c, .cmd, .out, .wks...)
+ Complete Documentation and Code Composer Workspace

« Instructions for running demo on eZdsp™ or EVM hardware
platforms

« Several Data Input Options
« Analog Signal from Externa Sources (function gen, other...)
« Software Simulated Analog Signal
+ Severa Filter Output Options
+ Code Composer Graph Windows
+ Oscilloscope - Measurement of PWM-based DAC
+ Oscilloscope - Measurement of DAC (EVM only)

Digital Filter System Block Diagram

»| Datalog g Code
Analog | nput | Module Composer
Source o 1
(External) Digital 1 |_DATA LOG
+ Function Gen. s :
-Application Cir . Module |,
\ ADC Module 1 | DAC Output il
— apcoa bRV ] .TLTSE)N > Module Sy
! | DAC_VIEW_DRV
Analog I nput :'I:IIRRff(S) :
(Simulated) :
.swsnecen | A-to-D *lIR32..  |! | pwM DAC oul
+ Other SW Source . > Module RC sa_ loscope
Conversion - ckt | Display
Modul Di o]l tal PWM_DAC_DRV
Analog odute Filter Filter
Input Module Output
Sour ces Output :
Dlspl ay Dlspl ay
Options
[] = Available Software Modules Modules P
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Intro to Lab Exercise

For

.

.

.

Running Lab6 - Digital Filter Demo

Purposes of thisLab, we will review and demonstrate a

modified* Filter Demo from TI’ s Digital Filter software package
¢ Lab6Badcs

Review components and features of TI's Digital Filter Demo
package

Review LAB6 Components. Lab6 is based on amodified*
copy of Filter Package Demo FIR20 (ASM version) - Fixed
20th Order FIR Filter.

Build and Load Lab6_FIRORD20 Filter Demo code using
Code Composer and eZdsp™ LF2407

Run the Filter Demo using a DSP PWM output as the Analog
Input Source (viajumper wire on eZdsp™ L F2407 board)

Vary Filter performance using different Coefficient tables
Display Filter Output using Code Composer Graphs

* Modificationsinclude Lab6 directory structure and addition of PWM output

Module 6 Lab: Digital Filter Demo

EVTl connector Delay Line Filter
for FIR Coefficients

PWM Generators wire ADC
[T
[T \ AEElEs
[z 18 P % PP

| result - -
e : et tdaa Ry

1 == -
T e

Event Mgr

PWM Outputs | GP Timer2triggers

| ADC SOC every
H 50 ps (20kHz)

v

M?

pointer rewi

Output of

FIR buffer

in memory =
=

GP Timerl GP Timer2 CodeC
GP Timer 1 used for PWM outputson GP Timer2 used ode Ompowr
pins: PWM3/PWM4, to Trigger ADC conversion /
50% duty cycl every 50 ps (20kH2) .
Q100H: ysoms e View Results
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L ab6 Software Flowchart

INT3

@ Interrupt
¥
T2UF ISR

Initialize Software Save contexts and
Modules clear interrupt
flag

S E—

Initialize Real Time
Monitor, Timer 2 and

Acquiretheinput
sample

Timerl (PWM
module
I T

Enable Timer 2
under flow Interrupt Update the
and Core Interrupt DATALOG,

INT3 EVMDAC and
PWMDAC modules

Background

Restore
L Return |¢—
- contexts

L ab6 Software Directory Structure

The Software used in Lab6 residesin thefollowing directory:
C:\DSP24 _1DAY\L abs\L ab6\L ab6 _firord20...

3 £ id BEIE]

. =) ¥ B B oo | X g | H
PR T ws| & Gy res | unb | Oua Poetes | Ve
| e [ C05P2e_TOAV\AES LboLath_ o0 =

Il Size| Type. T Mediied
26 cuorie e 2107
firgiiein s
frpveis Pty
200 oUtfe i
freits ettt

: ' ) For Lab6
c:]rdol ﬁ[aEUI\I:kFI Iz i L oad Code Composer
T ST Workspace

739 e ..\ build \ L 6fir20d.wks
'“Ef}c':::z . Include Files
S -h, .asm

Source Files
.C, .asm, .obj
) _ i)

X ]
T2t ]y Conputer
2 m &L > || ane [Hew i | o | Sten | i | BT SAXCEHIBIS 1amm
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Parallel Port/
JTAG

Controller
Interface (P9) -

Power
Connector (P3)
+5V

Lab 6 Hardwar e Connections

Connect Jumper Wire
between P2-11 and P1-2

1/0 Interface (P2/P8) ANALOG
Interface (P1/P7)
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Module 6 Lab: Digital Filter Basics

Outline

1) Introduction —Overview of Digital Filter SW Library

2) Objective and Components (10 mins)

- Datalnput/Output Options

- Software Library Modules Used
- Directory Structure

- Filter demo Block Diagram

- Software Flowchart

- Hardware Setup

3) Lab6 Procedure (20-30 min)

- Review Lab Components
- Connecting the Hardware
- Building and Loading the Filter Project

- Running and Viewing Filter Performance
- LowPeassFilter
- HighPass Filter
- BandPassFilter (OPTIONAL)
- StopBand Filter (OPTIONAL)

APPENDI X 6A (Reference)
® Theory of FIR filter Used in thisLab

APPENDIX 6B (Reference)
® Overview of the Complete Digital Filter SW Library Package

APPENDIX 6C - Code Listings (Reference)
® L 6fir20d.asm Main System File
® Fir20a.asm FIR Filter Algorithm
® Fircoeff.asm Filter Coefficients
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1. Introduction

Tl offersa Digital Filter Library Software package containing Modular Sourcecode,
Documentation, and Demonstrations for several different types of Digital Filter Implementations
(see Appendix for Details). This package is available Free-of-Charge from Texas Instruments
(subject to TI's Free Software license agreement) and contains the flexibility and filter coefficient
tables necessary to demonstrate L ow-Pass, HighPass, BandPass and StopBand Filters with
various cutoff frequencies. Lab6 will focus on understanding and using a modified version of
the FIR20 package for Fixed 20" Order FIR Filters.

T1'sC2000 DSP Digital Filter Library Options:

1) FIRGEN - Generic FIR Filter using Linear Buffer (variable Order)

2) FIR10 — Fixed 10" Order FIR Filter using Linear Buffer
LAB6 FOCUS . " : . .
3) FIR20—-Fixed 20" Order FIR Filter using Linear Buffer

4) FIRCGEN - Generic FIR Filter using Circular Buffer (variable Order)
5) FIR10C — Fixed 10" Order FIR Filter using Circular Buffer

6) FIR20C — Fixed 20" Order FIR Filter using Circular Buffer

7) 1IR16 - 16-bit IIR Filter

8) 1IR32 - 32-hit IIR Filter

2. Objective and Components

Lab6 uses software modules from TI's Software Library to create a complete system to
demonstrate digital filtering on the eZdsp™ L F2407 hardware platform. This lab uses a modified
version of the FIRORDZ20 Digital Filter Demo, which isone of severa Filter Demo’s available
in TI's Digital Filter Library. Only a portion of the Digital Filter Package's capabilities are
exploredin thislab. Refer to the Appendix for details of the Digital Filter Library package.

Theideabehind Lab6 issimple. A jumper wire will be used to connect the PWM signal to one of
the ADC inputs on the eZdsp™ LF2407 board. This PWM signal will be sampled at 20K Hz
through one of the DSP' s ADC inputs, and the sampled digital representation will be passed
through the Filter module to perform Digita Filtering. Both the input data sequence and filtered
output are logged and displayed in Code Composer Graph Windows. Thisisdoneto minimize
the required hardware for thislab (no signa generator or Oscilloscope are needed). Note that the
Filter Demo has severa possible Data Input and Output Display optionsin addition to what is
explored in thislab (see below)

Digital Filter Demo - Data | nput Options:
1) Anaog signal from Signal generator

Meti:ofaﬁm 2) Analog Signal from EVM or eZdsp™ board (through jumpers)
3) Software Simulated Analog Signal
Digital Filter Demo - Output Visualization options:

Me‘i‘ﬁ’aﬁw’ 1) Code Composer Graph Windows

2) Oscilloscope — Measurement of PWM-based DAC
3) Oscilloscope — Measurement of hardware DAC signals (2407EVM only)
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Software Library M odules Used:

The following Assembly Language modules are used in thislab. Most Modules are availablein
both ASM and CcASM. Refer to Modular Library Documentation for complete details.

1. ADC0O4U DRV - Converts Analog Inputs to Digital Format
2. PWM_DAC DRV (PWMDAC) Generates amodulated PWM signal on DSP output

3. DAC_VIEW_DRV (EVMDAC) Sends Digital Signalsto External Hardware DAC
(HW DAC isonly present on LF2407EV M, not available on eZdsp™ L F2407)

4. DATA LOG - Displays signals in Code Composer Graph Window
5. SYSINIT® System Initialization
6. FIRORD20 - Fixed 20" Order FIR Filter using Linear Buffer

L ab6 Directory Structure and Files Used:

The software modules used in lab6 consist of several assembly language sourcefiles, which are
described in the following directory snapshot. Keep in mind that all of the modules/files shown
below are active in this project, but some are not reviewed in this lab (DAC Driver, PWM
DAC driver...). The main files examined/modified in this lab are highlighted. Only the files
L 6fir20d.asm and firsel.h are actually modified in this lab. All other sourcefiles are copies of
the original software library sourcecode. Refer to the SW Library Documentation for complete
details on using any of the modules.

C:\DSP24_1DAY\LABS\LAB6 —

— Lab6_Firord20 —T— build

—> fir20d.cmd
L6fir20d.mak
L6fir20d.out
L6fir20d.wks

— include —» asmdemo.h

fircoeff.asm
firfilt.asm
Modified to select firinit.asm
L owpass, firsel.h
Highpass... rtvecs.h
x24x_app.h

—» s;)c —»  adc4udrv.asm

dac_view.asm
data_log.asm

Project Workspace
Used in thisLab

(Linker Command File)
(Project Make file)
(Project Output file)
(Project Workspace)

(Clock Frequency Config)
(Filter Coefficients)

(Filter Structure Declarations)
(Filter Initialization)

(Filter Type Selection)
(RealTime Monitor vector file)
(Main header file)

Empty for assembly lang case (used in C case)

(ADC Driver Module source)
(DAC Driver Module source)
(DataLog Module source)

(20" Order FIR Filter source)
(Main source for this project)
(PWM DAC Driver Module source)

—» RTMON (Realtime Monitor Components)

fir20a.asm
. . L 6fir20d.asm
E/Iam System Fl|e?pwm_dac.a8m
Sys_init.asm

several *.obj files

(System Initialization Module)
(.obj files for above sourcefiles)

Necessary, but not explored in detail in this lab
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Module 6 Lab: Digital Filter Basics

Lab6 Block Diagram
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Module 6 Lab: Digital Filter Basics

Software Flowchart

y

Initialize Software
Modules

Initialize Real Time
Monitor , Timer 2 and
Timer 1 (PWM Outputs)

y

Enable Timer 2 underflow
Interrupt and Core
Interrupt INT3

A 4

INT3
Interrupt

T2UF ISR

N

Save contexts and clear
interrupt flag

N

Acquire the input sample

N

Execute the filter module

Background
Loop

Update the DATALOG,
EVMDAC and PWMDAC
modules

N

Restore contexts
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Module 6 Lab: Digi

tal Filter Basics

L ab6 - Har dwar e Setup:

The hardware used in thislab consists of the eZdsp™ LF2407 board and Jumpers used to connect
the PWM outputs to the ADC Input. The Block Diagram and Board Layout are as follows:

CODE COMPOSER

LF2407 Board
LF2407 DSP
PWM FILTER ADC
/— /— <—.
OUTPUTS [ N1 INPUT
ALGO

l P2-11 1/0O Connector

P1-2 Anaog

Jumper Between
1O Conn. P2-11 and
Analog Conn P1-2

Jumper Between
10 Conn. P2-11 and
Analog Conn P1-2

M DIGITAL INCORPORA

C 2000 © 2
e = e/ dsp TMS320LF 2407 Qe B
| | | |
Pe Ooo qaooooooaooooooaoaooooaoao% el =
O g 000 PIloeooconoco0cn00nRC00000a0) R
oo mwe T EXPANSION oM 0nnomn 2
— P 9999003 EELEED o S orbafeu 0 e
o0 |RID Dooo Qo EUEDDDDD O& O o Sgétl 1000000 ~ gogoom &
oo = =3
AC [Bocs_ JPI0 UTAGEIDE mmmmmmm. S ¢ 0S5 55/ Soe &8 E
SOBE &MU _goo g g 50 15,08 eE g .
g8 E| B i 5 g g
08 oo BHE| E292E E o op QNI s 2 e S
OF5 oo SESEln=ery - 8 ow E E hoon £ =
09 8L, ot o g a8 0 B EERE Eo
o8 DDEE? 0% e = o = = oooiE =
oo o 0= =
o |on-“ge caeraft P58 B0 O orgps = D
O~ |80 Coooy g g ol
< (0D Hoogygjoo £ E"Dl:llﬂé -
oo [an 50 e 5% B =00 2
o |o0 RNggOOr- J1 3T [ = B
08 |88 5,705 gn0] Clhﬁ AL e Jrg 5.0 OIS o' e pa 3
| EBSn TR )R SEEEEE ey DO
= =
O oo o L9 [epbfe O =000 D00 ana poh 5
,O, BY [OCo0COLOCLOCOG000000h, [Ho00cooeapr %
] SOoOOooOQ0o000000o0000 RSO0 L o000
\ O‘ 5 nccocecgocooccccococoof [Roccoonoool! /_
O 1 T T

7
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Module 6 Lab: Digital Filter Basics

3. Procedure

1) Spend afew minutesreviewing Sections 1 & 2 of this document to understand the Objective
and Components of Lab6:

Software Modules Used

Directory Structure and Filenames
Hardware Setup

System Block Diagram

Software Flowchart

2) Connect and Power-up Hardware. Connect Jumper Wire between 1/0O Connector P2-11 and
Analog Connector P1-2 (refer to Hardware Setup Diagram)

3) Launch Code Composer and L oad the Workspace: File =>Workspace=>L oadWorkspace=>
C:\DSP24_1DAY\LABS\LABG6\Lab6_firord20\build\ L 6fir20d.wks

4) Refer tothe Screen Capture Below (on next page) for Diagram of

the next several steps. In the Project Window, expand the Project Directories (click
on the +'s) and spend a moment reviewing the names and locations of the sourcefiles
(*.asm), header files (*.h), and command files (*.cmd) used in this project.

SELECT LOWPASSFILTER OPTION

5) Locate the main system file L 6fir 20d.asm. (should already be open in the Code Composer
Workspace, if not then it can be found in Source directory). Spend afew minutes examining
the sourcecode to understand the general structure/flow of the software. L ocate the section
called Filter Initialization (Hint...one convenient way to do thisisto type Filter Init in the
Code Composer Search Window and hit <Return>). Under the Filter Initidization section,
UNCOMMENT (removethe semicolon ;) the Select L owPass option. Comment out the
other selections.

; Filter Initialization
LDP #pf
= SPLK #FIR_LPF20_coeff_ptr,|pf.coeff_ptr ; Select L owpass
; SPLK #FIR_HPF20_coeff_ptr,Ipf.coeff_ptr ; Select Highpass
; SPLK #FIR_BPF20 _coeff ptr,Ipf.coeff _ptr ; Select Bandpass
; SPLK #FIR_BSF20 _coeff_ptr,Ipf.coeff_ptr ; Select BandStop

6) Locatethefilefirsel.h (should already be open in the Code Composer Workspace, if not then
it can be found in INCLUDE directory). Enable the 20" Order L owpass option by putting a
“1” in the 20" Order L owpass selection. Make sure all other options are “0”:

. 20th Order

= FIR_LPF20 .Set 1 ; Select Lowpass
FIR_HPF20 .set 0 ; Select Highpass
FIR_BPF20 Set 0 ; Select Bandpass
FIR_BSF20 Set 0 ; Select BandStop
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Module 6 Lab: Digital Filter Basics

7) Fromthe Toolbar, select Option => Program L oad and make certain the “L oad Program After
Build” box ischecked. Select Rebuild All to assemble and link the Project (use Toolbar
RebuildAll button, or Pulldown menu Project => RebuildAll).

8) Ensurethat L 6fir20d.out is successfully loaded to DSP target. Y ou should seea Y ellow Bar
highlighting the line CALL SYS _INIT in the Dis-Assembly window (if thisis not the case,
then use Toolbar to select File=> Load Programto load file L6fir20d.out)

_ﬁ_ Zsdgo2xx [Spectrum Digital }/CPU_1 - C2%X Code Composer- LBfir20d. mak

File Edit Wiew Project Debug Profiler Option GEL Tools ‘Window

Sear ch Box...
type 1% few chars
and hit <Return>

Help

B@ |4 B8 o = |[Fiter nit

e &R o= Y

& [T e I Dis Assembly Step 8 Verify Code | il
Step 7 - = O1Fs EFOD RET. A&cc&ssfully M
" [z =g LEfir20d. mak 01F5S c_intO:
RebUI|d x ﬁ fir20d.crnd D1F5 7AB0 CALL SYS INIT, = Loaded to DSP p
- B3 Include 01F7 BCED LDP #elh
All T QJL\U&WAE
! asmdemoh 01F8 AE18 SPLK #85h, 18h
ﬁ 200wt 01FA 7AB0 CALL Pw_DAC_DRV_INIT,= =l
B fircoeff.asm 4 | (
P - firfilt.asm - . .
.. B fiitasm 73 L61i120d.asm - Step 5 Uncomment Desired Filter
Y firselh ; Copy the Coefficients from LOAD address t . . .
ftvecs.h CallL  FIRCOEFF_COPY_ROMZRAM Optl onin Iab6_f|r20d.asm

a

‘[B) #24x_app.h

\ -[1] Libraries t —
B[] Source LDP #1pf
adcdudry.asm SPLE #FIR_LPF20_coeff ptr,lpf.coeff_ptr ;Select Lowpass
Expand l 200t zsm SPLE  #FIR_HPF20_coefi_ptr,lpf.coeff_ptr : Select Highpass MW
H dac_view.asm SPLE #FIR_BPF20_coeff_ptr.lpf.coeff ptr ; Select Bandpass [——————
PFOjeCt and [E) data_log.zsm SPTE  #FTR REFZ0 coaff otr.1nf.coeff otr : Select RandSton | [oon S
Note Project B ot ' E—
H 3 - [) dac.sm
Sourcefiles pom.. . 20th Order -
B s itasn ; Belect Lowpass StQQG Set Desired
- ; Belect Highpass . “wqn
& ; Select Bandpass Fllter Typeto 1
e ; Select BandSt wAny
g mimet Bandstop (others“Q”) in
&L firsel.h
5] Av|
Al EC - OIFS = Board Version 00.00.81 B
Euild Complete, ACC = 00000 Target Silicon ¥ersion 00.00.205
0 Errors, 0 Warnings. PREG = 0005 Device Driver Version 02.15.00
ITREG = 0D&7 -
3T0 = 0600 | | b
hd ST1 = OFFC =
A[ATETET:, Buitd /7 =] Ll _»l_l Comnand: | BRI
|D5P HALTED I For Help, press F1 tnzg Catzo [ [ [

swt|| A %2 B E D> || Qoo | Faco. | GEs | @i | ced. | Ebic. [[§ sd.. |[Botd BHH 5@ LOF R 21
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Module 6 Lab: Digital Filter Basics

Enable Code Composer Realtime M ode
9) Invoke REALTIME MODE: using the following Steps

RealTimeStep 1) Select Menu Item DEBUG => RESET DSP
RealTime Step 2a) In Command Window type go MON_GO (typethisexactly asis)

Step 2b) Click EXECUTE (you may see the file C200mnrt pop up... just
minimize thisfile asit will not be reviewed in thislab)

RealTimeStep 3) Select Menu ltem DEBUG => REALTIME MODE

RealTime Step 4) For each Graph Window, Right Click in the Graph Window and
select =>Continuous Refresh (note: once thisis done once for each graph, it does not
need to be repeated unless Continuous Refresh is somehow turned off)

_ﬁ_ Zsdgo2xx [Spectrum Digital }/CPU_1 - C2%X Code Composer- LBfir20d. mak

File Edt Yiew Project | Debug Profler Option GEL Tools Window Help
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. pliut i o )
RealTimeStep 1— [ am P | #OneE oers) ) Zsom K >
ir i 5 d
Reset DSP el | ! 2 p1n,63h 0280 v hies
Animate F12 ﬂ ﬂ j\
B s Y it v Status Bar
B CilgiEs BET: V V Giid 5
Ffom ke Eorsan [t B0 -0.850 an
" FMultiple Operation... F11 1 Cursor Mode: » 0.00300 0.00335
= : Log Scale =0l x| 'E
d Restart ezt?iin Fized Scale =[O ]
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r Eriabie Task Level Debuaaiig _z_intd Feset Feak
. gL v FReal Time Mode PHANTOM
Real T Ime S:ep 3 —_ E Enatie Bude Beal Time Mode PHANTOM errBSh
" ) TIOOTT ST T b TZ_PERIOD _ISE Lontinuo [
Select Real Time Mode ) dac viewasm | f[TNT4 B PHANTOM Clear Display
) data_log.asm TRTS R PHANTOM =
Y fir20a.asm d HB|D Auto Scale |Rectangular
7 AL as| 5 Properties...
3 —[B] pwm_dac.asm . .
2;‘6 B sys_init.asm f‘I;DE}PngEdE R%ITlme Sep 4 e B e e
e FIR_HPF 20 For each Graph Clase
2 FIR_BPFZ0 : : s v Float In Main Windaw
i FIR_RSF 20 Window, Right Click in
% . 10tn orded  WWindow and Select | : = :
L FIER LEF10 . FFT Mag Lin |Auta Scale |Rectangular
= =T
B/s] [ Co00mait Continuous Refresh T

0 Errors,

Build Complete,

0 Warnings.

STO0 2600

A Bc = 06z =
ACC = 00000
PREG - 0005
TREG = ODE7

B STl 43FC =
e | LT

Target Silicon Version 00.00.205 ;I
Device Driver Version 02.15.00

go HON_GO
| ;I:‘

go HON_GO

4
CW [go MON_GD

AT TR, Buita £ =] | Execue |
[DSP HALTED [REALTIME Reset target DSP L1133, Cal1 /7

iﬁSlart"J Heum3E&dw

|J Cod... | Acm...

RealTime Step 2a—
Type go MON_GO

and Space sensitive)

exactly as shown (case

NERYC SR =

RealTime Step 2b
Click EXECUTE

ﬁasn B
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Module 6 Lab: Digital Filter Basics

View the L owPass Filter Output

10) Select RUN (from Icon or Debug=>RUN) and verify the following Filter Display

_"-‘ ZJedgo2xx [Spectrum Digital }/CPU_1 - C2<X Code Composer- LEfir20d. mak

File Edit ‘“iew Project Debug Ppofler Option GEL Tools ‘wWindow Help

s

2 ra-’“ﬂlééEaa\nm}b-——”—“‘—"—m—‘%*”a&é»&é\u%é*;z|§§|/¢%ﬁ@|

A) Time Domain I nput

Files =2 Input & Output - Time Domain

(2] GEL files

L owPass Option

L owPass Option

Selected

2
=27 Project 00S5E AEG4 SPLE #67h,64
= a0 Onen AEeD CDTE 40 £3L \ ’ \ I \ } \
-1.00.

B T. . . T T T T
E ime Domain Filtered Output 100
@ l ) p RN ata
b 200t 0065 MON_RESET: i
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— 000300 000355
fad firinit. asm ¥ LEfir20d. asm ;|Q|1||E

wan |5 eop g Coertoeens e o < P — o

ftvecs.h CALL FIRCOEFF_COPY ROMZRAI

w24u_app.h

i < ; AR 5l isation

L] LDP  #1lpf
7 S — SPLE  #FIR_LEF
o - 2 mr
B da .

o « C) Frequency Domain Input

 [[3384.38, 4.30345)

fir2ler

|FFT Mag [ Scale |Fectangular

-[B) LEfir20d.asm
B pwm_dac.asm
[E] sys initasm

: 20th Order

E2 Output - Frequency Domain |0 ﬂ

Q FIR_ESF20 .set
&L D) Frequency Domain Filtered Output |88, nzaszeg) [FFT Mag [Lin [Buta Scale [Rectangular
g — — =
_ A
&I Pc - ooez = Devic -
e Errors. hes - Dmgj -7 LowPassFilter ) T
0E L 0 W i . PREG = O00A b -
Irors ATn1ngs TREG - O3RE g0 HOK_G| NOte that Only the ﬁ
511 - aore o[ Low Frequency -
AR, Buitd £ IERN} L|j | _>|_I Command : Com onents Halt
[DSP RUNNING IREALTIME. For Help, press F1 p S
#swt|| A %2 B3 E D > || Goed. | Faco. | GEsl | @7vic. | Mcod. | Evic. |[§ s |E\rema|n /W

11) Verify that display is as expected:

A) Time Domain Input = 1000 Hz Square Wave from DSP PWM Output (you can use x-
axisin TimeDomain Graph to verify the signal period 0.00100msec = 1000H2)

B) Time Domain Filtered Output = Filtered Result for L owPass Filter with 3000HZz Corner

Frequency. Frequency components >~3000H z have been filtered out.

C) Frequency Domain Input = 1000Hz Square Wave (PWM Output)

D) Frequency Domain Filtered Output = Filtered Result for L owPass Filter with 3000Hz

Corner Frequency. Frequency components >~3000H z have been filtered out.
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Module 6 Lab: Digital Filter Basics

12) Turn Realtime Mode OFF before proceeding (IMPORTANT — Failureto turn Real Time
Mode OFF before making Code changes and loading new Code can result in

Unpredictable Operation):
o RealTime OFF Step 1) Select HALT (Use Halt Icon, or DEBUG =>HALT)
o Real Time OFF Step 2) Select DEBUG=>REALTIME MODE (click OFF)

. Verify DSPisHALTED and NOT in REALTIME Mode before Proceeding

_"-‘ ZJedgo2xx [Spectrum Digital }/CPU_1 - C2<X Code Composer- LEfir20d. mak
File Edt iew Project | Debug Profler Option GEL  Tools ‘Window Help

B | i D [C] ABR% SN e EE (4% %4
N — Probe Foints..
& @ Files Stepirto F8 =2 Input & Output - Time Domain . o [m] 3]
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-3 Froject Stenlut shitpr | INL_INTT,=
= fir’;DZE B = IHTM
2 B AR iklidr O 1007 ' ' '
- E‘E:'E' frimate Fig | meantesn ;N FoN
Ll | Fiun Free U
H Run ta Cursor Cul F10 RealTlme OFF Step 2) -
E | Multiple Operation... Fi11 0.00300 0.00335
f H (O] x] sk
o Rleset DSP Real Time Mode (click OFF) 5 =
Restart -
s Eo? \
& ey e
) Libr Enatie Task Level el il ain_loop
® Eratie Hude Heal Time fads S SSSSSSESSsEsssEssssssssssssssssssss=E
= _ ==
-[B) dac_view.asm
{fil data_\og.asm ettt sttt fiosfisfiosfonsiosfonfiosfiosfinsfissfisfisfisfossfonsfonfiosfisfinstissfisfisfiosfosfonfofenfsfinstistion
@ fir20a.asm 14] Rectangular
= ool Siiscth [ = Ouput - Frequency Domain =lolx|
2 T e enam L 20th Order
j\ B etz e P20 .set
. %
éﬂ/\ -
il RealTime OFF Step 1)
&L SeleCt HALT DSP (Can (867188, 0.47081) [FFT Mag |Gn [Auta Scale [Rectangular
& I : By
also use Pulldown Menu :
— Al PC = 0236 =« Device Driver Version 02.15.00 =]
Euild C\£EBUG =>HALT) / ACC - DDDDéj g0 HON_GO
0 Erroi> PREG = O00A o Mow_co
TREG = 03BE B - =
2T0 = 2400 q [ v
- 5T1 = 23FC =
A0 Buia / “LLI N ‘I _,l_l Connand : |gu MON_GO j Hailt I
|DSP HALTED [ If checked, processar is in Real Time Mode ’mh’ih

|| ted. | Elaco.| ByEwl. | g7tier. | ol | Eitice. [ 7. |[BBetd BORI@HLDF RS 109P

EaSlarl"J Cl

Verify DSPisHALTED
and NOT inREALTIME
Mode before Proceeding
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Module 6 Lab: Digital Filter Basics

SELECT HIGHPASSFILTER OPTION

13) Ensure DSP isHALTED and NOT in REALTIME Mode (bottom left corner of screen)

14) Locate the main system file L 6fir 20d.asm. (should already be open in the Code Composer
Workspace, if not then it can be found in SRC directory). Locate the section called Filter
Initialization (Hint...one convenient way to do thisisto type Filter Init in the Code
Composer Search Window and hit <Return>) Under the Filter Initialization section,
UNCOMMENT (remove the semicolon ;) the Select HighPass option. Comment out the
other selections.

; Filter Initialization
LDP #pf
' SPLK  #FIR_LPF20_coeff_ptr,|pf.coeff ptr ; Select Lowpass
= SPLK #FIR_HPF20 coeff ptr,|pf.coeff ptr ; Select Highpass
; SPLK #FIR_BPF20_coeff_ptr,Ipf.coeff_ptr ; Select Bandpass
; SPLK #FIR_BSF20 _coeff_ptr,Ipf.coeff_ptr ; Select BandStop
15) Locate thefilefirsel.h (should already be open in the Code Composer Workspace, if not then

it can be found in INCLUDE directory). Enable the 20" Order Highpass option by putting a
“1” in the 20" Order Highpass selection. Make sure all other options are “0":

;  20th Order
FIR_LPF20 .Set 0 ; Select Lowpass
= FIR_HPF20 .set 1 ; Select Highpass
FIR_BPF20 Set 0 ; Select Bandpass
FIR_BSF20 .set 0 ; Select BandStop

16) Select ReBuild All and Ensure that L 6fir 20d.out is successfully loaded to DSP target (refer
to Steps 7 & 8 if you need details on accomplishing this).

17) Invoke REALTIME MODE using the following steps (refer to earlier diagram as needed):

RealTimeStep 1) Select Menu Item DEBUG => RESET DSP
RealTime Step 2a) In Command Window type go MON_GO (type this exactly asis)

Step 2b) Click EXECUTE (you may see the file C200mnrt pop up... just
minimize thisfile asit will not be reviewed in thislab)

RealTimeStep 3) Select Menu Item DEBUG => REALTIME MODE

RealTime Step 4) For each Graph Window, Right Click in the Graph Window and
select =>Continuous Refresh (note: once thisis done once for each graph, it does not
need to be repeated unless Continuous Refresh is somehow turned off)
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6 Lab: Digital Filter Basics

View the HighPass Filter Output

18) Select RUN (from Icon or Debug=>RUN) and verify the following Filter Display

_"-‘ ZJedgo2xx (Spectrum Digital }/CPU_1 - C2<X Code Composer- LEfir20d. mak

File Edit ‘“iew Project Debug Ppofler Option GEL Tools ‘wWindow Help
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H | gh Pa$ Optl on CALL FIRCOEFF_COPY ROMZRAI
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o B C200mrvt.asm SPLE #FIR_HPF
1 B ey e .
L B datal .
- s C) Frequency Domain I nput |Irzane 25, 4.53033) [FFT Mag [Lin [uta Seale. [Fectangular

E2 Output - Frequency Domain

. . prm_dac.asm .
gégh P;SS Option  [oeesn | 200 Oxde
&t r|[FIR_HPFz0
[FIR_EPF20
— / FIR_BSF20
% |_ éTéupr?ﬁder [(345313, 1 57898) [FFTMag /\ [Lin [Auta Scale [Rectangular
oja - =
—J‘ D) Frequency Domain Filtered Output 1 =
- =[||[z= Hon_co . .
Buélg Comple‘éew ) ngg = ggggﬂ gg ggg—gg 4 HIghPaSS Filter-
ITrors., arnings. = —
! TREG = 03BE  [|7° MNEY Note that only the
3T0 = 2600 .
AIZI ST1 - 4aEc_l;| - High Frequency
A[ATETET, Buita / IEARE < ’ Comnand: oot Components
|DSP RUNNING [REALTIME  For Help, press Fi p

Hstat|| 4 & 29 BE D > || Gcod. | Flace..| Gyl | 57 | M Cod. | Ebic.. |[§ 75 |mqkremaln
19) Verify that display is as expected:

A) Time Domain Input = from DSP PWM Output (you can use x-axisin TimeDomain
Graph to verify the signal period 0.00100msec = 1000H2)

B) Time Domain Filtered Output = Filtered Result for HighPass Filter with 4000Hz
Corner Frequency. Frequency components |less than ~4000H z have been filtered out.

C) Frequency Domain Input = 1000Hz Square Wave (PWM Output)

D) Frequency Domain Filtered Output = Filtered Result for HighPass Filter with 4000HZz
Corner Frequency. Frequency components |less than ~4000H z have been filtered out.

20) Turn Realtime Mode OFF before proceeding (IMPORTANT — Failureto turn Real Time
Mode OFF before making Code changes and loading new Code can result in
Unpredictable Operation):

e RedTimeOFF Step1) Select HALT DSP (Use Halt Icon, or DEBUG =>HALT)
e ReaTime OFF Step 2) Select DEBUG=>REALTIME MODE (click OFF)
e Verify DSPisHALTED and NOT in REALTIME Mode before Proceeding
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OPTIONAL —

The following Section is Optional and uses similar methods to explore other Filter Options.

SELECT BANDPASSFILTER OPTION

21) Follow Real Time Off steps outlined earlier (step 12) and ensure DSP isHALTED and NOT
in REALTIME Mode (bottom left corner of screen)

22) Following the steps outlined in previous sections (refer to steps 5-12 if needed), make the
necessary code adjustmentsto L 6fir 20d.asm and firsel.h to SELECT and RUN BANDPASS
filter option.
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\

v4

s 5200 . . o6z & Enter y‘_/ untion
corvrig D) Frequency Domain Filtered Output gggj v BandPass Filter- Note
Dev -

Euild Cowp— 982 .
0 Errors, 0 Warnings. g%? - iggg gn ggg tha Onlythe Frequency
Jz‘ RPTC - 0000 o |14 Componentsinside the

e T RS ) XIS —"_I €M passBand remain

[DSP RUNMING |REALTIME Far Help, press F1

st Ao mBE > || Odad  |BYenw @Y o1 zle |Bewed Fo3 ¥ B 55zrM
23) Verify that display is as expected:

A) Time Domain I nput = 1000 Hz Square Wave (PWM Output)\

B) Time Domain Filtered Output = Filtered Result for BandPass Filter with 4000Hz and
6000Hz Corner Frequencies. Frequency components outside of~4000Hz to ~6000H z Band
have been filtered out.

C) Frequency Domain Input = 1000Hz Square Wave (PWM Output)

D) Frequency Domain Filtered Output = Filtered Result for BandPass Filter with 4000Hz
and 6000Hz Corner Frequencies. Frequency components outside of~4000Hz to ~6000H z
Band have been filtered out.
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OPTIONAL —

The following Section is Optional and uses similar methods to explore other Filter Options.

SELECT BANDSTOPFILTER OPTION

24) Follow Real Time Off steps outlined earlier (step 12) and ensure DSPisHALTED and NOT
in REALTIME Mode (bottom left corner of screen)

25) Following the steps outlined in previous sections (refer to steps 5-12 if needed), make the
necessary code adjustmentsto L 6fir 20d.asm and firsel.h to SELECT and RUN
BANDSTOP filter option.

™ /sdgoZxx [Spectrum Digital 1702 HEE

File  Edit Wiew Project Deb

BeEuls =8 A)TimeDomain Input &R E: EE[EE | sH A A

2 Files ~— ol BT e M=
i ||| E- 3 GEL fles D1AE 7ABD CALL

% Project | |D1EH] 7AB0 CALL

o R I I

g . . . 1.007]

o B) Time Domain Filtered Output [ [ [ [
#H — 100

— 0 0.00100 0.00200 0.00300 0.00395
' [0.0012, 0.997803) [0.0012, -0.856241] [Time [Gn [Auto Scale |

% JRI=Eq
&

b3
: SFLE  #FIF APF70 oot
SPLE  #FLR_BPF20_coeff_pt
_ SPLE  #FIR_BSF20_coeff_ptr

Band&op Optl on SPLE #lpf.dbuffer,lpf.dbu
SDT I HETD ADMFD20 1nF mrd
%Ia:taj Ll d |FFT Mag |Lin [#uto Scale |Rectangular
— - dac.asm 3 20th Order
Vit asrn FIR_LEFZ0
. \T FIR HEFZ0
FIR _BFFZ0
BandStop Option FIR BEF20
Selected
2| ||: 10tk order
P2 [ S e ARAREIL Wssss] FFT |G [Auto Scale [Fectangular
M3 3200 12 . . THS320C2 A -
Copvraant | D) Frequency Domain Filtered Output mee .
e BandStop Filter- Note
Euild Compl?t?,‘ Dev]
0 Errers, 0 Warnings. ST0 = 2400 go HON that the Fra:luency
= ll-5rc = Sooo offlat Components inside the
i L _l:| il StopBand have been
[DSP RUNNING [REALTIME Far Help, press F1

sl [Gou3€s> | odnd |Devmimoile  [Huae, OV
26) Verify that display is as expected:

A) Time Domain I nput = 1000 Hz Square Wave (PWM Output)\

B) Time Domain Filtered Output = Filtered Result for BandStop Filter with 4000Hz and
6000Hz Corner Frequencies. Frequency components inside of~4000Hz to ~6000Hz _have
been filtered out.

C) Frequency Domain Input = 1000Hz Square Wave (PWM Output)

D) Frequency Domain Filtered Output = Filtered Result for BandStop Filter with 4000Hz
and 6000Hz Corner Frequencies. Frequency components inside of~4000Hz to ~6000Hz
have been filtered out.
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Appendix 6A
Filter Theory —Used in L ab6 and FIRORD20

Background Theory -- Fourier Analysis:
e Any signal can be constructed by summing sinusoids of appropriate frequency and amplitude.

e Any signal can be decomposed into a sum of sinusoids

First 10 Harmonics First 100 Harmonics
Waveforms created by summing the first X odd harmonics of a sinusoid

Conversely, it is possible to remove the upper harmonic components of a square-wave signal
using alowpass filter. For example, if alowpass filter with a cutoff frequency between the 1% and
3 harmonic of the square-wave signal is used, the remaining signal will contain only the
fundamental and the 1% harmonic. If the cutoff frequency of the filter is between the 3 and 5"
harmonic, the output from the filter should contain the fundamental, 1% and 3™ harmonic of the
original signal.

Background I nformation for F1R20 — Fixed 20" Order FIR Filter using Linear Buffer

A 20" Order FIR filter is described by the difference equation
20
y(n)=> h xx(n-k)
k=0
or, equivalently, by the system function
20
H(z)=Y h xz*
k=0

Furthermore, the unit sample response of the FIR systemisidentical to the coefficients h(k) , that
is

h, O 20
h(n): X <n <.
0, otherwise
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The signa flow diagram of the FIR filter, representing the above mentioned difference equation
is given below. The following Tapped delay implementation is canonical, which means that the
number of storage element in the structure is equal to the order of the Filter.

FIRFILTER

The FIR filter is essentially a sum of product operating on an array of values maintained in a
delay line. The delay line for this routine is implemented as linear buffer, which requires manual
data move through the delay line. The new datais written to the recently vacated spot at the top of
the buffer. Although C24x/C240x DSP can perform this data movement in parallel with
arithmetic processing, use of this featureislimited to the on-chip memory. Due to this restriction,
it is absolutely necessary to place the delay buffer of the filter for this routine in internal DARAM
BO, B1 & B2 memory blocks
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The following diagram depicts the filter tap computation, the computation proceeds from
the oldest values to the newest. The coeff_ptr and dbuffer_ptr are manipulated to point
to the end of the buffer in the initialization routine though the beginning of the respective
buffers are assigned to the corresponding pointers before calling the initialization routine.

Computing from the newest sample to oldest with DMOV would not implement a delay
line, but instead would copy the newest value through the entire delay line.

Another important thing that the user should understand is the fact that the length of the
filter will be always greater then the order of the filter by 1. That is why the size of the
coefficient array is greater then the order of filter by 1.

DATA MOVE THROUGH LINEAR DELAY BUFFER
Xn

Xn—l

Xn—2

e The FIRFILT_ORDZ20 routine provides efficient execution time, but the
user can no longer be able to modify the order of the filter

=

> > = -
K

[Eorouicy @
?><

coeff_ptr Mo
h dbuffer_ptr

Notes:

e Filter taps computation routine is unrolled, which in turn increases the
program memory space

e Delay buffer array should be located in DARAM Memory Blocks

e Intermediate and final result of sum-of-product computation is
saturated, and the filter output is represented in Q15 format. Hence, if
the filter gain is over ‘1’ in the pass band, then the user needs to
restrict the input amplitude so that the output will not be saturated.
Otherwise, the filter will saturate the output to maximum +ve/-ve
values.
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Appendix 6B

Overview of Complete Digital Filter SW Library

The Digital Filter Library is one of several Modular Software Libraries avaivable from Tl for the
C2000 Family of DSP's (Motor Control Library, Math Library, Filter Library...). Tl provides
these Libraries Free-of-Charge (subject to TI's Free Software license agreement). Refer to the
files SYSTEM.DOC and USER DOC.DOC included with the Filter Library for complete
documentation.

General Software Library Directory Structure

All of these libraries come in .zip Files that should be extracted into the c\TI\DCS directory
structure.

**** |t is recommended that users make COPIES of the necessary modules into their own
working directory to avoid corruption of the Software Library Material ****

CA\TI\DCS — A libxx ) Contains Motor Control ASM library files
b clibxxx N Contains Motor Control CcA Library modules

Contains Motor Control CcA Library driver
Pdrvxxx ——> Y

p rtmon N Contains Real Time monitor programs
—pftrli lib
trib —pp AR ASM Only format Filter Module
Library (Do not Modify ***)
) asmdemo_, <Module Name> build
V/ include
ASM based Filter ob)j
Demo Code Lab6 uses src
a modified local copy
of the asmdemo 3 cdemo
firord20
cmlibxxx CcA format Filter Module

—» Library (Do not Modify ***)

*** |mportant : The source code found in the ftrlib = asmlibxxx and ftrlib = cmlibxxx
directories should not be modified asit isthe Original Digital Filter Library code. Itis
recommended that the User make alocal copy of the necessary modules from these directories to
avoid corrupting the original source code. Lab6 usesalocal copy of the material fornd in the
Filter Library package
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Within the C:ATN\DCS\ftrlib\asmdemo directory, will be several directories as shown below,
containing the Digital Filter Demo Softwarein ASM format. The CodeusedinLab6isa
modified version of firord20 - Fixed 20" Order FIR Filter using Linear Buffer.

C:\TI\DCS\ftrliblasmdemo [~  build
—> fircgen (Generic Demo using Cirular Buffer)
—>  fircord10 (10" order demo using Cirular
—  Fircord20 (20" order demo using Cirular Buffer)
—» Firgen (Generic demo using Linear Buffer)
—»  Firord10 (10" Order demo using Linear Buffer)
—  Firord20 - build —» *mak
*.wks
: N * map
Lab6 was derived from * out
code for 20" Order |
FIR Filter Demo —» include —» *h
— obj —>» *.0bj
— src —>» *.asm
— include
) obj
[ src

Each Filter Demo directory (firord10, firord20...) contains al of the necessary files to build and
run the appropriate filter demo. The main subdirectories contain the code as follows:

The build directory has the work space files (*.wks), make files (*.mak) along with the
map files (*.map) and output files (*.out) for individual functions demo

The include directory contains the include file for the ezDSK demo system.
The obj directory contains the systems object file, generated only in the C framework

The src directory contains the main system file (*.asm for ASM demo, *.C for C demo).
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Appendix 6C — Code Listings

e | 6fir20d.asm Main System File
® Fir20a.asm FIR Filter Algorithm
e Fircoeff.asm Filter Coefficients

; L6fir20d.asm

; Main System file for LF2407 1-Day Workshop Lab #6

; This code is a modified version of one of the Digital Filter Demo's included

; with TI's Digital Filter Library Package. See Digital Filter Library documentation
; for complete details on using all elements of this package. This code originated

; from fir20d.asm included in the asmdemo section of TI's Digital Filter Library

; Package. The changes made to the original code for purposes of Lab#6 are denoted

; with a "Labé" notation in the comments fields. All other code/comments are as

; included in the original Digital Filter package.

; Revision 1.0 3/27/01

;System Name: ASM Framework for FIRFILT ORD20 module
;File Name: fir20d.AsSM
;Description: Primary System file for demonstrating the FIR Filter

7

;Originator: Digital control systems Group - Texas Instruments
;Target dependency: x2407/x241/2/3
;Description:

; This software demonstrates the FIR Filter Usage

; The frame work, for demonstrating the FILTER is given below

I I R | | o | | = |
S | | | | |
i CHO | | | | |

;o---->] |  xn=CHO | | ym | EVMDAC |
; CHO | ADC04U DRV |----- [---->] FIR === - >| PWMDAC |
;oom--=> | | | FILTER | | DATALOG |
; cHO | | | | | |- |
il | | | | | | |

,-******************************************************************************

i SYSTEM OPTIONS

,-******************************************************************************

REAL_TIME .set 1 ; 1 for real time mode, otherwise set 0

,-******************************************************************************

.include "asmdemo.h"
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; EVMDAC Module Externel referance symbol declaration
.ref DAC_VIEW DRV,DAC VIEW DRV INIT ;function call
.ref DAC_IPTRO,DAC IPTR1,DAC IPTR2,DAC_IPTR3 ; Inputs

; DATALOG Module Externel Referance symbol declaration

.ref DATA LOG, DATA LOG INIT ;function call
.ref dlog _iptrl, dlog_ iptr2 ; Inputs
.ref trig value ; Inputs

; PWM DAC Module - Only for x2407 DSP

.1f x2407

.ref  PWM_DAC_DRV, PWM_DAC DRV_INIT ;Function Calls
.ref  PWM_DAC_IPTRO, PWM DAC_IPTR1, PWM DAC_IPTR2 ;Inputs

.endif

; ADC Module External Referance Symbol Declaration

.ref ADCO04U_DRV, ADCO04U_DRV_INIT ;function call
.ref A4 ch sel,Cl gain,C2 _gain,C3_gain,C4 gain ;inputs
.ref Cl out, C2 out, C3 out, C4 out ;Outputs

; REAL TIME MONITOR External Referance
.global MON_RT CNFG ;function call

; SYS INIT Routine external referance
.ref SYS INIT

; Global Varible declaration in main function
.def GPRO,GPR1,GPR2,GPR3,GPR4

; Variable declaration for this main function, map the .bss section in DATA Mem area BO

.bss GPRO, 1 ;General purpose registers.
.bss GPR1,1

.bss GPR2,1

.bss GPR3,1

.bss GPR4,1

.bss xn, 1

.bss yn, 1l

; Labé - Variable declaration for Tl based PWM outputs

;TICMP = 1000Hz PWM

;CMP1 & CMP2 = 1000Hz @ 10% Duty Cycle Complementary Asymmetric PWM's
;CMP3 & CMP4 = 1000Hz @ 50% Duty Cycle Complementary Asymmetric PWM's
;CMP5 & CMP6 = 1000Hz @ 75% Duty Cycle Complementary Asymmetric PWM's

Tl period .set 30303 ;1000 Hz PWM @ 33ns Clock

Tl _compare .set 3030 ;10% Duty Cycle @ 1000 Hz PWM

Full CMPR1 .set 3030 ; Full Compare #1 value for 10% @ 1000Hz
Full CMPR2 .set 15151 ; Full Compare #2 value for 50% @ 1000Hz
Full CMPR3 .set 22727 ; Full Compare #3 value for 75% @ 1000Hz

; Labé - End Labé additions

; Filter function external reference and Symbolic constants
.ref FIRFILT ORD20_calc
FIR ORDER20 .set 20

; Create an Instance of FIRFILT ORD20 module and place the object in "firfilt" section
1pf .usect "firfilt",FIRFILTioRD207LEN,1
1pf .tag FIRFILT ORD20 ;jAssign the FIRFILT ORD20 structure
;properties to the
;alloted memory locations

.include "c200mnrt.i" ; Include conditional assembly options.

.sect "vectors"

.def _c_into
RESET B _c_into ;00
INT1 B PHANTOM ;02
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INT2 B PHANTOM ;04
INT3 B T2 PERIOD_ ISR ;06
INT4 B PHANTOM ;08
INTS B PHANTOM ; OA
INT6 B PHANTOM ;0C
.include "rtvecs.h"

; Note : The above include line must be AFTER the user configurable
; vectors. Do not change the place where this line is included.

; MAIN C ODE - starts here

CALL SYS INIT

.if x2407

POINT_PF1 ;Load DP with the Periperal Frame 1 page no

SPLK #SCSR1_REG _VALUE,SCSR1 ;PLL MF=4, EVA&ADC Enable, clear illegal addr bit
CALL PWM_DAC_DRV_INIT

.endif

CALL  DAC_VIEW DRV_INIT

CALL DATA LOG_INIT

CALL ADC04U_DRV_INIT

; Copy the Coefficients from LOAD address to Run Address
CALL FIRCOEFF_COPY ROM2RAM

; Filter Initialisation

LDP #1pf

SPLK #FIR LPF20 coeff ptr,lpf.coeff ptr ;Select Lowpass
; SPLK #FIR _HPF20_coeff ptr,lpf.coeff ptr ;Select Highpass
i SPLK #FIR_BPF20_coeff ptr,lpf.coeff ptr ;Select Bandpass
i SPLK #FIR BSF20 coeff ptr,lpf.coeff ptr ;Select BandStop

SPLK #lpf.dbuffer,lpf.dbuffer ptr

SPLK #FIR_ORDER20, lpf.order

MAR *,AR1

SPLK #1pf, *+ ; Store the address of the instanced filter structure

CALL FIRFILT LIN INIT ;Call the Linear buffer FIR filter Init routine clear
;the delay buffer

MAR * -

;j---Real Time option---------------
.if (REAL _TIME)
CALL MON_RT_CNFG ;jFor Real-Time
.endif

LDP #DAC_IPTRO

; Assign the Address of 'xn' variable to DAC_iptro0
SPLK #xn,DAC_IPTRO

; Assign the Address of 'yn' variable to DAC_iptr0
SPLK #yn,DAC_IPTR1

LDP #dlog iptrl

; Assign the Address of 'xn' variable to dlog iptril
SPLK #xn,dlog_iptrl

; Assign the Address of 'yn' variable to dlog iptr2
SPLK #yn,dlog iptr2
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; Trigger Value =0
SPLK #0800h, trig value

.1f x2407
LDP #PWM_DAC_IPTRO

; Assign the Address of 'xn' variable to PWM_DAC_IPTRO
SPLK #xn, PWM_DAC_IPTRO

; Assign the Address of 'yn' variable to PWM_DAC_ IPTR1

SPLK #yn, PWM_DAC_IPTRI1
.endif

ldp #A4_ch_sel
SPLK #00000h, A4 ch sel ; Select CHO all the 4 ADC module input
SPLK #1FFFh, Cl _gain ;jgain = 1.0 (Q13)
SPLK #1FFFh, C2_gain ;jgain = 1.0 (Q13)
SPLK #1FFFh, C3_gain ;gain = 1.0 (Q13)
SPLK #1FFFh, C4 _gain ;gain = 1.0 (Q13)

;Lab6 Setup PWM Outputs
CALL PWM_INIT

; Initialise the Timer 2 to generate 20Khz interrupt burst

; and configure the interrupt levels to accept the timer interrupt
CALL TIME BASE INIT
CALL INT INIT

EINT ;Enable global Ints
; Infinite loop
main loop:
B main loop
; Initialise the Interrupt INT_INIT
INT_INIT:
POINT EV
.1f x2407
SPLK #00004h, EVAIMRB ;Enable T2 UF interrupt
.endif
Lif x243
SPLK #0004h, EVIMRB ;Enable T2 UF interrupt
.endif
;C2xx Core
POINT_ PGO
;---Real Time option -------------c-c oo

.if (REAL TIME)
SPLK #0000000001000100b, IMR ;En Int 1vl 3,7 (T2 ISR)

. | !
H : :
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;54321098765
.endif

.if (REAL TIME != 1)

43210

SPLK #0000000000000100b, IMR ;En Int 1vl 3 (T2 ISR)

. e
; LR

75432109876543210

.endif
SPLK #O0FFFFh, IFR
RET

;Clear any pending Ints

TIME_BASE INIT:
; Timer 2 Configuration

; Timer Prescalar= x1

; Counting Mode: Continuous up counting mode
; Clock Source: Internal Clock source

; Reload Condition: When Counter 0

; Enable the Timer

; Operation not affected by Emulation suspend

POINT EV

SPLK #09040h, T2CON

SPLK #SYSTEM_INT PERIOD, T2PER
RET

;Setup GP Timerl for Full Compare PWM outputs on CMP1-CMP6
;Setup T1CMP and T2CMP PWM outputs

LDP #OCRA>>7 ;set data page
SPLK #0011111111000011b, OCRA
* NARRRRRRRRRAENE
* FEDCBA9876543210
* bit 15 0: 0=I0PB7, 1=TCLKIN
* bit 14 0: 0=I0PB6, 1=TDIR
* bit 13 1: 0=IOPB5, 1=T2PWM/T2CMP ;Turn On all PWM's
* bit 12 1: 0=IOPB4, 1=T1PWM/T1CMP ;
* bit 11 1: 0=IOPB3, 1=PWM6 ;
* bit 10 1: 0=I0OPB2, 1=PWM5 ;
* bit 9 1: 0=IOPB1l, 1=PWM4 ;
* bit 8 1: 0=IOPBO, 1=PWM3 ;
* bit 7 1: 0=IOPA7, 1=PWM2 ;
* bit 6 1: 0=I0OPA6, 1=PWM1 ;
* bit 5 0: 0=I0OPA5, 1=CAP3
* bit 4 0: 0=I0PA4, 1=CAP2/QEP1
* bit 3 0: 0=IO0PA3, 1=CAP1/QEPO
* bit 2 0: 0=I0PA2, 1=XINT1
* bit 1 1: 0=I0PAl, 1=SCIRXD
* bit 0 1: 0=IOPAO, 1=SCITXD
POINT_EV ;set data page
SPLK #0000000001000101b, GPTCON ;init GPTCON register
* NARRRRRRRARAENE
* FEDCBA9876543210
* bit 15 0: reserved
* bit 14 0: T2STAT - read only
* bit 13 0: T1STAT - read only
* bit 12-11 00: reserved
* bit 10-9 10: T2TOADC, 00 = no ADCSOC
* bit 8-7 00: T1TOADC, 00 = no ADCSOC
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* bit 6 1: 1 = enable all timer compare outputs
* bit 5-4 00: reserved
* bit 3-2 01: 01 = T2PIN Active HIGH
* bit 1-0 01: 01 = T1PIN Active low
SPLK #0001000000000010b, T1CON ;init T1CON register
* [LLTEEEETTEEE T
* FEDCBA9876543210
* bit 15-14 00: stop immediately on emulator suspend
* bit 13 0: reserved
* bit 12-11 10: 10 = continous-up count mode ;ASymmetric PWM
* bit 10-8 000: 000 = x/1 prescaler
* bit 7 0: 0 = Reserved in T1CON
* bit 6 0: 0 = disable timer ;Keep Timer Off for now
* bit 5-4 00: 00 = CPUCLK is clock source
* bit 3-2 00: 00 = reload compare reg on underflow
* bit 1 1: 1 = enable timer compare
* bit 0 0: 0 = Reserved in T1CON
SPLK #1000001000000000b, COMCON ;init COMCON register
* RERRNRRARRRRNS
* FEDCBA9876543210
* bit 15 1: 1 = Enable Compare Operation
* bit 14-13 00: 00 = reload compare reg on underflow
* bit 12 0: 0= Disable Space Vector
* bit 11-10 00: 00= Reload Action Control Register on Underflow
* bit 9 1: 1 = Full Compare Outputs Enabled
* bit 8-0 00000000: Reserved
SPLK #0000100110011001b, ACTR ;init ACTR register
* [LLTEEEETTEEE T
* FEDCBA9876543210
* bit 15 0: Ignore if not using Space Vector
* bit 14-12 000: Ignore if not using Space Vector
* bit 11-10 10: 10= Output pin CMP6 Active High
* bit 9-8 01: 01= Output pin CMP5 Active Low
* bit 7-6 10: 10= Output pin CMP4 Active High
* bit 5-4 01: 01= Output pin CMP3 Active Low
* bit 3-2 10: 10= Output pin CMP2 Active High
* bit 1-0 01: 01= Output pin CMP1l Active Low

POINT_EV ;set data page

SPLK #T1 period, T1PER ;set timerl period

SPLK #T1 compare, T1CMP ;Set Timerl for chosen Duty Cycle
SPLK #Full_ CMPR1,CMPR1 ;Set Full Compare #1 compare value
SPLK #Full_ CMPR2, CMPR2 ;Set Full Compare #2 compare value
SPLK #Full CMPR3,CMPR3 ;Set Full Compare #3 compare value
SPLK #0000h, TI1CNT ;clear timerl counter

LACL T1CON

OR #0040h

SACL T1CON ;Set Bit #6 of T1CON to Start Counter
; Lab6 - End Labé additions

; Routine Name: T1l PERIOD ISR Routine Type:

; Description:

; Originator: Digital control systems Group - Texas Instruments

ISR
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; History:

; Last Update: 20-Dec 00

T2 PERIOD ISR:
;Context save regs

MAR * , AR1 ;AR1 is stack pointer
MAR * 4 ;skip one position
SST #1,*+ ;save ST1

SST #0O, *+ ;save STO

SACH * 4 ;save acc high

SACL * 4 ;save acc low

;NOTE: should use "read-modify-write" to clear Int flags & not SPLK!
POINT EV
.1f x2407
SPLK #0FFFFh, EVAIFRB ;Clear all Group B interrupt flags (T2 ISR)
.endif

Lif x243
SPLK #0FFFFh, EVIFRB ;Clear all Group B interrupt flags (T2 ISR)

.endif

CALL ADCO04U_DRV

LDP #xn

BLDD #C1 _out,xn ;Get the latest sample
LACC xn ;ACC=xn (Q15 unipolar)
XOR #4000h

SACL xn, 1 ;Bipolar Q15

LDP #1lpf ;Store the input

BLDD #xn, 1pf.input

; Filter
SPM #0
MAR *,AR1
SPLK #1lpf, *+
CALL FIRFILT ORD20 calc
MAR * -
LDP #yn
BLDD #1lpf.output, yn
CALL DAC_VIEW_ DRV ;Update sx&sy in EVMDAC CHO & 1 respectively
CALL DATA LOG ;Update the data log module
.1f x2407
CALL PWM_DAC_DRV
.endif
MAR *, AR1 ;make stack pointer active
SBRK #1
LACL * - ;Restore Acc low
ADDH * - ;Restore Acc high
LST #0, *- ;load STO
LST #1, *- ;load ST1
EINT
RET
; I S R - PHANTOM

; Description: Dummy ISR, used to trap spurious interrupts.
; Modifies:

; Last Update: 12-29-00
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PHANTOM1
PHANTOM2
PHANTOM3
PHANTOM4
PHANTOM5
PHANTOM6

Wwwwwww

PHANTOM

PHANTOM1
PHANTOM2
PHANTOM3
PHANTOM4
PHANTOM5
PHANTOM6
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FIR20A.ASM

; File Name: fir20a.asm

; Originator:

; Texas Instruments
; Description: This file contain
i

; Date 13/1/2001

; Routine Name

; Routine Type C Callable

; Description :

Digital Control Systems Group

source code for 20th order (FIXED ORDER) Filter

Generic Function

; void FIRFILT_ORD20_calc (FIRFILT ORD20_handle)
; void FIRFILT ORD20_ calc(FIRFILT ORD20S handle)

; This routine implements the non-recursive difference equation of an
All the coefficients of all-zero

; all-zero filter (FIR), of order 20.
; filter are assumed to be less than 1 in magnitude.

; Difference Equation

; y(n)=H(0) *x(n)+H (1) *x(n-1) +H(2) *x(n-2) +....+H(20) *x (n-20)

; where

; y (n) =output sample of the filter at index n

; x (n) =input sample of the filter at index n

; Transfer Function

i Y (z) -1 -2 -19 -20
e = h(0) + h(1l) z + h(2) z + +h(19) z + h(20) z
; X(z)

; Network Diagram

; dbuffer[0] dbuffer[1] dbuffer[2] dbuffer[20}

; Input -1 x(n-1) -1 x(n-2) x (n-20)

; x(n) >------ O----Z---->-0----Z---->-0--- - =->- - O

; | | | |

; | | | |

; | | | |

; v H(0) v H(1) v H(2) v H(20)

; | | | |

i | | | | output
i [---->----- (#)====>----(#)-- - -> - (+)----- > y(n)

i Symbols Used

i H(0),H(1),H(2),...,H(20) filter coefficients

; x(n-1),x(n-2),...,x(n-20) filter states

; x (n) filter input

; y(n) filter output

;  Function Input: This function

;  typedef struct

; {int *coeff ptr;

; int *dbuffer ptr;
; int order;

; int input;

; int output;

; int dbuffer[11];

; int coeff[11];

/*
/*
/*
/*
/*
/*
/*

accepts the handle of the below structure

Pointer to Filter co-efficient array */
Delay buffer pointer */

Order of the filter */

Input data */

Output data */

Delay buffer */

Coefficient Buffer */
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Module 6 Lab: Digital Filter Basics

i void (*init) (void *)

/* Pointer to init fun */

; void (*calc) (void *); /* Pointer to the calculation function */
; }FIRFILT ORD20;

;  Filter input (x)

i x(n) = | s.££f £fff | £££f ffff |

; Filter coefficients(hl]):
; h(k) for k=0,1,2,...,20

; = | s.fff ffff | ffff ffff |

LOWER MEMORY ADDRESS

are stored as shown below.

; H(0)

i H(1) x(n-1) dbuffer[1]

N ettt A e bt |
; H(2) x(n-2) dbuffer[0]

i e e |
; |
; |
H [-=-= -] e \
; H(18) x(n-18) |
i e e |
i H(19) x(n-19) dbuffer[18] v
; AR3----- >| H(20) | |  x(n-20) | dbuffer[19] <--- AR4

; filter coefficients filter states
; HIGHER MEMORY ADDRESS
; Implicit inputs(dbuffer([]):

; To compute the present output y(n), inputs x(n-i) for i=1,2,...20
; are needed. These are stored in the filter states buffer, as shown
; above.

; Filter order (n):
; This member of the structure holds the order of the filter

; Filter output(y):
i y(n)= | s.f£ff ££f£ff | ffff ££ff | Q15 Format

(FP+1) <---AR1
(FP) <---ARO
|<- o0la FP (FP-1)
(
(

|
| |<- Sstack Pointer
; | |<- Register to Register Tfr & Computation
|
|

| <- Return Address of the Caller
|<- Formal parameter FIRFILT GEN handle

; Symbolic Constant
ORDER .set 20

; Module definition for external referance
.def  FIRFILT ORD20 calc

__fir calc frs .set 00001h ; Local frame size for this routine
FIRFILT ORD20 calc:
POPD * 4 ; Store the Return Address in stack
SAR ARO, *+ ; Store the Caller's Frame Pointer
SAR AR1, *
LAR AR2, *+,AR2 ; ARP=AR2, AR2=FP, AR1=FP+1
SETC SXM

SETC OVM
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Module 6 Lab: Digital Filter Basics

SBRK #3 ;ARP=AR2, AR2=FP-3 points to the input argument
LAR AR2, * ;ARP=AR2, AR2=FIRFILT GEN handle->coeff ptr

LAR AR3,*+ ;ARP=AR2, AR2->dbuffer ptr, AR3=coeff ptr->coeff [N]
LAR AR4,*+ ;ARP=AR2, AR2->order, AR4=dbuffer ptr->dbuffer[N-1]
MAR *+,AR4 ;ARP=AR4, AR4=dbuffer ptr->dbuffer[N-1], AR2->input
LACL #0 ;Clear ACC

LT *-,AR3 ;ARP=AR3, TREG=dbuffer[N-1], AR4->dbuffer[N-2]
.loop (ORDER-1)

MPY *-,AR4 ;Filter Tap execution from oldest sample

LTD *-,AR3

.endloop

MPY *-,AR2 ; ARP=AR2, AR2->input

LTA *+,AR3 ; ARP=AR3, AR2->output

MPY *,AR2

APAC

SACH * ;32 bit of ACC is added with itself to get Q31 result
ADDH *

SACL *

ADDS * ;ARP=AR2, AR2->output

ADD #1,15 ;Round the result

SACH * - ;ARP=AR2, AR2->input, Store ACCH in Q15 format
LACL * ,AR4

MAR * 4

SACL *,0,AR1 ;Store the latest sample in the delay buffer
CLRC OVM

SBRK #(__fir calc_frs+l) ;jClear the local frame

LAR ARO, *- ;Retrive Caller's frame pointer

PSHD * ;Push the return address to TOS

RET ;Return to the caller
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FIRCOEFF.ASM

; File name: FIRCOEFF .ASM

; Originator: Digital Control Systems Group

; Texas Instruments

; Description:

; This file contains Filter coefficients and the initialisation routine

; History:

;Header file containing FIR Filter coefficients to initialise the coefficient array.
;4 coefficient sets for Order 50, 20, & 10 are available for demo, user can expand it
;using ezFIR script

; Include firsel.h header file
.include firsel.h

; External declaration to copy the FIR coeff from ROM to RAM
.def FIRCOEFF_COPY_ROM2RAM

; FIRCOEFF_COPY ROM2RAM routine that copies the filter coefficients from ROM to RAM

FIRCOEFF_COPY_ ROM2RAM:

.text

LAR AR2, #coeff RUN start adr

LACC #coeff LOAD_start_adr

MAR *,AR2

LAR AR3, #(coeff LOAD end adr-coeff LOAD start adr-1)
loop: TBLR *+,AR3

ADD #1

BANZ loop, *-,AR2

RET

.sect "fircoeff"

.label coeff LOAD start_adr ;Load Address of the section
jcoeff RUN start adr
;Run Address of the section

,-********************************************************

; 50th Order Filter

,-********************************************************

.if FIR_LPF50
FIR _LPF50_coeff ptr .word -34,-22,13,50,55,-1,-91,-137,-56,131
.word 276,198,-127,-471,-481,0,690,976,384,-896
.word -1905,-1447,1040,4892,8415,9839,8415,4892,1040,-1447
.word -1905,-896,384,976,690,0,-481,-471,-127,198
.word 276,131,-56,-137,-91,-1,55,50,13,-22
.word -34
.endif

.if FIR_HPF50
FIR _HPF50 coeff ptr .word 0,34,25,-32,-65,-1,106,83,-106,-214
.word 0,321,240,-291,-565,-1,810,602,-730,-1447
.word 0,2337,1976,-3019,-9877,19646,-9877,-3019,1976,2337
.word 0,-1447,-730,602,810,-1,-565,-291,240,321
.word 0,-214,-106,83,106,-1,-65,-32,25,34
.word O
.endif

Lif FIR BPF50

FIR BPF50 coeff ptr .word 0,69,-1,-63,0,-1,-1,167,-1,-427
.word 0,642,-1,-581,-1,-1,0,1203,-1,-2890
.word 0,4670,-1,-6033,-1,6543,-1,-6033,-1,4670
.word 0,-2890,-1,1203,0,-1,-1,-581,-1,642
.word 0,-427,-1,167,-1,-1,0,-63,-1,69
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Module 6 Lab: Digital Filter Basics

FIR BSF50_coeff ptr

.word 0
.endif

.if FIR_BSF50

.word -1,-70,0,62,-1,-1,0,-169,0,427

.word 0,-645,-1,582,0,-1,0,-1208,0,2900
.word 0,-4688,0,6054,0,26267,0,6054,0,-4688
.word 0,2900,0,-1208,0,-1,0,582,-1,-645
.word 0,427,0,-169,0,-1,-1,62,0,-70

.word -1

.endif

,-********************************************************

; 20th Order Filter

,-********************************************************

; Coeff's for 3000Hz Corner Freqg 20th Order LowPass Filter

FIR _LPF20_ coeff ptr

.if FIR_LPF20

.word 0,95,207,123,-406,-1125,-1044,869,4517,8236
.word 9815,8236,4517,869,-1044,-1125,-406,123,207,95
.word 0

.endif

; Coeff's for 4000Hz Corner Freq 20th Order HighPass Filter

FIR HPF20_coeff ptr

.if FIR_HPF20

.word -1,113,128,-237,-659,0,1694,1658,-2801,-9711
.word 19689,-9711,-2801,1658,1694,0,-659,-237,128,113
.word -1

.endif

; Coeff's for 4000Hz-6000Hz Corner Freq 20th BandPass Filter

FIR BPF20_ coeff ptr

.if FIR_BPF20

.word -1,0,304,-1,-1560,0,4009,-1,-6628,-1
.word 7766,-1,-6628,-1,4009,0,-1560,-1,304,0
.word -1

.endif

; Coeff's for 4000Hz-6000Hz Corner Freq 20th BandStop Filter

FIR BSF20 coeff ptr

.if FIR_BSF20

.word -1,0,-258,0,1316,0,-3386,0,5595,0
.word 26229,0,5595,0,-3386,0,1316,0,-258,0
.word -1

.endif

,-********************************************************

; 10th Order Filter

,-********************************************************

FIR LPF10_coeff ptr

FIR HPF10_coeff ptr

FIR BPF10_coeff ptr

FIR BSF10 coeff ptr

Lif FIR LPF10

.word -171,-264,437,3464,7882,10067,7882,3464,437,-264
.word -171

.endif

Lif FIR HPF10

.word 0,416,812,-2091,-9045,19652,-9045,-2091,812,416
.word 0

.endif

.if FIR_BPF10

.word 0,1645,-1,-8264,-1,12949,-1,-8264,-1,1645
.word O

.endif

.if FIR_BSF10

.word 0,-829,0,4163,0,26098,0,4163,0,-829
.word O

.endif

.label coeff LOAD end adr
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What's Next

Learning Objectives

Recap / What's Next

¢ Great!! You havethebasicsof a

DSP Control System
« Signal capture-digital control-output generation

¢ Beyond the eZdsp™: What are you going to do NOW!!
« Softwar e development tools
+ Hardware development tools
« Additional training
+ Web Resources
« Third Party Resources
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Module Topics

Module Topics
WWVN@E SINEXE ...ttt sttt sttt b et b e s b et ekt s b et e bt s b et e b e sb et et e st et ebesee e ebeneeeas 7-1
1Y/ 1a T LU =N o o= O 7-2
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Development Support

Development Support

Code Generation & Programming

¢ Code Generation Tools, v7.0
+ Highly efficient C-Compiler/Assembler/Linker
« ANSI C source code compliant.
+ Variety of optimizationsfor improved code efficiency.

« Includesarchiver, hex conversion and cross refer ence
utilities, and absolutelister.

& Flash Programming Utilities
« Support for JTAG and Serial Port flash programming.

« LF240x & F240/241/243 utilities available today with free
WEB download:

http://www.ti.com/sc/docs/tools/dsp/c2000/softwar e.htm#C2000

Code Composer 4.12
Offers Real-time Monitor and Plug-in Capabilities
¢ New interface style
¢ C2000 Code Gen Toolsincluded
¢  Command window plug-in
&  C24x rea-time debugging:
+ Halt the application and till handle

Heb
& |9 o |[counTERT JEAAR SR S OK )

interrupts; ability to update graphs,
watch and memory windows,
without halting the processor

+ Single-stepping of background code
while ISR’s continue to run in real-
¢ I time
= ke ] V + Tuning of system parameters, e.g.
PID loops, Motors char, etc.
+ Software switches to control/invoke
motor wind-down sequence

EORTE T - 7%
SUEDTE RATE = 7
ACOMVTER: = 1082

m=mi e Dragand drop setup program

¢  Emulation and simulation drivers
include

¢  BIOS supported on C28x
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Development Support

Recommended Next Step:
DM C Software M odules

Module Description Type
FC_PWM_DRV Full Compare PWM driver with dead-band control Driver
CAP_EVT_DRV Capture input event driver with 16 bit time stamps Driver
QEP_THETA_DRV Quadrature Encoder Pulse interface driver for position Driver
ILEG2_DRV Inverter leg based 3 phase current measurement Driver
ADCO04 DRV General purpose 4 conversion ADC driver with gain control Driver
BLDC_PWM_DRV BLDC PWM driver — uses High side chopping Driver
VHz_PROF Volts/ Hertz profile for ACI (Voltage vs Frequency) TI/AC
CLARK Clark transform — 3 phase to 2 phase (quadrature) conversion TI /Al
CLARK | Inverse Clark transform — 2 phase to 3 phase conversion TI /Al
PARK Park Transform — Stationary to Rotating reference frame conv. TI /Al
PARK_I Inverse Park Transform — Rotating to Stationary reference frame TI /Al
PMSM_SMO PMSM Sliding mode observer for position estimation TI/AC
AClI_MRAS Model Reference Adaptive System speed estimator TI/AC

Many mor e softwar e modules ar e available at
http://iwww.ti.com/sc/dmcsoftwar e

Note: Driver = Peripheral dependent driver
TI/AC = Target independent / Application configurable
TI/Al = Target independent / Application independent

Recommended Next Step:
DM C Softwar e Systems

System Motor Type Description
ACI1-1 |1 phAC induction Sensored — Tacho i/p
VHz/ SinePWM / Closed loop (CL) speed PID
ACI3-1 |3 phAC induction Sensored — Tacho i/p
VHz/ SVPWM / Closed loop speed PID
ACI3-2 |3 phAC induction Sensorless— MRAS (speed estimator)
VHz/ SVPWM / Closed loop speed PID
ACI3-3 |3 phAC induction Sensored — Tacho i/p
FOC / SVPWM / Closed loop current PID for D,Q / CL
speed PID
ACI3-4 |3phAC induction Sensorless — Direct Flux estimator + speed estimator
FOC / SVPWM / Closed loop current PID for D,Q / CL
speed PID
ACI3-5 |3 phAC induction Sensorless — Direct Torque Control (DTC)

Modified SVPWM / Closed loop current / CL speed
PM SM 3- | 3 Ph Permanent M agnet | Sensored - QEP
1

Synch FOC / SVPWM / Closed loop current PID for D,Q /CL
speed PID
PM SM 3- | 3 Ph Permanent M agnet | Sensorless — SM O (Sliding mode observer) position
2 Synch estimator
FOC / SVPWM / Closed loop current PID for D,Q / CL
speed PID
BLDC3-1 |3 ph Trapezoidal Sensored — 3 Hall effect i/p
BrushlesDC Trapezoidal / Closed loop current PID / CL Speed PID
BLDC3-2 | 3 ph Trapezoidal Sensorless— BEMF / Zero crossing detection
BrushlesDC Trapezoidal / Closed loop current PID / CL Speed PID
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Recommended Next Step:
System example4: ACI FOC Sensorless
“ACI3-4"

spd_ref | PID PWM1
—* REG

" REG I_PARK SEEN N

—»
S e[S |§
REG

PARK —

3
Phase
Inv.

=

VOLTAGE s
CALC
¢
- [ * ADCinx
DRV

thetal ———1¢ (

ACI_SE ACI_FE

ADCinx

Motor

Direct Rotor Flux estimator method

Recommended Next Step:
C2000 Evaluation M odules

C2000 Evaluation Modules
include:

m C2000 Evaluation Board
m Code Generation Tools

m Code Composer Debugger
m XDS510PP+ Emulator

m Universal Power Supply

= Documentation & cables

Everything you need to develop your own
L F240x DSP motor control based algorithms!
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Recommended Next Step:
4-day Training Course

Learn the L F2407 Evaluation Module

In-depth C240x Core
and Peripheral Training

http://www.ti.com/sc/docg/training/training.htm

| G Digital Motor Control at Toxas Instrumonts - Microsoft Intornot Explorer

Recommended Next Step:
Explorethe Web

N -
Back. Ironward

4, =] =

Fullscre. Mail Print Ec

1 ¥
Stop  Refresh  Home Search Favortes History Channels

Address [&] htp:/iwww.ti.com/sc/control || Links

R Texas INSTRUMENTS

THE WORLD LEADER IN DSP AND ANALOG

searcH [ | [Fremvememn 5] @  svvnceoseanen

Control

> Ovorviow

> C28x DSP Core

> 'C2dx Product List
> 'Codx Peripheral
Eeatures

>DMC Applications
> Application Dosign Kits
> Development Tools
> Third Penlies

> Technical Training
> News Releases

> Didital lnnovations
Hotne:

]

Herucanductor Hame > Apphieations

> Newl eXpressDSP for
Iviotar

TEGH SUPPORT KNOWLEDGEBASE MYWORKSPACE TI&ME

Digital Motor Control Overview

www.ti.com/sc/control

The World's First Open DSP Software Platform for
Motor Control

TI introduces the industry’s first and only open 1=
I

[ B e ane
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Development Support

Material Available
For Web Download

Type Number Description—",
Available
Application 60 Variety of topics including ACI,
Notes BLDC, PMSM, SR Motors, and
CPU/Peripheral reference guides.
Application 5 Full system designs, including
Design Kits software, technical documentation,
(ADK) and schematics (sLbc, PMSM, ACI, UPS,
SRM)
Software 15 Segmented ‘packages’ of source
Library code for functions such as ramp

generators, sine and cosine
generators, and current sampling.

Flash 5 Flash programming software for
Programming F240, F241/F243, LF24xx (parallel
Utilities and serial).

Large Third Party Network

Spectrum

Digital
¥ [EsorrroNcs:

Oztek

Drivetec, Inc.

Corp

8°
Q“' ‘ Intern , -
? Recnfl or Motion Control Specialists

SCHMIDHAUSER AG

Leader in M

Visual Solutions m
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Module Topics
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Appendix

eZdsp™ LF2407

eZdsp™ LF2407 Connector / Header and Pin Diagram
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Table 1: EZdSpTM LF2407 Connectors

Connector Function
P1/P7 Analog Interface
P2/P8 I/O Interface

P3 Power Connector
P6 I/O Expansion
Connector
F9 Farallel Port/JTAG
Controller Interface
P10 JTAG Interface
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P1/P7 - Analog Interface

ANALOG
P7|1]12 | 3] 4|5]|6 |7]|8]|9]10
214168 [10([12]|14 |16 | 18] 20
113|579 1113151719

P1

-

Table 2: P1, Analog Interface Connector

Pin # Signal Pin # Signal
1 GND 2 ADCINO
3 GND 4 ADCIN1
5 GND ] ADCINZ
7 GND 8 ADCIN3
9 GND 10 ADCIN4
11 GND 12 ADCINS
13 GND 14 ADCING
15 GND 16 ADCIN7Y
17 GND 18 VREFLO
19 GND 20 VREFHI

Table 3: P7, Analog Interface Connector

Pin# Signal

ADCINS
ADCINS
ADCIN10
ADCINT1
ADCIN12
ADCIN13
ADCIN14
ADCIN1S
RESERVED
RESERVED

wlo|w|lo|lo|ls|lw|n]=

-
=
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P2/ P8 — I/O Interface

o]
2]3 5(6]7| 8| 9(10[11|12{13]|14 |15|16 |17|18|19]|20| P8
2] 4|86 10112 14|16 | 18|20 (22| 24| 26{28 | 30| 32| 34| 36| 38|40 p2
O 1 5 11|13 15|17 |19 |21| 23| 25| 27| 29| 31| 33| 35|37 39
Table 4: P2, I/O Interface Connector Table 5: P8, /O Interface Connector
Pin # Signal Pin # Signal Pin # Signal
! +5V 2 +5V/ 1 +5V
3 SCITXD/IOPAQ 4 SCIRXD/IOPA1 2 XINT2-/ADCSOC/
5 XINT1-/IOPA2 6 CAP1/QEP1/IOPA3 1oPDo
7 CAP2/QEP2/IOPA4 8 CAP3/IOPA5 3 EMUO/IOPD1
9 PWM1/IOPAB 10 PWM2/IOPA7 4 EMU1/IOPD2
11 PWM3/I0PBO 12 PWM4/IOPB1 5 TCK/IOPD3
13 PWMS/IOPB2 14 PWM6/IOPB3 6 TDIIOPD4
15 | TIPWM/ITICMP/IOPB4 | 16 | T2PWM/T2CMP/IOPBS 7 TDO/IOPDS
17 TDIRA/IOPB6 18 TCLKINA/IOPB7 8 TMS/IOPDG
19 GND 20 GND 9 TMS2/I0PD7
21 WNR/IOPCO 22 BIO-/IOPCA 10 GND
23 SPISIMO/IOPC2 24 SPISOMI/IOPC3 1 CAPSIQEP4/IOPFO
25 SPICLK/IOPC4 26 SPISTE/IOPC5 12 CAPG/IOPH1
27 CANTX/IOPCE o8 CANRXIOPCT 13 | T3PWM/T3CMP/IOPF2
29 CLKOUT/IOPEO 30 PWM7/IOPEA 14 | TAPWM/T4CMP/IOPF3
31 PWMS/IOPE2 32 PWM9/IOPE3 13 TDIRB/IOPF4
33 PWM10/IOPE4 24 WM 1/IOPES 16 TCLKINB/IOPF5
35 PWM12/I0PE6 36 CAP4/QEP3/IOPE7 7 IOPF6
37 PDPINTA- 38 CDPINTE. 18 RESERVED
39 GND 40 GND 19 RESERVED
20 GND
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P6 — Expansion Interface

o e

18] 20]22] 24| 26] 28] 30| 3 34 36| 38]40]42) 44| 46[48]50
15[1719| 21 23 25] 27129| 31| 33|35 3941)|43] 45|47]49
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Table 6: P6, Expansion Interface Connector

Pin # Signal Pin # Signal
1 +5V 2 +5V
3 Do 4 D1
5 D2 6 D3
7 D4 8 D5
9 D6 10 D7

11 D8 12 D9

13 D10 14 D11

15 D12 16 D13

17 D14 18 D15

19 AD 20 A1l

21 A2 22 A3

23 Ad 24 A5

25 AB 26 AT

27 AB 28 A9

29 A10 30 Al1

31 A12 32 A13

33 A14 34 A15

35 GND 36 GND

37 PS- 38 DS-

39 READY 40 |5-

41 R/W- 42 STRB-
43 WE- 44 RD-

45 3.3V 46 RESERVED
47 RS-* 48 RESERVED
49 GND 50 GND
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F2407.h
o |

;Filename: £2407.h
;Last Modified: 10/24/00 |
;Description: LF2407 DSP register definitions

;Core registers

IMR .set 0004h ; Interrupt mask reg
GREG .set 0005h ;Global memory allocation reg
IFR .set 0006h ;Interrupt flag reg

;System configuration and interrupt registers

PIRQRO .set 7010h ;Peripheral interrupt request reg 0
PIRQR1 .set 7011h ;Peripheral interrupt request reg 1
PIRQR2 .set 7012h ;Peripheral interrupt request reg 2
PIACKRO .set 7014h ;Peripheral interrupt acknowledge reg 0
PIACKR1 .set 7015h ;Peripheral interrupt acknowledge reg 1
PTIACKR2 .set 7016h ;Peripheral interrupt acknowledge reg 2
SCSR1 .set 7018h ;System control & status reg 1

SCSR2 .set 701%h ;System control & status reg 2

DINR .set 701Ch ;Device identification reg

PIVR .set 701Eh ;Peripheral interrupt vector reg

;Watchdog timer (WD) registers

WDCNTR .set 7023h ;WD counter reg
WDKEY .set 7025h ;WD reset key reg
WDCR .set 702%h ;WD timer control reg

;Serial Peripheral Interface (SPI) registers

SPICCR .set 7040h ;SPI configuration control reg
SPICTL .set 7041h ;SPI operation control reg
SPISTS .set 7042h ;SPI status reg

SPIBRR .set 7044h ;SPI baud rate reg

SPIRXEMU .set 7046h ;SPI emulation buffer reg
SPIRXBUF .set 7047h ;SPI serial receive buffer reg
SPITXBUF .set 7048h ;SPI serial transmit buffer reg
SPIDAT .set 704%9h ;SPI serial data reg

SPIPRI .set 704Fh ;SPI priority control reg

;SCI registers

SCICCR .set 7050h ;SCI communication control reg
SCICTL1 .set 7051h ;SCI control reg 1

SCIHBAUD .set 7052h ;SCI baud-select reg, high bits
SCILBAUD .set 7053h ;SCI baud-select reg, low bits
SCICTL2 .set 7054h ;SCI control reg 2

SCIRXST .set 7055h ;SCI receiver status reg
SCIRXEMU .set 7056h ;SCI emulation data buffer reg
SCIRXBUF .set 7057h ;SCI receiver data buffer reg
SCITXBUF .set 7059h ;SCI transmit data buffer reg
SCIPRI .set 705Fh ;SCI priority control reg

;External interrupt configuration registers
XINT1CR .set 7070h ;Ext interrupt 1 config reg
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XINT2CR .set 7071h ;Ext interrupt 2 config reg

;Digital I/O registers

MCRA .set 7090h ;I/0 mux control reg A
MCRB .set 7092h ;I/0 mux control reg B
MCRC .set 7094h ;I/0 mux control reg C
PADATDIR .set 7098h ;I/0 port A data & dir reg
PBDATDIR .set 709Ah ;I/0 port B data & dir reg
PCDATDIR .set 709Ch ;I/0 port C data & dir reg
PDDATDIR .set 709Eh ;I/0 port D data & dir reg
PEDATDIR .set 7095h ;I/0 port E data & dir reg
PFDATDIR .set 7096h ;I/0 port F data & dir reg

;Analog-to-Digital Converter (ADC) registers

ADCTRL1 .set 70A0h ;ADC control reg 1

ADCTRL2 .set 70Alh ;ADC control reg 2

MAX CONV .set 70A2h ;jMaximum conversion channels reg
CHSELSEQ1 .set 70A3h ;Channel select sequencing cntrl reg 1
CHSELSEQ2 .set 70A4h ;Channel select sequencing cntrl reg 2
CHSELSEQ3 .set 70A5h ;Channel select sequencing cntrl reg 3
CHSELSEQ4 .set 70A6h ;Channel select sequencing cntrl reg 4
AUTO_SEQ SR .set 70A7h ;Autosequence status reg

RESULTO .set 70A8h ;Conversion result buffer reg 0
RESULT1 .set 70A%h ;Conversion result buffer reg 1
RESULT2 .set 70AAh ;Conversion result buffer reg 2
RESULT3 .set 70ABh ;Conversion result buffer reg 3
RESULT4 .set 70ACh ;Conversion result buffer reg 4
RESULT5 .set 70ADh ;Conversion result buffer reg 5
RESULT6 .set 70AEh ;Conversion result buffer reg 6
RESULT7 .set 70AFh ;Conversion result buffer reg 7
RESULTS8 .set 70BOh ;Conversion result buffer reg 8
RESULTY .set 70Blh ;Conversion result buffer reg 9
RESULT10 .set 70B2h ;Conversion result buffer reg 10
RESULT11 .set 70B3h ;Conversion result buffer reg 11
RESULT12 .set 70B4h ;Conversion result buffer reg 12
RESULT13 .set 70B5h ;Conversion result buffer reg 13
RESULT14 .set 70B6h ;Conversion result buffer reg 14
RESULT15 .set 70B7h ;Conversion result buffer reg 15
CALIBRATION .set 70B8h ;Calibration result reg
;Controller Area Network (CAN) registers

MDER .set 7100h ;CAN mailbox direction/enable reg
TCR .set 7101h ;CAN transmission control reg

RCR .set 7102h ;CAN receive control reg

MCR .set 7103h ;CAN master control reg

BCR2 .set 7104h ;CAN bit config reg 2

BCR1 .set 7105h ;CAN bit config reg 1

ESR .set 7106h ;CAN error status reg

GSR .set 7107h ;CAN global status reg

CEC .set 7108h ;CAN trans and rcv err counters
CAN_ IFR .set 7109h ;CAN interrupt flag reg

CAN IMR .set 710ah ;CAN interrupt mask reg

LAMO_H .set 710bh ;CAN local acceptance mask MBXO0/1
LAMO_L .set 710ch ;CAN local acceptance mask MBX0/1
LAM1 H .set 710dh ;CAN local acceptance mask MBX2/3
LAM1 L .set 710eh ;CAN local acceptance mask MBX2/3
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MSGIDOL .set 7200h ;CAN msg ID for mailbox 0 (lower 16b)
MSGIDOH .set 7201h ;CAN msg ID for mailbox 0 (upper 16Db)
MSGCTRLO .set 7202h ;CAN RTR and DLC for mailbox 0
MBXO0A .set 7204h ;CAN 2 of 8 bytes of mailbox 0
MBX0B .set 7205h ;CAN 2 of 8 bytes of mailbox 0
MBX0C .set 7206h ;CAN 2 of 8 bytes of mailbox 0
MBXO0D .set 7207h ;CAN 2 of 8 bytes of mailbox 0
MSGID1L .set 7208h ;CAN msg ID for mailbox 1 (lower 16b)
MSGID1H .set 7209h ;CAN msg ID for mailbox 1 (upper 16b)
MSGCTRL1 .set 720Ah ;CAN RTR and DLC for mailbox 1
MBX1A .set 720Ch ;CAN 2 of 8 bytes of mailbox 1
MBX1B .set 720Dh ;CAN 2 of 8 bytes of mailbox 1
MBX1C .set 720Eh ;CAN 2 of 8 bytes of mailbox 1
MBX1D .set 720Fh ;CAN 2 of 8 bytes of mailbox 1
MSGID2L .set 7210h ;CAN msg ID for mailbox 2 (lower 16b)
MSGID2H .set 7211h ;CAN msg ID for mailbox 2 (upper 16Db)
MSGCTRL2 .set 7212h ;CAN RTR and DLC for mailbox 2
MBX2A .set 7214h ;CAN 2 of 8 bytes of mailbox 2
MBX2B .set 7215h ;CAN 2 of 8 bytes of mailbox 2
MBX2C .set 7216h ;CAN 2 of 8 bytes of mailbox 2
MBX2D .set 7217h ;CAN 2 of 8 bytes of mailbox 2
MSGID3L .set 7218h ;CAN msg ID for mailbox 3 (lower 16b)
MSGID3H .set 7219%h ;CAN msg ID for mailbox 3 (upper 16b)
MSGCTRL3 .set 721Ah ;CAN RTR and DLC for mailbox 3
MBX3A .set 721Ch ;CAN 2 of 8 bytes of mailbox 3
MBX3B .set 721Dh ;CAN 2 of 8 bytes of mailbox 3
MBX3C .set 721Eh ;CAN 2 of 8 bytes of mailbox 3
MBX3D .set 721Fh ;CAN 2 of 8 bytes of mailbox 3
MSGID4L .set 7220h ;CAN msg ID for mailbox 4 (lower 16b)
MSGID4H .set 7221h ;CAN msg ID for mailbox 4 (upper 16b)
MSGCTRL4 .set 7222h ;CAN RTR and DLC for mailbox 4
MBX4A .set 7224h ;CAN 2 of 8 bytes of mailbox 4
MBX4B .set 7225h ;CAN 2 of 8 bytes of mailbox 4
MBX4C .set 7226h ;CAN 2 of 8 bytes of mailbox 4
MBX4D .set 7227h ;CAN 2 of 8 bytes of mailbox 4
MSGID5L .set 7228h ;CAN msg ID for mailbox 5 (lower 16b)
MSGID5SH .set 7229%h ;CAN msg ID for mailbox 5 (upper 16Db)
MSGCTRL5 .set 722Ah ;CAN RTR and DLC for mailbox 5
MBX5A .set 722Ch ;CAN 2 of 8 bytes of mailbox 5
MBX5B .set 722Dh ;CAN 2 of 8 bytes of mailbox 5
MBX5C .set 722Eh ;CAN 2 of 8 bytes of mailbox 5
MBX5D .set 722Fh ;CAN 2 of 8 bytes of mailbox 5
;Event Manager A (EVA) registers
GPTCONA .set 7400h ;GP timer control reg A
T1CNT .set 7401h ;GP timer 1 counter reg
T1CMPR .set 7402h ;GP timer 1 compare reg
T1PR .set 7403h ;GP timer 1 period reg
T1CON .set 7404h ;GP timer 1 control reg
T2CNT .set 7405h ;GP timer 2 counter reg
T2CMPR .set 7406h ;GP timer 2 compare reg
T2PR .set 7407h ;GP timer 2 period reg
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T2CON .set 7408h ;GP timer 2 control reg

COMCONA .set 7411h ;Compare control reg A

ACTRA .set 7413h ;Compare action control reg A
DBTCONA .set 7415h ;Dead-band timer control reg A
CMPR1 .set 7417h ;compare reg 1

CMPR2 .set 7418h ;compare reg 2

CMPR3 .set 741%h ;jcompare reg 3

CAPCONA .set 7420h ;Capture control reg A

CAPFIFOA .set 7422h ;Capture FIFO status reg A
CAP1FIFO .set 7423h ;Capture Channel 1 FIFO top
CAP2FIFO .set 7424h ;Capture Channel 2 FIFO top
CAP3FIFO .set 7425h ;Capture Channel 3 FIFO top
CAP1FBOT .set 7427h ;jBottom reg of capture FIFO stack 1
CAP2FBOT .set 7427h ;Bottom reg of capture FIFO stack 2
CAP3FBOT .set 7427h ;Bottom reg of capture FIFO stack 3
EVAIMRA .set 742Ch ;EVA interrupt mask reg A

EVAIMRB .set 742Dh ;EVA interrupt mask reg B

EVAIMRC .set 742Eh ;EVA interrupt mask reg C

EVAIFRA .set 742Fh ;EVA interrupt flag reg A

EVAIFRB .set 7430h ;EVA interrupt flag reg B

EVAIFRC .set 7431h ;EVA interrupt flag reg C

;Event Manager B (EVB) registers

GPTCONB .set 7500h ;GP timer control reg B

T3CNT .set 7501h ;GP timer 3 counter reg

T3CMPR .set 7502h ;GP timer 3 compare reg

T3PR .set 7503h ;GP timer 3 period reg

T3CON .set 7504h ;GP timer 3 control reg

T4CNT .set 7505h ;GP timer 4 counter reg

T4CMPR .set 7506h ;GP timer 4 compare reg

T4PR .set 7507h ;GP timer 4 period reg

T4CON .set 7508h ;GP timer 4 control reg

COMCONB .set 7511h ;Compare control register B

ACTRB .set 7513h ;Compare action control register B
DBTCONB .set 7515h ;Dead-band timer control reg B
CMPR4 .set 7517h ;Compare reg 4

CMPR5 .set 7518h ;Compare reg 5

CMPR6 .set 7519%h ;Compare reg 6

CAPCONB .set 7520h ;Capture control reg B

CAPFIFOB .set 7522h ;Capture FIFO status reg B
CAP4FIFO .set 7523h ;Capture channel 4 FIFO top
CAP5FIFO .set 7524h ;Capture channel 5 FIFO top
CAP6FIFO .set 7525h ;Capture channel 6 FIFO top
CAP4FBOT .set 7527h ;Bottom reg of capture FIFO stack 4
CAPSFBOT .set 7527h ;Bottom reg of capture FIFO stack 5
CAP6FBOT .set 7527h ;Bottom reg of capture FIFO stack 6
EVBIMRA .set 752Ch ;EVB interrupt mask reg A

EVBIMRB .set 752Dh ;EVB interrupt mask reg B

EVBIMRC .set 752Eh ;EVB interrupt mask reg C

EVBIFRA .set 752Fh ;EVB interrupt flag reg A

EVBIFRB .set 7530h ;EVB interrupt flag reg B

EVBIFRC .set 7531h ;EVB interrupt flag reg C

;I/0 space mapped registers

FCMR .set OFFOFh ;Flash control mode reg

WSGR .set OFFFFh ;Wait-state generator reg
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;************************************************

;Other useful definitions below (not addresses) *
;************************************************

;Data page definitions for LDP instruction

DP_PF1 .set 224 ;8ys regs,WD,SPI,SCI, (0x7000 - 0x707F)
DP_PF2 .set 225 ;ADC, GPIO (0x7080 - 0x70FF)

DP_CAN1 .set 226 ;CAN control regs (0x7100 - 0x717F)
DP_CAN2 .set 228 ;CAN mailboxes 1-5 (0x7200 - 0x727F)
DP_EVA .set 232 ;Event manager A (0x7400 - 0x747F)
DP_EVB .set 234 ;Event manager A (0x7500 - 0x757F)

;Bit codes for test bit instruction (BIT)

BIT15 .set 0000h ;Bit code for bit 0
BIT14 .set 0001h ;Bit code for bit 1
BIT13 .set 0002h ;Bit code for bit 2
BIT12 .set 0003h ;Bit code for bit 3
BIT11 .set 0004h ;Bit code for bit 4
BIT10 .set 0005h ;Bit code for bit 5
BITO .set 0006h ;Bit code for bit 6
BITS .set 0007h ;Bit code for bit 7
BIT7 .set 0008h ;Bit code for bit 8
BIT6 .set 0009h ;Bit code for bit 9
BIT5 .set 000Ah ;Bit code for bit 10
BIT4 .set 000Bh ;Bit code for bit 11
BIT3 .set 000Ch ;Bit code for bit 12
BIT2 .set 000Dh ;Bit code for bit 13
BIT1 .set 000Eh ;Bit code for bit 14
BITO .set 000Fh ;Bit code for bit 15
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